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Предисловие 

Цели и задачи дисциплины – требования к результатам освоения дисциплины: 

Изучение дисциплины ориентировано на достижение следующих целей: 

 освоение системы базовых знаний, отражающих вклад информатики в формирование современной 

научной картины мира, роль информационных процессов в обществе, биологических и технических 

системах; 

 овладение умениями применять, анализировать, преобразовывать информационные модели 

реальных объектов и процессов, используя при этом ИКТ, в том числе при изучении других дисциплин; 

 развитие познавательных интересов, интеллектуальных и творческих способностей путем освоения и 

использования методов информатики и средств ИКТ при изучении различных учебных предметов; 

 воспитание ответственного отношения к соблюдению этических и правовых норм информационной 

деятельности;  

 приобретение опыта использования информационных технологий в индивидуальной и 

коллективной учебной и познавательной, в том числе проектной деятельности 

 Контроль и оценка результатов освоения дисциплины осуществляется преподавателем в процессе 

проведения практических занятий и лабораторных работ, тестирования, а также выполнения обучающимися 

индивидуальных заданий, проектов, исследований. 

 

В результате освоения учебной дисциплины  и выполнения лабораторных работ обучающийся должен 

уметь: 

 оценивать достоверность информации, сопоставляя различные источники; 

 распознавать информационные процессы в различных системах; 

 использовать готовые информационные модели, оценивать их соответствие реальному объекту и 

целям моделирования; 

 осуществлять выбор способа представления информации в соответствии с поставленной задачей; 

 иллюстрировать учебные работы с использованием средств информационных технологий; 

 создавать информационные объекты сложной структуры, в том числе гипертекстовые; 

 просматривать, создавать, редактировать, сохранять записи в базах данных; 

 осуществлять поиск информации в базах данных, компьютерных сетях и пр.; 

 представлять числовую информацию различными способами (таблица, массив, график, диаграмма и 

пр.); 

 соблюдать правила техники безопасности и гигиенические рекомендации при использовании средств 

ИКТ. 

 

В результате освоения учебной дисциплины обучающийся должен знать: 

 различные подходы к определению понятия «информация»; 

 методы измерения количества информации: вероятностный и алфавитный. Знать единицы измерения 

информации; 

 назначение наиболее распространенных средств автоматизации информационной деятельности 

(текстовых редакторов, текстовых процессоров, графических редакторов, электронных таблиц, баз данных, 

компьютерных сетей); 

 назначение и виды информационных моделей, описывающих реальные объекты или процессы; 

 использование алгоритма как способа автоматизации деятельности; 

 назначение и функции операционных систем. 

 

Правила выполнения лабораторных и  практических занятий 

     Лабораторные и практические занятия организуются с целью систематизации, углубления, закрепления и 

практического осмысления полученных теоретических знаний на лекционных занятиях курса. 

 При подготовке к лабораторному или практическому занятию обучающиеся должны выполнить 

необходимый объем заданий в рамках самостоятельной подготовки. Перед выполнением каждой работы 

преподавателем организуется проверка готовности обучающихся. После выполнения работы обучающийся 

должен представить отчет о проделанной работе с соответствующими выводами. 

      Формой контроля знаний, умений и навыков обучающихся является  допуск  к дифференцированному 

зачету.    Каждая лабораторная  или практическая работа  выполняется по определенной теме в соответствии 

с заданием. Перед выполнением лабораторной или практической  работы обучающийся должен проработать 

соответствующий материал, используя конспекты теоретических занятий, знания, полученные в результате 

самостоятельной подготовки. На практических занятиях обучающийся выполняет работу в соответствии с 

ее содержанием и методическими указаниями. По окончании занятий обучающийся оформляет отчет по 



каждой работе, соблюдая следующую форму: наименование темы, цель работы, содержание выполненной 

работы. Результаты представляют в форме папок на ПК. 

На практическом занятии обучающиеся должны иметь необходимый раздаточный материал.  

 

Допуск к зачету по ОП.01 Информационное обеспечение профессиональной деятельности 

обучающийся получает, при условии наличия:  

 промежуточных зачетов по всем  темам лабораторных занятий; 

 суммарной положительной оценки за выполнение всех работ.  

Если одно из выше указанных требований не выполняется, то обучающиеся не допускается к сдаче 

дифференцированного зачета.  

 

Компетенции обучающегося, формируемые в результате освоения дисциплины 
Процесс изучения дисциплины ОП.01 Информационное обеспечение профессиональной деятельности 

направлен на формирование следующих компетенций в соответствии с программой ФГОС СПО по 

специальности Прикладная эстетика 

Общие компетенции 
ОК 01. Выбирать способы решения задач профессиональной деятельности применительно к различным 

контекстам. 

ОК02. Использовать современные средства поиска, анализа и интерпретации информации, и 

информационные технологии для выполнения задач. 

ОК 03. Планировать и реализовывать собственное профессиональное и личностное развитие, 

предпринимательскую деятельность в профессиональной сфере, использовать знания по финансовой 

грамотности в различных жизненных ситуациях. 

ОК 04. Эффективно взаимодействовать и работать в коллективе и команде. 

ОК 05. Осуществлять устную и письменную коммуникацию на государственном языке Российской 

Федерации с учетом особенностей социального и культурного контекста. 

ОК 06. Проявлять гражданско-патриотическую позицию, демонстрировать осознанное поведение на основе 

традиционных общечеловеческих ценностей, в том числе с учетом гармонизации межнациональных и 

межрелигиозных отношений, применять стандарты антикоррупционного поведения.  

ОК 07. Содействовать сохранению окружающей среды, ресурсосбережению, применять знания об 

изменении климата, принципы бережливого производства, эффективно действовать в чрезвычайных 

ситуациях  

ОК 09. Пользоваться профессиональной документацией на государственном и иностранном языках. 

 

Количество практических занятий – 68 часов. 

 

 

 



Практическое занятие № 1 Инсталляция программного обеспечения 

 

1. Цель работы: изучить основные термины программного обеспечения; научиться устанавливать 

программное обеспечение, обновлять и использовать по назначению.  

2. Вопросы домашней подготовки: 

3.1.   Что такое программа? 

3.2. Что такое программное обеспечение ? 

3.3.  Что такое файл, каталог? 

1. Подготовка к работе: 

1.1. Изучить литературу (2.1 – 2.3) и конспект лекций по курсу. 

1.2. Изучить описание практической работы. 

1.3. Подготовить бланк отчета, содержащий название и цель работы. 

2. Оборудование: Персональный компьютер 

3. Порядок выполнения работы: 
 

4. Внимание! Данная практическая работа выполняется только в присутствии преподавателя 

или лаборанта. 

Правила техники безопасности в компьютерном классе. 

Содержание работы:  

Каждому пользователю компьютера приходится сталкиваться с этим вопросом, поэтому вы должны уметь 

грамотно инсталлировать программы. Не забывайте, любая игра также является программой, а их вы 

пытаетесь устанавливать на свои компьютеры, наверное, каждый день. 

1. Установка программного обеспечения 

 Без подходящего, хорошо настроенного программного обеспечения даже самый мощный  современный 

компьютер не будет работать в полную силу, а его реальные возможности останутся не использованными. 

Настройка разнообразных программ непосредственно под задачи каждого пользователя является залогом 

комфортной и уверенной работы на компьютере. Установка программ – широчайшее поле деятельности: 

количество приложений настолько велико, что сориентироваться в новинках и системных требованиях 

бывает порой весьма затруднительно. 

Запишите в тетрадь: 

Установка или инсталляция — процесс установки программного обеспечения на компьютер конечного 

пользователя. 

Деинсталяция - действие, обратное инсталляции; процесс удаления программного продукта с диска, с 

компьютера 

Рассмотрим понятия: 

1.  Что такое дистрибутив. 

2.  Типы инсталляции программного обеспечения. 

3.  Лицензионное соглашение 

Дистрибутив (англ. distribute — распространять) — это набор программ, предназначенный для начальной 

установки программного обеспечения. 

 Например, дистрибутив операционной системы обычно содержит программы для начальной 

инициализации — инициализация аппаратной части, загрузка урезанной версии системы и запуск 

программы-установщика, программу-установщик (для выбора режимов и параметров установки) и набор 

специальных файлов, содержащих отдельные части системы (так называемые пакеты). 

Запишите в тетрадь: 

Дистрибутив - это пакет файлов, изготовленный специально для удобства инсталляции программы в 

достаточно произвольный компьютер. 

Дистрибутив также может содержать README-файл (от англ. readme— «прочти меня») — текстовый 

файл, содержащий информацию о других файлах. 

2. Инсталляция программного обеспечения 

Дистрибутив (ПО) - это комплект (как правило, набор файлов), приспособленный для распространения ПО. 

Может включать вспомогательные инструменты для автоматической или автоматизированной начальной 

настройки ПО (установщик). 

Так и при использовании дистрибутива программного обеспечения - устанавливаются только необходимые 

файлы, при чем таким образом, чтобы их правильно видела операционная система. Также конфигурируются 

начальные параметры, язык, способ подключения, например, к Интернет. 

Виды дистрибутивов: 

 Архив (.zip, .rar, .tar.gz и др.) - неавтоматизированный дистрибутив 



 Исполняемый файл - дистрибутив с автоматизированным установщиком, позволяет пользователю 

указать необходимые параметры при установке. 

 Комплект на CD/DVD - такой дистрибутив, как правило, состоит из нескольких файлов и 

сопровождается автоматизированным установщиком. Используется для крупных пакетов ПО и системного 

программного обеспечения (дистрибутивы ОС, Windows, различные дистрибутивы Linux). 

Большинство программ поставляются для продажи и распространения в сжатом (упакованном) виде. 

Длянормальной работы они должны быть распакованы, а необходимые данные правильно размещены на 

компьютере, учитывая различия между компьютерами и настройками пользователя. В процессе установки 

выполняются различные тесты на соответствие заданным требованиям, а компьютер необходимым образом 

конфигурируется (настраивается) для хранения файлов и данных, необходимых для правильной работы 

программы 

 Установка включает в себя размещение всех необходимых программе файлов в соответствующих местах 

файловой системы. Многие программы (включая операционные системы) поставляются вместе с 

универсальным или специальным инсталлятором — программой, которая автоматизирует большую часть 

работы, необходимой для их установки. 

Запишите в тетрадь: 

Инсталлятор — это компьютерная программа, которая устанавливает файлы, такие как приложения, 

драйверы, или другое ПО, на компьютер. Она запускается из файла SETUP.EXE или INSTALL.EXE 

Дистрибутив также может содержать README-файл (от англ. readme— «прочти меня») — текстовый 

файл, содержащий информацию о других файлах. 

3. Лицензионное соглашение 

Программы по их юридическому статусу можно разделить на три большие группы: 

Запишите в тетрадь: 

1. Лицензионные 

2. условно бесплатные (shareware) 

3. свободно распространяемые программы (freeware). 

Дистрибутивы лицензионных программ продаются пользователям. В соответствии с лицензионным 

соглашением разработчики программы гарантируют ее нормальное функционирование в определенной 

операционной системе и несут за это ответственность. 

Условно бесплатные программы предлагаются пользователям в целях их рекламы и продвижения на 

рынок. Пользователю предоставляется версия программы с ограниченным сроком действия (после 

истечения указанного срока программа перестает работать, если за нее не произведена оплата) или версия 

программы с ограниченными функциональными возможностями (в случае оплаты пользователю сообщается 

код, включающий все функции).  

Производители бесплатного программного обеспечения заинтересованы в его широком распространении. К 

таким программным средствам можно отнести следующие: 

 новые недоработанные (бета) версии программных продуктов 

 программные продукты, являющиеся частью принципиально новых технологий 

 дополнения к ранее выпущенным программам, исправляющие найденные 

 устаревшие версии программ; 

 драйверы к новым устройствам или улучшенные драйверы к уже существующим. 

Производители программного обеспечения предлагают пользователям лицензионное соглашение. 

Принимая настоящее соглашение, Вы выражаете свое полное согласие со всеми его положениями и 

условиями. Если Вас не устраивают условия, описанные в нем, то не устанавливайте программу. 

Использование программы однозначно подразумевает принятие Вами всех положений и условий данного 

соглашения. 

Принятие положений и условий настоящего соглашения не является передачей, каких бы то ни было прав 

собственности на программы и продукты. 

4. Порядок установки 

Чтобы ознакомиться с процессом установки программного обеспечения, запустите видео ролик Установка 

антивируса Avast.mpg    

Практическое задание: 

1. Зайдите на сайт Avast! (http://www.avast.ru) 

2. Установите на свой компьютер антивирусную программу для домашнего использования, размещая 

пиктограммы этого антивируса на Рабочем столе. 

3. Сохраните скриншот рабочего стола с пиктограммами установочного файла антивируса и 

пиктограммой самого антивируса с именем Virus.jpg. 

4. Отошлите скриншот Virus.jpg преподавателю. 

Задание для самостоятельной работы: 



1 вариант 

1. Установить на ПК программуWiseCalculator  

Калькулятор для инженерных и научных вычислений с очень большими возможностями. 

Сайт программы: http://www.wisecalculator.chat.ru/rus.html 

2.  Опишите этапы процесса установки и удаления программы 

3. Удалите программуWiseCalculator  

4. Опишите этапы процесса удаления программы 

5. Изучить основные термины программного обеспечения 

3 вариант 

1.Установить на ПК программуCCleaner 

CCleaner - утилита для чистки мусора в операционной системе.  

Домашняя страница: http://www.ccleaner.com/ 

2.Опишите этапы процесса установки программы 

3.Удалите программуCCleaner 

4.Опишите этапы процесса удаления программы 

5.Изучить основные термины программного обеспечения 

4 вариант. 

1. Установить на ПК программу 7-Zip  

2. Архиватор с высокой степенью сжатия. 

Домашняя страница http://www.7-zip.org/ 

2.Опишите этапы процесса установки программы 

3.Удалите программуCCleaner 

4.Опишите этапы процесса удаления программы 

5.Изучить основные термины программного обеспечения 

5 вариант 

1. Установить на ПК программуAviraAntiVirPersonalEditionClassic  

2. AntiVirPersonalEdition - это антивирусная программа, которая может определять и удалять вирусы.  

Домашняя страница: http://www.free-av.com/ 

2.Опишите этапы процесса установки программы 

3.Удалите программуCCleaner 

4.Опишите этапы процесса удаления программы 

5.Изучить основные термины программного обеспечения 

6 вариант 

1. Установить на ПК программуDr.WEBCureIt! 

2. Это бесплатная антивирусная утилита на основе сканера Dr.WEB, которая быстро и эффективно 

проверит и вылечит, в случае необходимости 

Домашняя страница: http://www.freedrweb.com/ 

2.Опишите этапы процесса установки программы 

3.Удалите программуDr.WEBCureIt! 

4.Опишите этапы процесса удаления программы 

5.Изучить основные термины программного обеспечения 

7 вариант 

1. Установить на ПК программуКто хочет стать ОТЛИЧНИКОМ?!  

Игровая система тестирования. 

Сайт программы: http://otlichnik5.net/ 

2. Опишите этапы процесса установки программы 

3. Удалите программу Кто хочет стать ОТЛИЧНИКОМ?!  

4. Опишите этапы процесса удаления программы 

Изучить основные термины программного обеспечения 

6. Порядок выполнения работы: 

Повторить требования по соблюдению техники безопасности. 

Включение ПК должно производиться в следующей последовательности: 

 включить принтер (если он нужен); 

 включить монитор; 

 включить системный блок. 

Перед выключением компьютера завершите все работающие программы и подождите 1-2 сек. (это 

необходимо, если на вашем ПК предусмотрено кэширование дисков). Далее необходимо: 

• выключить системный блок; 

http://www.wisecalculator.chat.ru/rus.html
http://www.ccleaner.com/
http://www.7-zip.org/
http://www.free-av.com/
http://www.freedrweb.com/
http://otlichnik5.net/


• выключить принтер (если он был включен); 

• выключить монитор.  

6.1 . Ознакомиться с пунктами практической работы; 

6.2 . Оформите свой отчет согласно седьмому пункту данной практической работы; 

6.3.Выполните задание в соответствии со своим вариантом; 

6.4. Сделайте вывод о проделанной работе. 

7. Содержание отчета: 

7.1. Название, цель работы, задание данной практической работы. 

7.2. Номер варианта, условие задачи своего варианта и ее решение. 

7.3. Перечень контрольных вопросов. 

7.4. Вывод о проделанной работе. 

 

Практическое занятие № 2 Операционная система. Структурные элементы окна в Windows.   

Цель:Изучить работу с файлами: создание, копирование, архивирование, разархивирование, работу с 

антивирусной программой. 

Задача: Сформировать профессиональные компетенции. 

Задание:PKZIP 

Работает из командной строки. Различные функции по обслуживанию архивов zip выполняются разными 

программами: 

pkzip - помещение файлов в архив 

pkunzip - извлечение файлов из архива 

zip2exe - создание самораспаковывающегося архива 

pkzipfix - восстановление поврежденного архива. 

Изучить справку по работе с архиватором pkzip с помощью команд: 

pkzip /h 

pkunzip /h 

zip2exe /h 

RAR 

Архиватор RAR v2.50 для DOS - Интегрированная программа управления архивами 

RAR - это очень мощное средство для создания архивов и управления ими. Возможности RAR: 

-Полноэкранный интерактивный интерфейс (отключаемый); 

-Поддержка мыши и меню; 

-Поддержка не-RAR архивов; 

-'Стандартный' интерфейс командной строки; 

-Оригинальный высокоэффективный алгоритм сжатия данных; 

-Специальный алгоритм для сжатия мультимедийных файлов; 

-Лучшая степень упаковки, чем у аналогичных продуктов, за счет использования режима "непрерывного" 

сжатия; 

-Информация об авторе архива (только в зарегистрированной версии); 

-Самораспаковывающиеся (SFX) обычные и многотомные архивы; 

-Восстановление физически поврежденных архивов; 

-Язык программирования для инсталляционных SFX-архивов; 

-Блокировка, шифрование, список порядка файлов, метки томов и др. 

QUARK 

Quark является архиватором классического типа, использующим LZ77-алгоритм для уплотнения исходных 

данных путем кодирования повторяющихся последовательностей байт (RSE-алгоритм) с последующим 

вторичным уплотнением сжатого потока кодами Хаффмана. Подобные методы используют все три лидера в 

области упаковки данных - архиваторы ARJ, LHA, PkZIP. 

Тем не менее, Quark добивается лучших результатов в компактности данных при скорости лучшей, чем 

LHA, не меньшей чем у ARJ и не сильно отличающейся от скорости PkZIP, при использовании им т.н. 

максимальной компрессии данных. Это обусловлено несколькими причинами: 

1) Quark работает с плавающим размером окна от 32Kb до 64Kb (против фиксированных 16Kb у LHA, и 

32Kb у PkZIP и ARJ). 

2) Quark выполняет оптимизацию Первого рода (оптимальность адресов ссылок LZ77) и оптимизацию 

Второго рода (оптимальность ссылочного покрытия потока). 

3) Quark использует текстовую редукцию для текстовых файлов. 

4) Quark заносит в архив минимум служебной информации, не претендуя на иные аппаратные платформы и 

операционные системы. 

GZIP 



Gzip сокращает размер заданных файлов, используя кодирование Зива-Лемеля (LZ77). Когда возможно, 

каждый файл замещается файлом с расширением '.gz', при этом сохраняются владелец, режимы, доступ и 

времена модификации (Другие расширения '-gz' для VMS, 'z' для MSDOS, OS/2, FAT и Atari). Если никаких 

файлов не указано или имя файла '-', то пакуется стандартный ввод и выдается на стандартный вывод. Gzip 

пытается паковать только обычные файлы, в частности GZip игнорирует символические ссылки. 

Gzip использует алгоритм Зива-Лемеля также как Zip, PKZIP. Итоговый размер, полученного файла после 

сжатия, зависит от размера исходного файла и наличия в нем общих подстрок. Обычно, такой текст, как 

исходный код или английский текст сокращается на 60-70%. Паковка с использованием этого алгоритма 

обычно лучше, чем при использовании LZW (его использует Compress), кодирование Хаффмана (его 

использует Pack) или адаптированное кодирование Хаффмана (Compact). 

Упаковка происходит независимо от того, увеличился ли размер упакованного файл в сравнении с 

оригиналом или нет. Причина расширения - несколько байтов для заголовка Gzip файла, плюс 5 байтов для 

каждого 32К блока, или отношение расширения 0.015% от длины файла. Заметим, что фактическое число 

занятых на диске блоков уже никогда не возрастает. Gzip сохраняет режимы доступа, владельцев и время 

модификации файлов при упаковке и распаковке. 

 

Методические указания по выполнению задания: 
Алгоритм выполнения  

Выполнить практическое занятие. 

Изучить теоретический материал по Теме 2.2 Программное обеспечение. 

Внимательно прочитать задание и методические рекомендации по его выполнению. 

Выполнить задание. 

Вид контроля 
Защита с демонстрацией. 

Библиографический список: 
1. Колмыкова Е.А., Кумскова И.А. Информатика. Учебное пособие для студ.ентов СПО– М.: 

Академия, 2006. 

2. Михеева Е.В. «Информационные технологии в профессиональной деятельности». - М.: 

Издательский центр «Академия», 2008 г. 

3. Михеева Е.В. «Практикум по информационным технологиям в профессиональной деятельности». - 

М.: Издательский центр «Академия», 2006 г. 

4. www.consultant.ru — Консультант - Плюс 

5. www.garant.ru - ГАРАНТ 

 

Практическое занятие № 3 

Использования внешних устройств, подключаемых к компьютеру, в учебных целях. Подключение внешних 

устройств к компьютеру и их настройка. 

Цели: изучить периферийные устройства, способы их подключения к компьютеру и использование в 

учебных целях,  выработать практические навыки работы с программных обеспечением компьютера, с 

внешними устройствами, подключаемыми к компьютеру; подключения внешних устройств к компьютеру и 

их настройки. 

Задачи: 
1. образовательные: изучить интерфейс операционных систем. Научиться пользоваться стандартными 

приложениями Windows. 

2.развивающая: развитие познавательного интереса, логического мышления, речи и внимания учащихся, 

формирование информационной культуры и потребности приобретения знаний; 

3.воспитательная: привитие учащимся навыка самостоятельности в работе, воспитание трудолюбия, 

эстетического отношения к результатам своего труда. 

Время на выполнение: 2 часа 

Обеспеченность занятия: 
1. Интернет – ресурсы: Графические интерфейсы – [http://www.glossary.ru/cgi-

bin/gl_sch2.cgi?RDwg(o,lxqol!otylw(lpx:]. 

Графический интерфейс пользователя – [http://dic.academic.ru/dic.nsf/ntes/1261/ГРАФИЧЕСКИЙ]. 

2. Учебная литература: 

Литература: Е.В.Михеева. Практикум по информационным технологиям в профессиональной деятельности. 

М., Академия, 2016, с. 4 – 11 

3. Методическая разработка практических работ. 

4. Рабочая тетрадь в клетку 48 листов, ручка. 

5. Технические средства обучения: персональный компьютер с выходом в Интернет, проектор. 

http://infourok.ru/site/go?href=http%3A%2F%2Fwww.consultant.ru%2F
http://infourok.ru/site/go?href=http%3A%2F%2Fwww.garant.ru%2F


Краткие теоретические и учебно-методические материалы по теме практического занятия 
К системному блоку можно присоединить различные внешние устройства. По интерфейсу внешние 

устройства весьма разнообразны. По этому системный блок имеет различные внешние разъемы, рассмотрим 

некоторые из них. 

Имеются специальные порты,  через которые происходит обмен данными с внутренними 

устройствами компьютера, и порты общего назначения, к которым могут присоединяться различные 

дополнительные  устройства (принтер,  мышь,  сканер и другие).  Порты общего назначения бывают двух 

видов: параллельные (обозначаемые LPT1-LPT4) асинхронные последовательные (обозначаемые COM1-

COM3). Параллельные порты выполняют ввод и вывод с большей скоростью,  чем асинхронные 

последовательные, но требуют большего числа проводов для обмена данными. Очень широко используется 

разъем USB, здесь можно подключить несколько внешних устройств, включая флэш – память, принтеры, 

фотоаппараты и многие другие устройства. Данные разъемы могут располагаться помимо задней стенки еще 

и спереди, а также сверху. Небольшой разъем FIREWIRE, куда подключаются скоростные внешние 

устройства. Сетевой разъем для того, чтобы подключить локальную сеть или интернет посредством 

локальной сети. Маленькие разъемы PS/2, чтобы подключить клавиатуру и мышку. 

  

Устройства ввода информации – это  устройства, которые переводят информацию с языка человека 

на машинный язык.  

К устройствам ввода информации относятся следующие устройства:  

1. Клавиатура; 

2. Сканер;   

3. Цифровые фотокамеры; 

4. Средство речевого ввода (микрофон); 

5. Координатные устройства ввода (мышь, трекбол); 

6.Сенсорные устройства ввода (световое перо, сенсорный экран, дигитайзер). 

  

Задание 1. Откройте информационный модуль «Устройства ввода информации» и изучите пункт «Базовая 

система ввода-вывода». Заполните пропуски в тексте ниже. 

Базовая система ввода-вывода 
________ ( __________________________________ - базовая система ввода-вывода) называется так потому, 

что включает в себя обширный набор ____________________________, благодаря которым операционная 

система и прикладные программы могут взаимодействовать как с 

________________________________________ и с _________________. BIOS, с одной стороны, 

является____________________________ _______________________________, а с другой стороны это 

_________________________ _________________________________________. 

К функциям BIOS относятся _______________________________________________ и 

________________________________________________________________________. Но _________________ 

функцией BIOS материнской платы является_____________________ __________________________, 

подключенных к материнской плате, сразу после включения питания компьютера. Кроме того, BIOS 

предоставляет вычислительной системе такие функции, как 

_____________________________________________________, __________________, 

_____________________ входных и выходных данных, осуществление захвата внешних устройств, 

_______________________ __________________, возникающих при операциях ввода-вывода, планирование 

последовательности запросов на выполнение этих операций.  

Часть функций базовой подсистемы может быть передана _____________________ и самим 

____________________________________. 

 

Задание 2. В информационном модуле «Устройства ввода информации» изучите раздел «Программная и 

аппаратная поддержка ввода информации». Заполните таблицу. 

Внешние интерфейсы (порты) 

№ Название 

порта 

Назначение 

1  

 

 

2  

 

 

3  

 

 



4  

 

 

5  

 

 

6  

 

 

Задание 3. Изучите модули «Устройства ввода информации. Примеры» и «Устройства вывода информации. 

Примеры». Заполните таблицу. 

Устройства ввода-вывода информации 

Устройства ввода Устройства вывода 

 

 

 

 

 

 

 

 

 

 

 

 

Задание 4. Изучите модули «Устройства ввода информации. Примеры» и «Устройства вывода информации. 

Примеры». Подпишите элементы следующих устройств. 

Клавиатура 

 
Мышь 

 
Проектор 

 

 

Плоттер 

 

 
Контрольные вопросы: 

1. Что такое драйвер? 

2. Что такое адаптер? 



3. Что такое контроллер? 

4. Что такое дигитайзер? 

5. Какие виды принтеров существуют? Дайте им краткую характеристику. 

6. Что такое графопостроитель? В чем различие между планшетным и рулонным графопостроителем? 

7. Что такое электронная бумага? Опишите принцип действия. 

8. Дайте определение терминам «эргономика», «эргономическое обеспечение устройства». 

9. Укажите варианты эргономичных устройств ввода и вывода информации. 

 

Практическое занятие № 4 Защита информации, антивирусная защита. 

 
Тема: Средства информационных и коммуникационных технологий.  

Цель:  
 выработать практические навыки работы с антивирусными программами, навыки правильной работы с 

компьютером. 

Норма времени: 2 часа  

Оснащение рабочего места: ПК, ОС Windows, рабочая тетрадь.  

Техника безопасности: Правила ТБ при работе в компьютерном классе.  
Краткие теоретические сведения. 

Вирусы. Антивирусное программное обеспечение 
Компьютерный вирус– программа, способная самопроизвольно внедряться и внедрять свои копии в другие 

программы, файлы, системные области компьютера и в вычислительные сети, с целью создания всевозможных 

помех работе на компьютере. 

 

Признаки заражения: 

 прекращение работы или неправильная работа ранее функционировавших программ 

 медленная работа компьютера 

 невозможность загрузки ОС 

 исчезновение файлов и каталогов или искажение их содержимого 

 изменение размеров файлов и их времени модификации 

 уменьшение размера оперативной памяти 

 непредусмотренные сообщения, изображения и звуковые сигналы 

 частые сбои и зависания компьютера и др.  

Классификация компьютерных вирусов 
По среде обитания: 

 Сетевые – распространяются по различным компьютерным сетям 

 Файловые – внедряются в исполняемые модули (COM, EXE) 

 Загрузочные – внедряются в загрузочные сектора диска или сектора, содержащие программу загрузки 

диска 

 Файлово-загрузочные – внедряются и в загрузочные сектора и в исполняемые модули  

По способу заражения: 

 Резидентные – при заражении оставляет в оперативной памяти компьютера свою резидентную часть, 

которая потом перехватывает обращения ОС к объектам заражения 

 Нерезидентные – не заражают оперативную память и активны ограниченное время  

По воздействию: 

 Неопасные – не мешают работе компьютера, но уменьшают объем свободной оперативной памяти и 

памяти на дисках 

 Опасные – приводят к различным нарушениям в работе компьютера 

 Очень опасные – могут приводить к потере программ, данных, стиранию информации в системных 

областях дисков 

 По особенностям алгоритма: 

 Паразиты – изменяют содержимое файлов и секторов, легко обнаруживаются 

 Черви – вычисляют адреса сетевых компьютеров и отправляют по ним свои копии 

 Стелсы – перехватывают обращение ОС к пораженным файлам и секторам и подставляют вместо них 

чистые области 

 Мутанты – содержат алгоритм шифровки-дешифровки, ни одна из копий не похожа на другую 

 Трояны – не способны к самораспространению, но маскируясь под полезную, разрушают загрузочный 

сектор и файловую систему 

 Основные меры по защите от вирусов 



 оснастите свой компьютер одной из современных антивирусных программ: DoctorWeb., NortonAntivirus, 

AVP 

 постоянно обновляйте антивирусные базы 

 делайте архивные копии ценной для Вас информации (гибкие диски, CD) 

 Классификация антивирусного программного обеспечения 

 Сканеры (детекторы). Принцип работы антивирусных сканеров основан на проверке файлов, секторов и 

системной памяти и поиске в них известных и новых (неизвестных сканеру) вирусов. 

 Мониторы. Это целый класс антивирусов, которые постоянно находятся в оперативной памяти 

компьютера и отслеживают все подозрительные действия, выполняемые другими программами. С 

помощью монитора можно остановить распространение вируса на самой ранней стадии. 

 Ревизоры. Программы-ревизоры первоначально запоминают в специальных файлах образы главной 

загрузочной записи, загрузочных секторов логических дисков, информацию о структуре каталогов, 

иногда - объем установленной оперативной памяти. Программы-ревизоры первоначально запоминают в 

специальных файлах образы главной загрузочной записи, загрузочных секторов логических дисков, 

информацию о структуре каталогов, иногда - объем установленной оперативной памяти. Для 

определения наличия вируса в системе программы-ревизоры проверяют созданные ими образы и 

производят сравнение с текущим состоянием. 

Задание для выполнения за компьютером 

Используя сеть Интернет, выполните следующие задания: 

Задание 1. Укажите требования к помещениям кабинета информатики: 

 Задание 2. Укажите, какие действия запрещены в кабинете информатики. 

 Задание 3. Укажите комплекс упражнений для снятия усталости за компьютером. 

Содержание отчета 

 

Отчет должен содержать: 

1. Название работы. 

2. Цель работы. 

3. Задание и его решение. 

4. Ответы на контрольные вопросы. 

5. Вывод по работе.  

Контрольные вопросы  

1. Что такое вирус? 

2. Дайте классификацию вирусов. 

3. Для чего нужны антивирусные программы? 

4. Дайте их классификацию. 

5. Перечислите основные требования к компьютерному рабочему месту. 

6. Действия, которые запрещены в кабинете информатики. 

 

Практическое занятие  № 5Эксплуатационные требования к компьютерному рабочему месту. 

Профилактические мероприятия для компьютерного рабочего места в соответствии с его 

комплектацией для профессиональной деятельности 

 

 
Цель работы: выработать навыки правильной работы с компьютером. 

2. Оборудование, приборы, аппаратура, материалы: персональный компьютер, антивирусная программа. 

3. Краткие теоретические сведения. 

Профилактические мероприятия для компьютерного рабочего места 
1. Требования к микроклимату, ионному составу и концентрации вредных химических веществ в воздухе 

помещений 

На рабочих местах пользователей персональных компьютеров должны обеспечиваться оптимальные 

параметры микроклимата в соответствии с СанПин 2.2.4.548-96. Согласно этому документу для категории 

тяжести работ 1а температура воздуха должна быть в холодный период года не более 22-24оС, в теплый 

период года 20-25оС. Относительная влажность должна составлять 40-60%, скорость движения воздуха - 0,1 

м/с. Для поддержания оптимальных значений микроклимата используется система отопления и 

кондиционирования воздуха. Для повышения влажности воздуха в помещении следует применять 

увлажнители воздуха или емкости с питьевой водой. 

2. Требования к освещению помещений и рабочих мест 

В компьютерных залах должно быть естественное и искусственное освещение. Световой поток из оконного 

проема должен падать на рабочее место оператора с левой стороны. 
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Искусственное освещение в помещениях эксплуатации компьютеров должно осуществляться системой 

общего равномерного освещения. 

Допускается установка светильников местного освещения для подсветки документов. Местное освещение 

не должно создавать бликов на поверхности экрана. 

Отраженная блескость на рабочих поверхностях ограничивается за счет правильного выбора светильника и 

расположения рабочих мест по отношению к естественному источнику света. 

Для искусственного освещения помещений с персональными компьютерами следует применять 

светильники типа ЛПО36 с зеркализованными решетками, укомплектованные высокочастотными 

пускорегулирующими аппаратами. Допускается применять светильники прямого света, преимущественно 

отраженного света типа ЛПО13, ЛПО5, ЛСО4, ЛПО34, ЛПО31 с люминесцентными лампами типа ЛБ. 

Допускается применение светильников местного освещения с лампами накаливания. Светильники должны 

располагаться в виде сплошных или прерывистых линий сбоку от рабочих мест параллельно линии зрения 

пользователя при разном расположении компьютеров. 

Для обеспечения нормативных значений освещенности в помещениях следует проводить чистку стекол 

оконных проемов и светильников не реже двух раз в год и проводить своевременную замену перегоревших 

ламп. 

3. Требования к шуму и вибрации в помещениях 

Уровни шума на рабочих местах пользователей персональных компьютеров не должны превышать 

значений, установленных СанПиН 2.2.4/2.1.8.562-96 и составляют не более 50 дБА. 

Снизить уровень шума в помещениях можно использованием звукопоглощающих материалов с 

максимальными коэффициентами звукопоглощения в области частот 63-8000 Гц для отделки стен и потолка 

помещений. Дополнительный звукопоглощающий эффект создают однотонные занавески из плотной ткани, 

повешенные в складку на расстоянии 15-20 см от ограждения. Ширина занавески должна быть в 2 раза 

больше ширины окна. 

4. Требования к организации и оборудованию рабочих мест 

Рабочие места с персональными компьютерами по отношению к световым проемам должны располагаться 

так, чтобы естественный свет падал сбоку, желательно слева. 

Схемы размещения рабочих мест с персональными компьютерами должны учитывать расстояния между 

рабочими столами с мониторами: расстояние между боковыми поверхностями мониторов не менее 1,2 м, а 

расстояние между экраном монитора и тыльной частью другого монитора не менее 2,0 м. 

Рабочий стол может быть любой конструкции, отвечающей современным требованиям эргономики и 

позволяющей удобно разместить на рабочей поверхности оборудование с учетом его количества, размеров и 

характера выполняемой работы. Целесообразно применение столов, имеющих отдельную от основной 

столешницы специальную рабочую поверхность для размещения клавиатуры. Используются 

рабочие столы с регулируемой и нерегулируемой высотой рабочей поверхности. При отсутствии 

регулировки высота стола должна быть в пределах от 680 до 800 мм. 

Глубина рабочей поверхности стола должна составлять 800 мм (допускаемая не менее 600 мм), ширина - 

соответственно 1 600 мм и 1 200 мм. Рабочая поверхность стола не должна иметь острых углов и краев, 

иметь матовую или полуматовую фактору. 

Рабочий стол должен иметь пространство для ног высотой не менее 600 мм, шириной - не менее 500 мм, 

глубиной на уровне колен - не менее 450 мм и на уровне вытянутых ног - не менее 650 мм. 

Быстрое и точное считывание информации обеспечивается при расположении плоскости экрана ниже 

уровня глаз пользователя, предпочтительно перпендикулярно к нормальной линии взгляда (нормальная 

линия взгляда 15 градусов вниз от горизонтали). 

Клавиатура должна располагаться на поверхности стола на расстоянии 100-300 мм от края, обращенного к 

пользователю. 

Для удобства считывания информации с документов применяются подвижные подставки (пюпитры), 

размеры которых по длине и ширине соответствуют размерам устанавливаемых на них документов. Пюпитр 

размещается в одной плоскости и на одной высоте с экраном. 

Для обеспечения физиологически рациональной рабочей позы, создания условий для ее изменения в течение 

рабочего дня применяются подъемно-поворотные рабочие стулья с сиденьем и спинкой, регулируемыми по 

высоте и углам наклона, а также расстоянию спинки от переднего края сидения. 

Конструкция стула должна обеспечивать: 

·   ширину и глубину поверхности сиденья не менее 400 мм; 

·  поверхность сиденья с закругленным передним краем; 

·  регулировку высоты поверхности сиденья в пределах 400-550 мм и углом наклона вперед до 15 градусов и 

назад до 5 градусов; 

·  высоту опорной поверхности спинки 300±20 мм, ширину - не менее 380 мм и радиус кривизны 

горизонтальной плоскости 400 мм; 
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·  угол наклона спинки в вертикальной плоскости в пределах 0±30 градусов; 

·  регулировку расстояния спинки от переднего края сидения в пределах 260-400 мм; 

·  стационарные или съемные подлокотники длиной не менее 250 мм и шириной 50-70 мм; 

·  регулировку подлокотников по высоте над сиденьем в пределах 230±30 мм и внутреннего расстояния 

между подлокотниками в пределах 350-500 мм; 

·  поверхность сиденья, спинки и подлокотников должна быть полумягкой, с нескользящим не 

электризующимся, воздухонепроницаемым покрытием, легко очищаемым от загрязнения. 

Рабочее место должно быть оборудовано подставкой для ног, имеющей ширину не менее 300 мм, глубину 

не менее 400 мм, регулировку по высоте в пределах до 150 мм и по углу наклона опорной поверхности 

подставки до 20 град. Поверхность подставки должна быть рифленой и иметь по переднему краю бортик 

высотой 10 мм. 

5. Режим труда и отдыха при работе с компьютером 

Режим труда и отдыха предусматривает соблюдение определенной длительности непрерывной работы на 

ПК и перерывов, регламентированных с учетом продолжительности рабочей смены, видов и категории 

трудовой деятельности. 

Виды трудовой деятельности на ПК разделяются на 3 группы: группа А - работа по считыванию 

информации с экрана с предварительным запросом; группа Б - работа по вводу информации; группа В - 

творческая работа в режиме диалога с ПК. 

Если в течение рабочей смены пользователь выполняет разные виды работ, то его деятельность относят к 

той группе работ, на выполнение которой тратится не менее 50% времени рабочей смены. 

Категории тяжести и напряженности работы на ПК определяются уровнем нагрузки за рабочую смену: для 

группы А - по суммарному числу считываемых знаков; для группы Б - по суммарному числу считываемых 

или вводимых знаков; для группы В - по суммарному времени непосредственной работы на ПК. В таблице 

приведены категории тяжести и напряженности работ в зависимости от уровня нагрузки за рабочую смену. 

Виды категорий трудовой деятельности с ПК 

Категория работы по тяжести и 

напряженности 

Уровень нагрузки за рабочую смену при 

видах работы на ПК 

Группа А 

Количество знаков 

Группа Б 

Количество знаков 

Группа В 

Время 

работы, ч 

I 

II 

III 

До 20000 

До 40000 

До 60000 

До 15000 

До 30000 

До 40000 

До 

2,0 

До 

4,0 

До 

6,0 

Количество и длительность регламентированных перерывов, их распределение в течение рабочей смены 

устанавливается в зависимости от категории работ на ПК и продолжительности рабочей смены. 

При 8-часовой рабочей смене и работе на ПК регламентированные перерывы следует устанавливать: 

·  для первой категории работ через 2 часа от начала смены и через 2 часа после обеденного перерыва 

продолжительностью 15 минут каждый; 

·  для второй категории работ - через 2 часа от начала рабочей смены и через 1,5-2,0 часа после обеденного 

перерыва продолжительностью 15 минут каждый или продолжительностью 10 минут через каждый час 

работы; 

·  для третьей категории работ - через 1,5- 2,0 часа от начала рабочей смены и через 1,5-2,0 часа после 

обеденного перерыва продолжительностью 20 минут каждый или продолжительностью 15 минут через 

каждый час работы. 

При 12-часовой рабочей смене регламентированные перерывы должны устанавливаться в первые 8 часов 

работы аналогично перерывам при 8-часовой рабочей смене, а в течение последних 4 часов работы, 

независимо от категории и вида работ, каждый час продолжительностью 15 минут. 

Продолжительность непрерывной работы на ПК без регламентированного перерыва не должна превышать 2 

часа. 

При работе на ПК в ночную смену продолжительность регламентированных перерывов увеличивается на 60 

минут независимо от категории и вида трудовой деятельности. 

Эффективными являются нерегламентированные перерывы (микропаузы) длительностью 1-3 минуты. 

Регламентированные перерывы и микропаузы целесообразно использовать для выполнения комплекса 

упражнений и гимнастики для глаз, пальцев рук, а также массажа. Комплексы упражнений целесообразно 

менять через 2-3 недели. 
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Пользователям ПК, выполняющим работу с высоким уровнем напряженности, показана психологическая 

разгрузка во время регламентированных перерывов и в конце рабочего дня в специально оборудованных 

помещениях (комнатах психологической разгрузки). 

6. Медико-профилактические и оздоровительные мероприятия. 

Все профессиональные пользователи ПК должны проходить обязательные предварительные медицинские 

осмотры при поступлении на работу, периодические медицинские осмотры с обязательным участием 

терапевта, невропатолога и окулиста, а также проведением общего анализа крови и ЭКГ. 

Не допускаются к работе на ПК женщины со времени установления беременности и в период кормления 

грудью. 

Близорукость, дальнозоркость и другие нарушения рефракции должны быть полностью корригированы 

очками. Для работы должны использоваться очки, подобранные с учетом рабочего расстояния от глаз до 

экрана дисплея. При более серьезных нарушениях состояния зрения вопрос о возможности работы на ПК 

решается врачом-офтальмологом. 

Досуг рекомендуется использовать для пассивного и активного отдыха (занятия на тренажерах, плавание, 

езда на велосипеде, бег, игра в теннис, футбол, лыжи, аэробика, прогулки по парку, лесу, экскурсии, 

прослушивание музыки и т. п.). Дважды в год (весной и поздней осенью) рекомендуется проводить 

курс витаминотерапии в течение месяца. Следует отказаться от курения. Категорически должно быть 

запрещено курение на рабочих местах и в помещениях с ПК. 

7. Обеспечение электробезопасности и пожарной безопасности на рабочем месте 

На рабочем месте пользователя размещены дисплей, клавиатура и системный блок. При включении дисплея 

на электронно-лучевой трубке создается высокое напряжение в несколько киловольт. Поэтому запрещается 

прикасаться к тыльной стороне дисплея, вытирать пыль с компьютера при его включенном состоянии, 

работать на компьютере во влажной одежде и влажными руками. 

Перед началом работы следует убедиться в отсутствии свешивающихся со стола или висящих под столом 

проводов электропитания, в целостности вилки и провода электропитания, в отсутствии видимых 

повреждений аппаратуры и рабочей мебели. 

Токи статического электричества, наведенные в процессе работы компьютера на корпусах монитора, 

системного блока и клавиатуры, могут приводить к разрядам при прикосновении к этим элементам. Такие 

разряды опасности для человека не представляют, но могут привести к выходу из строя компьютера. Для 

снижения величин токов статического электричества используются нейтрализаторы, местное и общее 

увлажнение воздуха, использование покрытия полов с антистатической пропиткой. 

Пожарная безопасность - состояние объекта, при котором исключается возможность пожара, а в случае его 

возникновения предотвращается воздействие на людей опасных его факторов и обеспечивается защита 

материальных ценностей. 

Противопожарная защита - это комплекс организационных и технических мероприятий, направленных на 

обеспечение безопасности людей, предотвращение пожара, ограничение его распространения, а также на 

создание условий для успешного тушения пожара. 

Пожарная безопасность обеспечивается системой предотвращения пожара и системой пожарной защиты. Во 

всех служебных помещениях обязательно должен быть «План эвакуации людей при пожаре», 

регламентирующий действия персонала в случае возникновения очага возгорания и указывающий места 

расположения пожарной техники. 

Пожары в вычислительных центрах (ВЦ) представляют особую опасность, так как сопряжены с большими 

материальными потерями. Характерная особенность 

ВЦ - небольшие площади помещений. Как известно, пожар может возникнуть при взаимодействии горючих 

веществ, окислителя и источников зажигания. В помещениях ВЦ присутствуют все три основные фактора, 

необходимые для возникновения пожара. 

Горючими компонентами на ВЦ являются: строительные материалы для акустической и эстетической 

отделки помещений, перегородки, двери, полы, изоляция кабелей и др. 

Источниками зажигания в ВЦ могут быть электрические схемы от ЭВМ, приборы, применяемые для 

технического обслуживания, устройства электропитания, кондиционирования воздуха, где в результате 

различных нарушений образуются перегретые элементы, электрические искры и дуги, способные вызвать 

загорания горючих материалов. 

В современных ЭВМ очень высокая плотность размещения элементов электронных схем. В 

непосредственной близости друг от друга располагаются соединительные провода, кабели. При протекании 

по ним электрического тока выделяется значительное количество теплоты. При этом возможно оплавление 

изоляции. Для отвода избыточной теплоты от ЭВМ служат системы вентиляции и кондиционирования 

воздуха. При постоянном действии эти системы представляют собой дополнительную пожарную опасность. 

Для большинства помещений ВЦ установлена категория пожарной опасности В. 
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Одна из наиболее важных задач пожарной защиты - защита строительных помещений от разрушений и 

обеспечение их достаточной прочности в условиях воздействия высоких температур при пожаре. Учитывая 

высокую стоимость электронного оборудования ВЦ, а также категорию его пожарной опасности, здания для 

ВЦ и части здания другого назначения, в которых предусмотрено размещение ЭВМ, должны быть первой и 

второй степени огнестойкости. Для изготовления строительных конструкций используются, как правило, 

кирпич, железобетон, стекло, металл и другие негорючие материалы. Применение дерева должно быть 

ограничено, а в случае использования необходимо пропитывать его огнезащитными составами. 

Утилиты для очистки и оптимизации операционных систем. 
CCleaner официальный сайт программы http://www. /ccleaner (ранее — CrapCleaner) —

 бесплатная утилита с закрытым исходным кодом, которая предоставляет пользователям мощный и простой 

в использовании инструмент для очистки и оптимизации 32-битных и 64-разрядных операционных 

систем Microsoft Windows. Утилита была создана британской частной фирмой PiriformLimited и написана 

на C++. 

Обычно новая версия дистрибутива выходит каждый месяц. Некоторые пользователи отмечают тот факт, 

что частые обновления программы, делают утилиту не только более быстрой по скорости работы, но и более 

мощной с каждым выпуском. 

На октябрь 2011 года компания Piriform поддерживала разработку четырёх версий CCleaner, в число 

которых входят такие издания, как: 

·  FreeEdition — бесплатная версия утилиты. Единственное отличие от других изданий заключается в том, 

что к ней не предоставляется приоритетная техническая поддержка от разработчиков. 

·  HomeEdition — идёт совместно в комплекте с приоритетной технической поддержкой. Подходит для 

индивидуальных лиц для использования на домашних компьютерах. 

·  BusinessEdition — бизнес-издание может быть использовано различными компаниями на рабочих 

компьютерах для коммерческого использования. Разработчики предоставляют премиум бизнес-поддержку 

для предпринимателей совместно в комплекте с дистрибутивом. 

·  CCleanerNetworkEdition — сетевая версия программы для оптимизации работы в корпоративных сетях 

любой величины. Данную версию продукта можно установить не более чем на 10 компьютеров для бизнес-

использования. 

4. Задание 
Задание 1. Обновите через Интернет антивирусную программу, установленную на Вашем компьютере. 

Выполните проверку папки «Мои документы» на вирусы. Дать характеристику этой программы. 

Задание 2. Установите утилиту CCleaner на Ваш компьютер и выполнить очистку операционной системы и 

реестра компьютера. 

Задание 3. Укажите требования к помещениям кабинета информатики: 

Задание 4. Укажите, какие действия запрещены в кабинете информатики. 

Задание 5. Укажите комплекс упражнений для снятия усталости за компьютером. 

Задание 6. Укажите стандартные утилиты операционной системы для устранения ошибок, очистки и 

дефрагментации. 

5. Содержание отчета 
Отчет должен содержать: 

1.  Название работы. 

2.  Цель работы. 

3.  Задание и его решение. 

4.  Вывод по работе. 

6. Контрольные вопросы 
1.  Что такое вирус? 

2.  Дайте классификацию вирусов. 

3.  Для чего нужны антивирусные программы? 

4.  Дайте их классификацию 

5.  Требования к кабинету информатики. 

6.  Комплекс упражнений для снятия усталости за компьютером 

 

 

Практическое занятие № 6 Оборудование АРМ на базе ПК. 

 

Цель: ознакомиться с эксплуатационными требованиями к компьютерному рабочему месту; 

профилактическими мероприятиями для компьютерного рабочего места в соответствии с его комплектацией 

для профессиональной деятельности. 
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Содержание работы: 

Задание №1. Отразите основные санитарно-гигиенические требования к кабинету информатики: 

1.  

2.  

 

3.  

 

4.  

 

5.  

 

6.  

 

 

Задание №2. Укажите некоторые требования к помещениям кабинета информатики: 

1.  

 

2.  

 

3.  

 

 

Задание №3. Укажите, какие действия запрещены в кабинете информатики: 

1.  

 

2.  

 

3.  

 

4.  

 

Задание №4. Укажите комплекс упражнений для снятия усталости за компьютером: 

1.  

 

2.  

 

3.  

 

4.  

 

5.  

 

6.  

 

Задание №5. Сделать вывод о проделанной работе: 

 

Практическое занятие № 1 Форматирование абзаца. Выравнивание абзаца, оформление «красной 

строкой» отступы абзацев. Оформление и редактирование списка. 
Задание 1 1 Войдите в редактор MS Word. Ознакомьтесь со стандартным окном ре- дактора (строка главного 

меню и ее команды, панель инструментов и ее кноп- ки, служебные кнопки, функциональные клавиши). 2 

Установите поля документа: верхнее – 2 см, нижнее – 1,5 см, левое – 2,5 см, правое – 1 см. 3 Введите 

предложенный текст. 4 Сохраните текст под своим оригинальным именем. 14 5 Закройте документ. 6 

Откройте созданный текст для редактирования. 7 Визуально отредактируйте текст. 8 Сохраните 

отредактированный документ. 9 Закройте документ.  

Задание 2 1 Найдите в приведенном ниже тексте все случаи, когда пробелы были ис- пользованы не по 

назначению, и определите, какие настройки формата следо- вало бы здесь применить. 2 Наберите текст, 

исправляя неточности. 3 Сохраните текст под своим оригинальным именем. 4 Закройте документ.  



Задание 3 1 Наберите текст и отформатируйте, как показано в образце, исправляя ошибки. 15 2 Сохраните 

текст под своим оригинальным именем. 3 Закройте документ.  

Задание 4 1 Получите у преподавателя задание_1 и сохраните его под новым именем. 2 В созданном 

документе установите все поля по 2 см. 3 Разбейте текст на абзацы. 4 Удалите второй абзац. 5 В оставшемся 

тексте переставьте абзацы в обратном порядке. 6 Разрешите перенос слов. 7 Найдите в тексте слово 

«Интернет» и выделите его. 8 Найдите в тексте однокоренные слова и выделите их корни. 9 Проверьте 

орфографию текста, используя встроенный словарь. 10 Сохраните документ.  

Задание 5 1 Получите у преподавателя задания по редактированию текста (задание_2, 3). 2 Выполните 

редактирование. 3 Сохраните полученные документы в созданную папку. 

 Задание 6 1 Откройте созданный в задании_1 документ и получите его копию под но- вым именем. 16 2 

Выделите первый абзац и установите начертание букв полужирным, раз- мер букв – 16 пт, тип шрифта – 

CourierNew. 3 Сделайте выравнивание текста по ширине. 4 Для красной строки установите отступ в 1,5 см. 5 

Для каждого абзаца установите свой тип и цвет шрифта. 6 Перед и после второго абзаца сделайте интервалы 

в 24 пт. 7 Третий абзац уплотните 8 После третьего абзаца сделайте интервал в 18 пт. 9 Сохраните 

отформатированный документ. 

 Задание 7 1 Получите у преподавателя задания по редактированию текста (зада- ние_4). 2 Выполните 

проверку правописания. 3 Сохраните полученные документы в созданную папку. 

 Задание 8 1 Откройте задание_1 и сохраните его под новым именем. 2 В созданном документе установите 

все поля по 2 см и выделите границы текста. 3 Используя меню Фон страницы, создайте подложку с 

надписью «Моя подложка». 4 Измените цвет листа. 5 Сохраните полученный документ.  

1.4 Вопросы для самоконтроля 1 Как войти в редактор Word? 2 Найдите в окне редактора Word строку 

главного меню, стандартную панель инструментов, панель форматирования, строку состояния. 3 Укажите на 

панели инструментов кнопки: Масштаб (страницы), От- менить (предыдущие команды), Вернуть 

(предыдущие команды), Непеча- таемые символы (восстановить/убрать), Вырезать (текст), Копировать 

(текст), Вставить (текст). 4 Как перейти от «латиницы» к «кириллице» и обратно? 5 Для чего служат кнопки 

, , ? 6 Что такое: полоса прокрутки и как ею пользоваться? 7 Как выделить фрагмент текста? 

 

 

Практическое занятие № 2 . Поиск информации, структурирование информации с помощью MS Word 

Цель:Изучение технологии создания комплексных документов. 

Задача: Сформировать профессиональные компетенции.  

Задание:Создать текстовый документ, содержащий рисунок в виде схемы и маркированный список.(20 

баллов) 

Порядок работы 
1. Запустите текстовый редактор MicrosoftWord. 

2. Разверните окно редактора на весь экран. Установите вид — «Разметка страницы»; масштаб — 85 %. 

3. Задайте все поля страницы по 2,5 см. 

4. Перед началом набора текста установите размер шрифта — 12 пт.; вид — курсив и гарнитуру шрифта — 

TimesNewRoman. 

5. Командами Формат/Абзац задайте следующие параметры: 

межстрочный интервал — множитель 1,2; 

выравнивание — по ширине. 

6. Командами Сервис/Язык/Расстановка переносов установите автоматическую расстановку переносов. 

7. Наберите образец текста. Образец содержит один абзац текста, рисунок в виде схемы и маркированный 

список. 

Краткая справка. Для создания схемы воспользуйтесь возможностями панели Рисование (Вид/Панели 

инструментов/Рисование). После создания схемы проведите группировку для того, чтобы вся схема 

воспринималась как единый графический объект. Для этого выделите всю схему при помощи кнопки Выбор 

объекта панели Рисование, нажмите на кнопку Действия и выберите команду Группировать. 

Для создания списка используйте команду Формат/Список/ Маркированный. 

Образец задания 

Информационное письмо 

М 

етодология планирования материальных ресурсов производства (MRP) обеспечивает ситуацию, когда 

каждый элемент производства, каждая комплектующая деталь находится в нужное время в нужном 

количестве (рис. 4.1). 

На основании входных данных 

MRP-система выполняет следующие 

операции: 



Рис. 4.1. Структурная схема MRP 

• определяется количество конечных данных изделий для каждого периода времени планирования; 

• к составу конечных изделий добавляются запасные части; 

• определяется общая потребность в материальных ресурсах в соответствии с ведомостью материалов и 

составом изделия; 

• общая потребность материалов корректируется с учетом состояния запасов для каждого периода времени 

планирования; 

• осуществляется формирование заказов на пополнение запасов с учетом необходимого времени 

опережения. 

8. Проверьте введенный текст с точки зрения грамматики командой Сервис/Правописание. Исправьте все 

найденные ошибки. Сохраните документ. 

Задание 4.2. Оформить схемы по образцу (80 баллов). 

 

 

 



 
Методические указания по выполнению задания: 
Алгоритм выполнения  

Выполнить практическое занятие. 
Изучить теоретический материал по Теме 4.1 Использование пакетов MicrosoftOffice, OpenOffice. 

Внимательно прочитать задание и методические рекомендации по его выполнению. 

Выполнить задание. 

Вид контроля 
Защита с демонстрацией. 

Библиографический список: 
1. Колмыкова Е.А., Кумскова И.А. Информатика. Учебное пособие для студ.ентов СПО– М.: 

Академия, 2006. 

2. Михеева Е.В. Практикум по информатике: Учебное пособие для студ. СПО– М.: Академия, 2008. 

3. Михеева Е.В. «Информационные технологии в профессиональной деятельности». - М.: 

Издательский центр «Академия», 2008 г. 

4. Михеева Е.В. «Практикум по информационным технологиям в профессиональной деятельности». - 

М.: Издательский центр «Академия», 2006 г. 

5. www.consultant.ru — Консультант - Плюс 

6. www.garant.ru - ГАРАНТ 

 

 

Практическое занятие № 3 Форматирование документа согласно ГОСТ 

Цель работы: получить представление о компьютерных словарях и системах машинного перевода текста, 

познакомиться с возможностями данных программ, научиться использовать эти программы, ознакомление с 

программой оптического распознавания текстов ABBYY Finereader 6. 

2. Оборудование, приборы, аппаратура, материалы: персональный компьютер, MS Access. 

3. Краткие теоретические сведения. 
Обзор программ переводчиков 

Информация в Сети представлена не только на русском языке. Русскоязычный сегмент Интернета – это 

только лишь небольшая часть того, что можно найти в Глобальной Сети. Рано или поздно вам придется 

столкнуться с сайтами на других языках, например, на английском. Если у вас возникнут затруднения при 

понимании иностранных слов, вам помогут программы-переводчики. Традиционно этот сегмент 

программного обеспечения относится к бизнес-классу – большинство программ такого типа платные и стоят 

довольно дорого. Мы рассмотрим несколько более бюджетных решений, достаточно интересных. 

PROMT Express 
Сайт: http://www.promt.ru 

Эта программа – один из лучших переводчиков из известных на сегодняшний день. Базовая бесплатная 

версия программы, работоспособная в течение 30 дней, умеет работать с английским языком – переводить с 

английского на русский и наоборот. 

Чтобы перевести слово, можно ввести его в окне программы PromtX и нажать кнопку Перевести на панели 

инструментов. 

Кроме того, программа умеет отслеживать содержимое буфера обмена – фрагмент текста, скопированный в 

буфер, автоматически будет помещен в окно программы-переводчика. 

Сохранить результат перевода можно в RTF- или ТХТ-файле. 

Если вы хотите получить синхронный перевод, который будет отображаться в окне перевода по мере ввода 

текста, выберите Перевод > Синхронный перевод. 

http://infourok.ru/site/go?href=http%3A%2F%2Fwww.consultant.ru%2F
http://infourok.ru/site/go?href=http%3A%2F%2Fwww.garant.ru%2F


Если в вашей программе подключено несколько словарей, вы можете изменить базовый словарь, выбрав 

Тематика > Словари документа. Если вы хотите зарезервировать некоторые слова для того, чтобы оставлять 

их без перевода, выберите Тематика > Зарезервированные слова. Слова, которые добавлены в этот список, 

не будут переводиться с помощью программы. В такой список стоит добавить различные имена 

собственные, возможно, непереводимые названия. А пометив переключатель Транслитерировать, вы 

заставите программу выводить зарезервированное слово латинскими буквами. 

Web Translator 
Скачать Web Translator: http://samouchka.net/2006/11/27/web_translator_v80.html 

Эта программа умеет переводить сразу в нескольких направлениях. Среди языков, с которыми умеет 

работать WebTranslator – английский, французский, испанский, немецкий, португальский, итальянский, 

русский и еще несколько других. 

Программа умеет работать в двух режимах – в режиме Web и в режиме Text. Переключает их одноименная 

кнопка на панели инструментов программы. 

В режиме Text программа позволяет ввести текст с клавиатуры или же вставить его из буфера обмена. При 

этом доступны инструменты форматирования текста, а также работа с буфером обмена. 

Кроме того, программа может переводить содержимое RTF- и ТХТ-файлов. Для начала вам нужно открыть 

файл, выбрав File>OpenSourceDocument. Поменять местами значения языков оригинала и перевода вы 

можете с помощью кнопки Swap. 

На панели инструментов, выбирая нужные значения из списка, установите языки оригинала и перевода. 

VuDictionary 
СкачатьVuDictionaryможноздесь: http://www.vu-software.spb.ru/startpage 

VuDictionary – это простой словарь для перевода английских слов, который умеет работать в фоновом 

режиме. Программа может переводить только с английского на русский, работая со стандартным словарем. 

Работает она так: пользователь вводит слово в строке, по ходу чего из словаря отбираются подходящие 

варианты перевода. Комплект отобранных вариантов отображается в виде списка, при этом отображается 

только ближайший перевод. Полный набор вариантов можно посмотреть в специальном окне, выделив 

нужное слово. 

Слова в окне программы размещены по алфавиту. После удачного перевода найденное слово запоминается в 

списке истории, и в будущем перевод можно просмотреть, не прибегая к поиску. 

Кстати, окно с переводом содержит очень детальную информацию, включая транскрипцию, варианты 

словоупотребления, варианты перевода. 

TranslatIt! 
Сайт: http://www.translateit.ru 

Эта программа отображает перевод во всплывающем окне рядом с незнакомым словом на web-странице. 

Для этого достаточно навести на него мышиную стрелку. 

После запуска приложение размещает свой значок в системномтрее, откуда и можно управлять его работой: 

изменить направление перевода, задать настройки, проверить обновления. Если программа работает в 

активном режиме (о чем сигнализирует пиктограмма, расположенная в трее), то для перевода незнакомого 

слова в браузере нужно просто задержать мышку над словом. Через несколько мгновений перевод появится 

рядом со словом. 

Если постоянно появляющееся всплывающее окно с переводом слова мешает, можно установить режим 

отображения перевода только при нажатой клавише Ctrl. 

LingvoOnLine! 
Скачать плагин для firefoxLingvoOnLine! можно здесь: https://addons.mozilla.org/ru/firefox/addon/991 

Плагин LingvoOnLine!, который позволяет переводить слова с английского на русский и обратно с помощью 

одного из двух сервисов – lingvo.yandex.ru или lingvo.ru. 

В результате установки плагин интегрируется в контекстное меню. Для перевода слова вам необходимо 

выбрать TranslatewithLingvo и указать, с какого языка необходимо получить перевод. В результате во 

всплывающем окне будет отображен результат работы переводчика с переводом выделенного слова. 

. Задание №1«Сканирование и распознавание двух страниц любой книги средствами программы ABBYY 

Finereader»  

 

Ход работы: 

Перед началом работы убедитесь, что Ваш сканер включен и в него вложен нужный Вам документ.  

1. Запустите программу ABBYY FineReader 

(Пуск/Программы/ABBYY FineReader 6.0 Sprint).  

2. Нажмите кнопку , чтобы начать сканирование.  

После того, как программа отсканирует документ, Вы сможете увидеть его в окне Изображение. 

3. Нажмите кнопку , распознанный текст появится в окне Текст. 



4. Чтобы сохранить результаты распознавания, нажмите кнопку . 

Выберите формат документа  MicrosoftWord, имя файла СКАНЕР. 

5. Выполните редактирование и форматирование полученного текстового документа. 

Задание №2 «Распознавание уже имеющихся файлов или изображений в текстовый документ Word» 

 

Ход работы: 

1. Запустите программу ABBYY FineReader (Пуск/Программы/ABBYY FineReader 6.0 Sprint).  

 

2. Для распознавания текста из графического файла  

– нажмите на стрелку справа от кнопки и в открывшемся меню выберите пункт Открыть изображение... В 

открывшемся окне выберите нужный файл (папка Красная книга, имя файла совпадает с именем 

животного). 

– или нажмите кнопку и укажите путь к нужному изображению.  

(папка Красная книга, имя файла совпадает с именем животного). 

Вы сможете увидеть открытый файл в окне Изображение. 

 

3. Нажмите кнопку , распознанный текст появится в окне Текст.  

4. Чтобы сохранить результаты распознавания, нажмите кнопку  . 

Мастер сохранения поможет Вам сохранить результаты распознавания в удобной для Вас форме. Имя 

файла совпадает с именем животного. 

5. Выполнить редактирование и форматирование полученного текстового документа. 

6. Подготовить небольшое сообщение о животном – наиболее интересные факты. 

7. Файл своей работы передать по сети через папку обмена рабочего стола. 

5. Контрольные вопросы 
1.  

1. Какие программы переводчики вы знаете? 

2. Программы переводчики нужны для… 

3. Системы машинного перевода основаны на…. 

4. Нецелесообразно переводить…. 

5. Компьютерный перевод нуждается в.. 

6. Какие программы для распознавания текста вы знаете? 

6. Литература 
1.  

1. Информатика и ИКТ: учебник для начального и среднего профессионального образования. 

Цветкова Н.С., Великович Л.С. – Академия, 2011 г. 

2. Информатика и ИКТ. Практикум для профессий и специальностей технического и 

социально-экономического профилей. Н. Е. Астафьева, С. А. Гаврилова, под ред. М.С. 

Цветковой, Академия, 2012г. 

3. Информатика и ИКТ. Базовый уровень: учебник для 10-11 кл. / И.Г.Семакин, Е 

4. http://samouchka.net/2006/11/27/web_translator_v80.html 

5. : http://www.vu-software.spb.ru/startpage 

6. http://www.translateit.ru 

7. https://addons.mozilla.org/ru/firefox/addon/991 

 

 

Практическое занятие № 4 Сохранение документов в различных форматах  

Задача №1  

Вставка специальных символов, знаков, формул  
А) Набрать формулу без помощи специального редактора формул (диал. окно Шрифт → Видоизменение 

→ Надстрочный (Подстрочный)):  

s=s0+vt+at2.  

Б) Набрать формулы и текст,  

используя вставку специальных символов и знаков (вкл.Вставка → гр. Символы → Символ → Другие 

символы):  
v=Δx/Δt, {π, μ, Ω}, Microsoft®,  

map [mǽp], pen [pən],  

используя смещение вверх или вниз (диал. окно Шрифт → вкл.Интервал → Смещение вверх (вниз) на 6 

пт, размер шрифта 12 пт).  

 



Σμiik, Ππlmn.  

В) Набрать формулы, используя редактор формул (вкл. Вставка → гр. Символы → Формула → Вставить 

новую формулу)  

.  

Задача №2  

Многоуровневые списки  
Создание многоуровневого списка: вкл. Главная → гр. Абзац → Многоуровневые списки.  

Понижение уровня списка: кн. Увеличить отступ или кн. Tab. Повышение уровня списка: кн. Уменьшить 

отступ или кн. Shift+Tab.  

А) Набрать следующие строки и оформить их как маркированный список (выбрать любой рисованный 

маркер):  

Вставка специальных символов и знаков  

Редактор формул  

Использование графических примитивов  

 

Оформление страниц  

Колонки  

Многоуровневые списки  

Буквица  

Вставка даты  

Вставка экспресс-блока 

 

Б) Маркированный список из пункта А) сделать многоуровневым по образцу. Для этого использовать:  

инструменты вкл. Главная – гр. Абзац – Многоуровневый список – Уменьшить отступ (Увеличить 

отступ),  

опции контекстного меню (ПК мыши) Задать начальное значение... иИзменить отступы в списке...  

маркеры на горизонтальной линейке.  

 

5. Вставка специальных символов и знаков  

5.1. Редактор формул  

5.1.1. Использование графических примитивов  

6. Оформление страниц  

6.1. Колонки  

6.1.1. Многоуровневые списки  

6.1.2. Буквица  

7. Вставка даты  

7.1. Вставка экспресс-блока 

 

В) Список из пункта Б) видоизменить в соответствии с образцом (символы нумерации 1-го уровня (10, 11, 

12) - размер 14 пт, начертание жирное; символы 2-го уровня (а, б, в) – размер 12 пт, начертание полужирный 

курсив, 3-го уровня – 10 пт, курсив):  

10) Вставка специальных символов и знаков  

a) Редактор формул  

b) Использование графических примитивов  

i) Оформление страниц  

11) Колонки  

a) Многоуровневые списки  

b) Буквица  

12) Вставка даты  

a) Вставка экспресс-блока 

 

Г) Список из пункта В) видоизменить в соответствии с образцом (элементы списка и нумерация 1-го уровня 

(7, 8, 9) – шрифт TimesNewRoman зеленого цвета, выравнивание номера 1 см, отступ текста 1 см; символы 

2-го  

 

 



уровня – шрифт CourierNew красного цвета, выравнивание номера 2 см, отступ текста 1 см, 3-го уровня – 

шрифт CourierNew, оранжевый, выравнивание номера 3 см, отступ текста 0.5 см), используя контекстное 

меню (ПК мыши, опцияИзменить отступы в списке):  

7) Вставка специальных символов и знаков  

a) Редактор формул  

b) Использование графических примитивов  

i) Оформление страниц  

8) Колонки  

a) Многоуровневые списки  

b) Буквица  

9) Вставка даты  

a) Вставка экспресс-блока 

 

Задача №3  

Нумерация страниц. Колонтитулы  
Вставить нумерацию страниц (вкл. Вставка → гр. Колонтитулы → Номер страницы → Внизу страницы 

– Простой номер 1 (по левому краю страницы)).  

Вставить верхний и нижний колонтитулы (вкл.Вставка → гр. Колонтитулы → Верхний (Нижний) 

колонтитул).  

В верхний колонтитул поместить информацию о содержании документа (на нечетных страницах) и его 

авторе (на четных страницах), а в нижний – дату (на нечетных страницах) и время (на четных страницах) с 

автоматическим обновлением.  

Для оформления верхнего колонтитула можно использовать всплывающее окно Встроенный верхнего 

колонтитула (вкл.Вставка → гр. Колонтитулы → Верхний колонтитул), на котором выбрать любой 

вариант с различным оформлением четной и нечетной страниц и возможностью ввода текста (например, 

Головоломка).  

Для оформления нижнего колонтитула можно использовать инструментИзменить нижний колонтитул 

нижнего колонтитула (вкл. Вставка → гр. Колонтитулы → Нижний колонтитул - Изменить нижний 

колонтитул). На появившейся вкладке Работа с колонтитулами, Конструктор выбрать опцию Разные 

колонтитулы для четной и нечетной страниц и далее на вкл. Вставить выбрать Дату и время с 

автоматическим обновлением. Практическое занятие № 5 5 вторник, 9 сентября 2014 г.  

Задача 4 

Вставка объектов WordArt, SmartArt 
Заголовок «Задача №4» отобразить как объект WordArt произвольным образом (вкл.Вставка → гр. Текст 

→ WordArt → выбор варианта). Установить размер шрифта 28 пт (контекстное меню объекта (ПК мыши) – 

Изменить текст).  

Содержание основных этапов выполненной на занятии работы отобразить с помощью вставки рисунка 

SmartArt (вкл.Вставка → гр. Иллюстрации → SmartArt → Список → Вертикальный список). Названия 

этапов вписать в текстовые блоки по-отдельности либо вставить заранее подготовленный набор строк. 

Например:  

Задача №5  

Сноски  
Сноски используются для оформления кратких комментариев и примечаний. Сноска может быть обычной (в 

конце текущей страницы документа) и концевой (в конце всего документа).  

После любых двух абзацев в тексте ПЗ вставить сноски (обычные) (вкл. Ссылки → гр. Сноски → 

Вставить сноску) с текстом комментария «Это мое первое ПЗ» или «Основы информационных 

технологий». Обратить внимание на автоматическую нумерацию сносок.  



В любом месте текста вставьте концевую сноску (вкл. Ссылки → гр. Сноски → Вставить концевую 

сноску). Научитесь просматривать сноски и перемещаться по ним (вкл. Ссылки → гр. Сноски → 

Показать сноски, а также меню Следующая сноска).  

Задача №6  

Примечания  
С помощью примечаний удобно размещать комментарии к тексту документа. Вставить примечания 

произвольного содержания к любым двум задачам (вкл. Рецензирование → гр. Примечание → Создать 

примечание).  

Задача №7  

Закладки  
С помощью закладок легко находить нужные фрагменты в большом документе.  

В тексте отчета по ПЗ-1 создайте закладки для задач №2 (списки), №5 (сноски) и дайте им соответствующие 

названия с помощью инструментов вкл. Вставка → гр. Связи → Закладка → Имя закладки окна 

Закладка → Добавить.  
Научитесь перемещаться по закладкам. Удалите одну из закладок (вкл. Вставка → гр. Связи → Закладка 

→ выделить имя закладки → Перейти).  

Задача №8  
Вставка титульной страницы  

Оформляя документ с материалами ПЗ №1, предусмотреть вставку титульной страницы (Вкл.Вставка → 

гр. Страницы → Титульная страница). 

 

Практическое занятие № 5  
Создание и редактирование таблиц. Вставка и редактирование рисунка.Цель занятия: Изучение 

основных приемов создания, редактирования и форматирования таблиц 

 

 

ТЕОРЕТИЧЕСКИЙ МАТЕРИАЛ 
Для работы с таблицами в Microsoft Word применяют контекстные 

вкладки Конструктор и Макет группы вкладок Работа с таблицами (рис. 1). Эти вкладки 

автоматически отображаются, когда курсор находится в какой-либо ячейке существующей 

таблицы. 

 
Рис. 1.  Вкладки для работы с таблицами 

 

 



Кроме обычных таблиц Word документы могут содержать таблицы, импортированные из Microsoft 

Excel, и таблицы Microsoft Excel, созданные непосредственно в документе. 

Вставка таблицы Microsoft Word 

Таблица всегда вставляется в то место документа, где в данный момент находится курсор. Лучше 

всего поставить курсор в начало абзаца текста, перед которым должна располагаться создаваемая 

таблица. 

Для быстрой вставки простой таблицы во вкладке Вставка нажмите кнопку Таблица и в 

появившемся табло при нажатой левой кнопке выделите необходимое число столбцов и строк (рис. 

2). При наведении указателя мыши срабатывает функция динамического просмотра, и создаваемая 

таблица отображается в документе. Таблица занимает всю ширину страницы и имеет столбцы 

одинаковой ширины. 

 
Рис. 2.  Вставка простой таблицы 

 

 

Можно настроить некоторые параметры создаваемой таблицы. 

Установите курсор туда, где будет находиться создаваемая таблица. 

Щелкните кнопку Таблица во вкладке Вставка и выберите команду Вставить таблицу (см. рис. .2). 

В окне Вставка таблицы (рис. 3) выберите требуемое количество строк и столбцов, а также способ 

автоподбора. При выборе режима постоянный можно установить ширину столбцов таблицы. 

 
Рис. 3.  Выбор параметров вставляемой таблицы 



 

 

При создании таблицы можно воспользоваться имеющимися заготовками Microsoft Word или 

собственными, ранее созданными таблицами. 

Установите курсор туда, где будет находиться создаваемая таблица. 

Нажмите кнопку Таблица во вкладке Вставка и выберите команду Экспресс-таблицы (см. рис. 2). 

Прокрутите список таблиц и выберите нужную (рис. 4). Пользовательские таблицы, занесенные в 

список экспресс-таблиц, обычно располагаются в разделе Общие в конце списка. 

 
Рис. 4.  Выбор экспресс-таблицы 

 

 

В результате в документ будет вставлена готовая, содержащая текст и оформление таблица (рис. 5). 

Оформление встроенных экспресс-таблиц Microsoft Word зависит от выбранной темы документа. 

Вставленная таблица может иметь заголовок. Ненужный текст можно удалить. Можно также 

изменить оформление таблицы. 

 
Рис. 5.  Вставленная в документ экспресс-таблица 

 

 



Ход работы: 

 

 

1. Запустите программу Microsoft Word 

2. Создайте текстовый документ  Таблица_1.doc, который сохраните в своей папке на диске 

D: Выполните в этом файле следующие задания: 

2.1. Командой Вставить таблицу постройте таблицу состоящую из 10 строк и 5 столбцов. 

o Выделите ячейки первой строки и из контекстного меню объедините их 

o Аналогично объедините все ячейки нижней строки, затем восемь средних ячеек 

первого и последнего столбцов 

o Запишите в объединенных ячейках слова ТАБЛИЦА, выровняйте текст по центру и 

измените направление записи текста (ориентацию) 

 
2.2. Построение таблицы командой Нарисовать таблицу по образцу, приведенному ниже: 

 

 

 
o Залить каждую строку таблицу разными цветами 

 

 

2.3 Командой Нарисовать таблицу построить таблицу состоящую из 3 строк и 4 столбцов. 

Границы таблицы должны быть построены красной тройной линией толщиной 3 пт., а внутренние 

границы – пунктирной линией в 1,5 пт. синего цвета. 

o Задайте высоту строк – 1 пт., ширину столбцов – 2 пт. 

o Введите произвольные цифры в ячейки таблицы и настройте выравнивание 

как  показано на рисунке ниже. 

 

 

 

 



 
 

 

3. Создайте текстовый документ  Таблица_2.doc по образцу приведенному ниже. Файл 

сохраните  в своей папке на диске D. 

 

 

 
 

 

Рекомендации по выполнению задания 
 Для создания символов -1….-3   воспользуйтесь диалоговым окном 

форматирования Шрифта и установите флажок в списке Видоизменение – Контур 

 Символ ✵ возьмите в наборе Wingdings, Ш – Webdings,  ☼ –Times New Roman. 

 Первая  строка залита синим цветом, а цвет шрифта – белый 

 Третья строка залита желтым цветом, цвет букв - черный 

 
4. Создайте текстовый документ  Таблица_3.docx по образцу приведенному ниже. Файл 

сохраните  в своей папке на диске D. 

 

 



 
Анализ результатов работы 

 

Практическое занятие № 6 Редактирование документов с таблицами, рисунками 
Текстовый процессор Word 2007 обладает большим набором средств для работы с таблицами, 

позволяющими легко и быстро выполнять различные стандартные операции с таблицами: создание, 

редактирование, форматирование. 

Таблица состоит из столбцов и строк, на пересечении которых находятся ячейки. В ячейках 

таблицы могут быть числовые данные, текст, графика, ссылки на данные из других документов и 

др. Наиболее удобно использовать таблицы для хорошо структурированных данных, например, 

списков, расписаний, финансовой информации. 

Таблицы позволяют легко и быстро форматировать, содержащиеся в них данные, сортировать их, 

производить некоторые вычисления, строить диаграммы. 

С помощью таблиц можно разместить текст в несколько колонок, изменить направление текста, 

выровнять абзацы текста и рисунки. 

Данные, представленные в табличной форме, отличаются наглядностью. Таблицы всегда были 

неотъемлемым атрибутом печатной документации. 

2. Создание таблиц 

Текстовый процессор Microsoft Word 2007 предусматривает множество способов создания таблиц. 

Командой ВСТАВКА – группа Таблицы – Таблица открывается меню, в котором можно указать 

способ создания таблиц. 



 

1. Указать мышкой в графической карте число столбцов и число строк. 

2. Выбрать команду Вставить таблицу. В появившемся диалоговом окне Вставка 

таблицы указать количество строк и столбцов. 

 

3. Выбрать команду Нарисовать таблицу. С помощью появившегося инструмента -

 карандаша начать рисовать таблицу. После этого появляется контекстная панель Работа с 

таблицами с вкладкой Конструктор с инструментами рисования. 

 



Инструменты рисования на вкладке Конструктор. 

 

Раскрывающийся список Стиль пера предоставляет обширный набор линий для изображения 

границ. 

Раскрывающийся список Толщина пера предназначен для задания толщины линий. 

Кнопка Цвет пера открывает цветовую палитру. 

Кнопка Нарисовать таблицу действует как перекаключатель. Она включает и выключает 

инструмент Карандаш. 

Кнопка Ластик включает и выключает инструмент Ластик, предназнвченный для удаления линий. 

Кнопка Границы и заливка открывает диалоговое окно с расширенным набором средств 

для оформления таблиц. 

4. Выбрать команду Преобразовать в таблицу предварительно набранный табулированный 

текст. 

Табулированным называют текст, в котором в качестве разделителей элементов текста 

используется код табуляции. Он вводится нажатием клавиши Tab . Действие его состоит в том, что 

введенный после него текст сдвигается на несколько позиций, установленных заранее. 

Настройку позиции табулятора можно выполнить командой ГЛАВНАЯ – группа Абзац –

 кнопка Табуляция. В появившемся диалоговом окне можно настроить позицию табулятора. 

 

Другой способ настройки позиции табулятора - отбуксировать на разметочной линейке маркер 

табулятора, который появляется щелчком по нижней части линейки. 



 

5. Выбрать команду Экспресс-таблицы. С помощью экспресс-технологий можно создать 

таблицу, оформленную профессионально. В появившемся меню открывается список 

заготовок Экспресс-таблиц. 

 

Выбрав нужную заготовку, ее вставляют в документ в качестве исходной таблицы. Затем в ней, 

если нужно, вставляют дополнительные столбцы, строки, вводят содержание, корректируют 

структуру и оформление. 

 

 

Практическое занятие № 7,8  Расчеты с применение элементарных формул  

Цель: Получить практические навыки создания и редактирования электронных таблиц, ввода формул в таблицу, 

сохранения таблицы на диске. 

Ход работы: 

1. Составьте прайс-лист по образцу: 

 

Прайс-лист магазина 

"РОГА И КОПЫТА" 

  28.09.11 

 Курс доллара 4,6 грн. 

   
Наименование товара Цена в у.е. Цена в грн. 

Тетрадь в клеточку $0,20 0,92 грн. 

Тетрадь в линеечку $0,20 0,92 грн. 

Пенал $2,00 9,20 грн. 



Ручка $0,50 2,30 грн. 

Карандаш $0,20 0,92 грн. 

Линейка $0,30 1,38 грн. 

Резинка $0,40 1,84 грн. 

Этапы выполнения задания: 

1. Выделите ячейку В1 и введите в нее заголовок таблицы Прайс-лист магазина "РОГА И КОПЫТА" 

2. В ячейку С2 введите функцию СЕГОДНЯ (Поставьте знак «=»  Нажмите кнопку fx на панели 

инструментов. В поле КАТЕГОРИЯ выберите Дата и Время. В нижнем поле выберите 

функцию Сегодня). 

3. В ячейку В3 введите слова «Курс доллара», в С3 – курс доллара на сегодняшний день. 

4. К ячейке С3 примените денежный формат (Формат  Формат ячеек  Вкладка Число  Числовой 

формат  Денежный  Обозначение можно выбрать произвольное). 

5. В ячейки А5:В5 введите заголовки столбцов таблицы. 

6. Выделите их и примените полужирный стиль начертания и более крупный шрифт. 

7. В ячейки А6:А12 и В6:В12 введите данные. 

8. В ячейку С6 введите формулу: = В6*$C$3. ($ означает, что используется абсолютная ссылка). 

9. Выделите ячейку С6 и протяните за маркер заполнения вниз до ячейки С13. 

10. Выделите диапазон ячеек С6:С13 и примените к ним денежный формат. 

11. Выделите заголовок – ячейки В1:С1 и выполните команду Формат Ячейки, вкладка Выравнивание и 

установите переключатель «Центрировать по выделению» (Горизонтальное выравнивание), 

«Переносить по словам». Увеличьте шрифт заголовка. 

12. В левой части прайс-листа вставьте картинку по своему вкусу. 

13. Измените название ЛИСТ1 на Прайс-лист. 
2. Рассчитайте ведомость выполнения плана товарооборота киоска №5 по форме: 

№ Месяц Отчетный год 
Отклонение от 

плана 

  
план фактически выполнение, % 

 
i Mi Pi Fi Vi Oi 

1 Январь 7 800,00 р. 8 500,00 р.   

2 Февраль 3 560,00 р. 2 700,00 р.   

3 Март 8 900,00 р. 7 800,00 р.   

4 Апрель 5 460,00 р. 4 590,00 р.   

5 Май 6 570,00 р. 7 650,00 р.   

6 Июнь 6 540,00 р. 5 670,00 р.   

7 Июль 4 900,00 р. 5 430,00 р.   

8 Август 7 890,00 р. 8 700,00 р.   

9 Сентябрь 6 540,00 р. 6 500,00 р.   

10 Октябрь 6 540,00 р. 6 570,00 р.   

11 Ноябрь 6 540,00 р. 6 520,00 р.   

12 Декабрь 8 900,00 р. 10 000,00 р.   

 

1. Заполнение столбца Mi можно выполнить протяжкой маркера. 

2. Значения столбцов Vi и Oi вычисляются по формулам: Vi=Fi / Pi; Oi=Fi – Pi 

3. Переименуйте ЛИСТ2 в Ведомость. 



4. Сохраните таблицу в своей папке под именем Практическая работа 11 

5. Покажите работу учителю. 
 
 

Практическое занятие № 9,10 Возможности системы электронных таблиц для решения профессиональных 

задач 

Цель:Научиться работать с электронными таблицами. 

Задача: Формирование профессиональных компетенций. 

Задание: Для автоматизации обработки данных, представленных в табличной форме, используются 

специальные программы, называемые электронными таблицами или табличными процессорами. Мы 

познакомимся с табличным процессором MicrosoftExcel. 

Окно табличного процессора Excel (рассматривается версия 2003 года) содержит стандартную строку 

заголовка, строку меню и панели инструментов (рис. 2.8). В основном мы будем использовать панели 

инструментов Стандартная и Форматирование. 

 
Рис. 2.8 
Создаваемый и сохраняемый в Excel документ называется рабочей книгой. Рабочая книга состоит 

из рабочих листов, похожих на листы бухгалтерской книги. Их можно перелистывать, щелкая на ярлыках, 

расположенных внизу окна. 

Основная часть окна табличного процессора – рабочий лист. Рабочий лист состоит из 256 столбцов и 65 

536 строк (в версии 2007 года стало 16 384 и 1 048 576 соответственно). 

 
Версия 2007 года 
Столбцы именуются латинскими буквами (одно- и двухбуквенными именами) в алфавитном порядке в 

направлении слева направо. Строки нумеруются сверху вниз, начиная с 1. 

На пересечении столбцов и строк образуются ячейки. Каждая ячейка имеет имя, составленное из 

буквенного имени столбца и номера строки, на пересечении которых она располагается. Имя ячейки иначе 

называют ее адресом. 

Расположенные подряд ячейки в строке, столбце или прямоугольнике образуют диапазон. При задании 

диапазона указывают его начальную и конечную ячейки, в прямоугольном диапазоне — ячейки левого 

верхнего и правого нижнего углов. Наибольший диапазон представляет вся таблица, наименьший — одна 

ячейка. Примеры диапазонов: A1:A1O, В2:С2, B2:D10. 

Важным элементом электронной таблицы является табличный курсор — выделенный прямоугольник. Его 

можно поместить в любую ячейку таблицы. Ячейка таблицы, которую в данный момент занимает курсор, 

называется активной ячейкой. Вводить или редактировать данные можно только в активной ячейке. 

В ячейке могут помещаться текст, число или формула. 

Тексты (надписи, заголовки, пояснения) нужны для оформления таблицы, в текстовой форме могут быть 

представлены характеристики рассматриваемых объектов. 

С помощью чисел (натуральных, целых, рациональных) задаются различные количественные 

характеристики рассматриваемых объектов. Числовые данные, введенные в ячейки таблицы, являются 

исходными данными для проведения вычислений. 

Формулы являются своеобразными инструкциями, определяющими порядок вычислительных действий. 

Они могут содержать имена ячеек, числа, знаки операций и обращения к функциям. 

Арифметические операции «Сложение», «вычитание», «умножение» и «деление» обозначаются 

соответственно символами «+», «-», «*» и «/». 

При решении задач мы будем использовать функции суммирования (СУММ), вычисления среднего 

арифметического значения (СРЗНАЧ), нахождения максимума (МАКС) и минимума (МИН). 

Например, вычисление стоимости припасенного Незнайкой кваса в ячейке DЗ осуществляется по формуле 

ВЗ*СЗ, газировки (ячейка D4) — по формуле В4*С4, касторки (ячейка D6)- по формуле В6*С6. Общее 

количество напитков (ячейка С7) может быть найдено по формуле С3+С4+С5+С6 или СУММ(СЗ:С6). 

При вычислении по формуле используется порядок операций, принятый в математике. Для его изменения 

можно применять круглые скобки. 



Изменение содержимого любой ячейки приводит к автоматическому пересчету значений всех ячеек 

таблицы, в которых есть ссылки на данную. 

Электронные таблицы не только автоматизируют расчеты, но и являются эффективным средством 

моделирования различных вариантов и ситуаций. Меняя значения исходных данных, можно проследить за 

изменением получаемых результатов и из множества вариантов решения задачи выбрать наиболее 

подходящий.  

Методические указания по выполнению задания: 
Алгоритм выполнения  

Выполнить практическое занятие. 

1.Изучить теоретический материал по Теме 4.1 Использование пакетов MicrosoftOffice, OpenOffice. 

 

2.Внимательно прочитать задание и методические рекомендации по его выполнению. 

3.Выполнить задание. 

Вид контроля 
1.Защита с демонстрацией. 

Библиографический список: 
1. Колмыкова Е.А., Кумскова И.А. Информатика. Учебное пособие для студ.ентов СПО– М.: 

Академия, 2010. 

2. Михеева Е.В. «Практикум по информационным технологиям в профессиональной деятельности». - 

М.: Издательский центр «Академия», 2014 г. 

3. www.consultant.ru — Консультант - Плюс 

4.www.garant.ru – ГАРАНТ 

 

 

Практическое занятие № 11 Разработка структуры презентации  

Цель: Научиться создавать презентации. 

Задача: Сформировать профессиональные компетенции.  

Задание Необходимо создать презентацию по представлению новых услуг туристического агентства. 

1. Создайте слайд по рис. 1: 

 
Рис. 1 

• разметка слайда Титульный слайд; 

• заголовок «Приглашаем в путешествие» 

• подзаголовок «Новые туры по всему свету»; 

• вставьте объект WordArt «Фирма «Здравствуй! Это я!» (Вставка — Рисунок — объект WordArt); 

• примените оформление «Глобус» (Формат - Оформление 

• эффект появления слайда на экране медленное «прорезание через черное» (Показ слайдов — Смена 

слайда), смена слайда по щелчку; 

• настройте анимацию (Показ слайдов - Настройка анимации): 

• включите анимацию «автоматически» для всех объектов; 

• установите следующий порядок появления объектов на слайде: подзаголовок, объект WordArt, заголовок; 

• установите эффекты: 

- для заголовка «Вылет слева», появление текста «Все вместе», «Былет 

— для подзаголовка «Вылет сверху», появление текста «По словам», «Быстро»; 

- для объекта WordArt «Вылет снизу-слева», «Быстро». 

2. Создайте слайд по рис. 2: 

• Вставка — Создать слайд - разметка слайда Заголовок и текст; 

• заголовок «У нас»; 
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• введите текст, оформите его списком, поменяйте вид маркера (Формат — Список — Знак); 

 
• примените фон «Зеленый мрамор (формат—Фон — Способы заливки - Текстура — «Зеленый мрамор» - 

Применить), 

• эффект появления слайда на эк ране медленное «прямоугольник внутрь (Показ слайдов - Смена слайда), 

сме на слайда по щелчку; 

• настройте анимацию (Пока слайдов - Настройка анимации): 

• включите анимацию автомати 

чески для всех объектов, 

• установите следующий порядок появления объектов на слайде: заголовок, текст 

• установите эффекты: 

- для заголовка «Вылетслева», появление текста «Все вместе», 

-для текста списка «Вылет сверху», появление текста «Все вместе по абзацам 1 - го уровня». 

3. Создайте слайд по рис. 3: 

• Вставка — Новый слайд - разметка слайда «Заголовок, объект и текст»; 

• заголовок «Путешествие в Монголию» 

• вставьте текст «Сопки, экзотика, цветущие дали» (Вставка — Надпись), 

• введите текст слайда; 

• вставьте подходящий по смыслу рисунок (двойной щелчок на подходящем рисунке в местозаполнителе 

или Вставка — Рисунок —Картинки), 

• примените фон «Пламя» (Формат — Фон — Способы заливки — Градиентная—Заготовка — «Пламя»—

Диагональная 1 — Применить); 

• эффект появления слайда на экране медленное «жалюзи вертикальные» (Показ слайдов — Смена слайда), 

смена слайда по щелчку; 

• настройте анимацию (Показ слайдов - Настройка анимации): 

• выберите объекты Заголовок, Надпись, текст, рисунок, 

• включите анимацию автоматически для всех объектов, 

• установите эффекты: 

- для заголовка «Вылет сверху», появление текста «Все вместе», 

- для надписи «Вылет слева», появление текста «По словам», 

- для основного текста «Вылет снизу-справа», появление текста «Все вместе», 

- для рисунка «Шашки вертикальные». 

4. Создайте слайд по рис. 4: — • Вставка - Новый слайд - разметка слайда «Заголовок, объект и текст »; 

• заголовок «Путешествие в Испанию»; 

• введите текст елайда; 

• вставьте подходящий по смыслу рисунок (двойной щелчок на подходящем рисунке в местозаполните-ле 

или Вставка — Рисунок — Картинки): 

• примените фон « Водяные капли» (Формат — Фон — Способы залив - | ки — Текстура — «Водяные 

капли» — Применить); 1 

• измените цвет букв (Формат — Шрифт — Цвет); 1 

• эффект появления слайда на экране медленное «прямоугольник на - 1 ружу» (Показ слайдов — Смена 

слайда), смена слайда по щелчку; 1 

• настройте анимацию (Показ слайдов — Настройка анимации): \ 

• выберите объекты Заголовок, Надпись, текст, рисунок; ] 

• включите анимацию автоматически для всех объектов; ) 

• установите эффекты: | 



- для заголовка «Случайное построение», появление текста «Все вме - | сге»; ' 

- для основного текста «Вылет снизу-справа», появление текста «бее вместе»; 

- для рисунка «Спираль»Создайте слайд по рис. 5: 

• Вставка - Новый слайд - разметка слайда «Заголовок, объект и текст»; 

• заголовок «Путешествие в Ки - щ тай»; Щ 

• введите текст слайда; £ 

• вставьте подходящий по смыслу Ж рисунок; £ 

• примените фон «Ранний закат» Л (Формат — Фон — Способы заливки — £ Градиентная — Заготовка — 

«Ранний ц закат» — Из угла — Применить); J 

• эффект появления слайда на "щ экране медленное «шашки горизонтальные» (Показ слайдов — Смена 

слайда), смена слайда по щелчку; 

• настройте анимацию (Показ слайдов — Настройка анимации). 

• выберите объекты Заголовок, Надпись, рисунок, текст; 

• включите анимацию автоматически для всех объектов; 

• установите эффекты: 

— для заголовка «Панорама горизонтальная наружу», появление текста «Все вместе»; 

- для основного текста «вылет снизу-справа», появление текста «Все вместе»; 

Методические указания по выполнению задания: 
Алгоритм выполнения  

Выполнить практическое занятие. 

1.Изучить теоретический материал по Теме 4.1 Использование пакетов MicrosoftOffice, OpenOffice. 

2.Внимательно прочитать задание и методические рекомендации по его выполнению. 

3.Выполнить задание. 

Вид контроля 
1.Защита с демонстрацией. 

Библиографический список: 
1. Михеева Е.В. «Информационные технологии в профессиональной деятельности». - М.: 

Издательский центр «Академия», 2014 г.. 

2. www.consultant.ru — Консультант - Плюс 

3. www.garant.ru - ГАРАНТ 

 

Практическое занятие № 12 Подбор материала для презентации  

Упражнение: Демонстрация слайд-фильма и присвоение эффектов анимации объектов и переходов 

слайдов.  

В качестве темы первой презентации возьмем электронную иллюстрацию выступления, касающегося 

структуры построения курса лекций по изучению MicrosoftOffice. 

Этот процесс подготовки презентации придется разбить на два этапа: 

1. непосредственная разработка презентации, т. е. оформление каждого слайда;  

2. демонстрация, т. е. процесс показа готовых слайдов, который может сопровождаться 

пояснениями лектора, некоторыми графическими пометками по ходу демонстрации.  

1. Откройте созданный вами ранее файл (PP_Иванов) 

2. Демонстрация: 

Для того чтобы начать демонстрацию, перейдите к первому слайду и воспользуйтесь кнопкой , 

расположенной в левой нижней части экрана или выполните команду Вид-

Демонстрация... (в этом случае нет необходимости переходить к первому 

слайду). 

Первый слайд должен появиться перед вами в режиме просмотра (занимает 

весь экран). 

Переход к следующему слайду в режиме демонстрации осуществляется 

щелчком мыши, нажатием клавиш Enter, Пробел, PageDown, при помощи 

клавиш управления курсором «Вниз» или «Вправо». 

По ходу демонстрации вы можете делать любые устные пояснения, переходя 

к новому слайду через такой промежуток времени, который потребуется. 

Провести демонстрацию наиболее эффективно, вам поможет использование 
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контекстного меню, которое в процессе демонстрации можно вызвать нажатием правой клавиши мыши. 

Как пользоваться командами контекстного меню? 

 Вы хотите, чтобы указатель мыши не был виден во время презентации, но 

собираетесь пользоваться мышью. Выберите команду Указатель - Параметры стрелки - Скрывать 

всегда. Вы сможете перемещать указатель мыши по экрану, щелкать для перехода к новому слайду, 

вызывать контекстное меню, при этом указатель мыши останется невидимкой. Для того чтобы вернуть 

стрелку указателя мыши, вызовите контекстное меню и выберите команду Указатель - Параметры 

стрелки - Автоматически. 
 Вы хотите на какое-то время отвлечь внимание слушателей от экрана и привлечь к себе, чтобы 

сообщить что-то особенно важное. Выполните команду Экран - Черный экран (Белый экран). Щелчок 

мыши выведет на экран следующий слайд. 

 Вы хотите во время демонстрации графически отметить некоторые моменты: обвести какие-то 

записи, провести указующую линию, чтобы акцентировать на чем-либо внимание слушателей. При 

этом вам нужно, чтобы все пометки не сохранялись до следующей демонстрации. Выберите команду Ручка 

указатель мыши изменил форму, теперь им можно рисовать, делать пометки по ходу демонстрации. Цвет 

ручки можно выбрать при помощи команды Указатель - Цвет. Кроме указателя в виде ручки есть еще и 

Фломастер, и Выделение (маркер). 

 По каким-то причинам, вы хотите завершить демонстрацию прежде, чем достигли последнего 

слайда. Выберите командуЗавершить демонстрацию. 

Обратите внимание!!! Обязательно первую демонстрацию проведите только для себя (прорепетируйте), а 

затем уже выходите выступать перед аудиторией. 

Если провести демонстрацию вы хотите не сразу после создания презентации, а через какое-то время 

(например, на следующий день) нет необходимости запускать PowerPoint . Найдите свой файл при помощи 

проводника Windows (или заранее создайте для него ярлык на рабочем столе), выделите и вызовите 

контекстное меню нажатием правой клавиши мыши. В контекстном меню будет присутствовать команда 

Демонстрация (Показ). 

3. Настройка анимации  

4. Откройте презентацию, созданную на прошлом занятии, 

например, PP_Иванов. 

5. Щелкните по слайду № 1 правой кнопкой мыши и в 

контекстном меню выберите опцию Смена слайдов. Исследуйте эту панель в 

правой части окна. Также можно изменить следующие параметры Смены 

слайдов – Скорость перехода, а также возможность Добавить звук. Возможно 

задать Смену слайдов по щелчку, либо автоматически, через выбранный 

интервал времени. 

Обратите внимание!!! Часто сложно рассчитать время, через которое должна 

происходить смена слайдов, так как в ходе демонстрации могут возникать 

различные ситуации, на которые заложить время не представляется 

возможным. Например, вопросы, которые может задать аудитория во время 

показа. Поэтому чаще используют смену слайдов по щелчку. 

3. К вашему сведению! Слайды, оформленные в одном стиле (цвет, 

шрифт, переходы, анимация в одном выдержанные направлении), т.е. 

единого дизайна, легче воспринимаются аудиторией. 

4.  

5. Задайте смену слайдов В форме круга, скорость – Средне, звук – 

Бластер. И щелкните по кнопке Применить ко всем. Если же вам 

необходимо задать смену слайдов различного вида, то нужно щелкнуть 

по кнопкеПрименить, тогда выбранный тип смены слайдов будет 

применен к текущему слайду.  

6. Предварительный просмотр осуществляется при помощи кнопки 

Просмотр. Просмотр всего слайд-фильма производится щелчком по 

кнопке Показ слайдов. 



7. Далее произведем анимацию объектов на слайде. Рассмотрим по шагам процесс анимации слайда. 

8. Слайд № 1. щелкните правой кнопкой мыши по заголовку на слайде и в контекстном меню выберем 

опцию Настройка анимации. В правой части экрана появится панель Настройка анимации. На 

данной панели есть возможность Добавить эффект: Вход, выделение, выход, пути перемещения. 

Вход – это объект, у которого анимационный эффект присутствует в момент его появления на 

слайде. Выход – в момент исчезновения, Выделение – объект изменяет свои параметры (цвет, 

размер, и др.). Пути перемещения - присвоение сложной траектории объекту на слайде. 

9. Выберем эффект Вход – поворот, скорость – средне. Подзаголовок эффект Выделение – Изменение 

цвета текста, скорость – быстро. 

10. Слайд № 3 – слайд № 4 – выполните самостоятельно. Обратите внимание на то, что принастройки 

анимации есть возможность корректировать параметры эффектов, а также изменять порядок 

следования объектов анимации. 

11. Слайд № 2 – Здесь необходимо продумать порядок следования объектов при анимации, если вы 

будете анимировать каждый блок отдельно. Если же вы хотите, чтобы схема появлялась или уходила 

целиком, как единый объект, то необходимо вспомнить навыки работы с рисованными объектами в 

Word. На панели инструментов Рисование выберите кнопку Выбор объектов и обрисуем 

вокруг всей схемы прямоугольник. Обратите внимание!!! Все объекты должны попасть в зону 

выделения. Далее на панели Рисование щелчок по кнопке Действия – Группировать. Теперь схема 

– это один объект, настройте для него анимацию. 

12. Сохраните результат своей работы в папке своей группы (класса) под тем же именем, что и ранее. 

Контрольные вопросы: 

1. Для чего предназначена программа MS PowerPoint?  

2. Как настроить анимацию картинки?  

3. Как настроить переход слайдов?  

4. Как поменять местами слайды?  

5. Как добавить звуковое сопровождение к слайду?  

6. Как настроить анимацию текста 

Практическое занятие № 13 Разработка дизайна презентации. 

Технологическая карта занятия 
 

Тема занятия: «Создание электронных презентаций» 

Курс:  Оборудование: персональные компьютеры по числу учащихся с установленной операционной 

системой Microsoft Windows, программы из пакета MicrosoftOffice: Word и PowerPoint, методические 

указания к выполнению лабораторной работы, дополнительный материал в электронном виде (изображения, 

аудио-файлы на сетевом диске). 

Тип занятия: закрепление знаний и навыков. 

Вид занятия: лабораторная работа. 

Формы работы: индивидуальная работа за компьютером. 

Цель работы: способствовать освоению технологии создания презентаций в среде приложения MS 

PowerPoint; создать условия для: 

 развития памяти, внимания, наблюдательности, мышления; способностей к анализу и синтезу, умения 

выделять главное, сравнивать, обобщать; 

 формирования опыта работы в коллективе; 

 развития личности, открытой для общения и сотрудничества; 

 практического использования полученных профессиональных навыков. 

План занятия: 
1. Оргмомент. 

2. Тестирование по пройденному материалу. 

3. Закрепление пройденного материала. Выполнение учащимися лабораторной работы. 

4. Оценивание результатов защиты учащимися своих работ и техники использования презентационного 

оборудования. 

5. Подведение итогов урока 

6. Задание на дом. 



Ход работы 
I. Организационный момент (2-5 мин.) 

Приветствие 

Проверка готовности к уроку 

Перекличка 

Объявление темы занятия. 

Тема сегодняшнего занятия “Использование презентационного оборудования” 

Объявление цели занятия. 

На этом занятии нам необходимо будет познакомиться с азами работы с проектором и мультимедиа 

в MS Office PowerPoint 

Объявление плана занятия. 

Тестирование по пройденному материалу. Выполнение лабораторной работы. Защита презентаций. 

 

 

II. Тестирование по пройденному материалу (10-15 мин.) 

 

Вопросы теста по теме: «MS Office PowerPoint» 
 

1. ВЫБЕРИТЕ ВЕРНЫЕ ОТВЕТЫ 

Укажите 3 существующих режима работы с презентацией: 

a. Обычный режим 

b. Аварийный режим 

c. Режим сортировщика 

d. Режим просмотра текущего слайда 

 

2. НАЙДИТЕ ОШИБКУ 

К эффектам анимации относят: 

a. вход 

b. выделение 

c. выход 

d. пути перемещения 

e. пути исчезновения 

 

3. НАЙДИТЕ ОШИБКУ 

Общий порядок слайдов презентации: 

a. Титульный 

b. План презентации (содержание) 

c. Основная часть 

d. Заключительная часть 

e. Спасибо за внимание 

f. Контакты 

 

4. ВВЕДИТЕ СЛОВО 

Как называется одна страница презентации? 

 

5. ВЫБЕРИТЕ ВЕРНЫЙ ОТВЕТ 

В рабочем окне программы PowerPoint нет элемента: 

a. Область задач 

b. Область рабочего слайда 

c. Строка заголовка 

d. Строка меню 

e. Строка панель 

 

6. ВЫБЕРИТЕ ВЕРНЫЙ ОТВЕТ 

Укажите порядок действий при сохранении презентации в своей папке. 

1. Нажать Сохранить Как 

2. Нажать Файл 

3. Выбрать место и имя сохраняемой презентации 

4. Нажать сохранить 



a. 2-1-3-4 

b. 2-3-1-4 

c. 2-4-1-3 

d. 4-1-3-2 

 

7. ВЫБЕРИТЕ ВЕРНЫЕ ОТВЕТЫ 

Презентации бывают: 

a. линейные 

b. интерактивные 

c. циркулярные 

d. нет верного ответа 

 

8. ВЫБЕРИТЕ ВЕРНЫЕ ОТВЕТЫ 

Общие требования к оформлению презентации: 

a. Дата на всех слайдах 

b. Крупный шрифт 

c. Наличие заголовков у слайдов 

d. Использовать только стандартное оформление и клипарт 

e. Содержимое слайдов должно быть лаконичным, тезисным 

 

9. ВЫБЕРИТЕ ВЕРНЫЙ ОТВЕТ 

Что такое презентация PowerPoint? 

a. демонстрационный набор слайдов, подготовленных на компьютере 

b. прикладная программа для обработки электронных таблиц 

c. текстовой документ, содержащий набор рисунков, фотографий, диаграмм 

d. устройство компьютера, управляющее демонстрацией слайдов 

 

10. ВЫБЕРИТЕ ВЕРНЫЙ ОТВЕТ 

Что такое PowerPoint? 

a. прикладная программа для обработки таблиц 

b. системная программа, управляющая ресурсами компьютера 

c. прикладная программа, предназначенная для создания презентаций 

d. прикладная программа, предназначенная для создания публикаций 

ОТВЕТЫ: 1–a,c,d; 2–e; 3–f; 4–слайд; 5–e; 6–a; 7–a,b; 8–b,c,e; 9–a;10–c. 

 

Этапы подготовки презентации: 

1. проектирование презентации; 

2. сбор подробной информации по теме, т.е. изучение литературы и беседы со специалистами; 

3. сбор сведений об аудитории, которой будет представлена презентация; 

4. изучение возможностей и ограничений презентационного программного обеспечения, с которым предстоит 

работать. 

 

Требования к оформлению презентации: 

1. Первый слайд – название; 

2. Общий стиль (исключение - первый слайд); 

3. Анимированная смена слайдов в общем стиле; 

4. Наличие заголовков у слайдов; 

5. Лаконичность (минимум текста). Каждый слайд должен быть заполнен текстом не более чем на треть; 

6. На слайдах должны присутствовать объекты: аудио (видео-) фрагменты, анимированные изображения (в 

том числе двигающиеся по заданной траектории) 

7. Постоянный шрифт; 

8. Крупный шрифт; 

9. Тёмный текст на светлом фоне или наоборот; 

10. Не использовать стандартный клипарт; 

11. Наличие четкой структуры и навигации, созданной при помощи кнопок и гиперссылок. 

12. Непрерывный музыкальный фон. 

 

III. Закрепление пройденного материала (10-12 мин). Ответы на контрольные вопросы 

 



 

Практическое занятие № 14,15 Настройка управлением презентацией.  Подготовка к публичным 

выступлениям 

Цель: познакомиться с основными устройствами, входящими в состав презентационного оборудования, 

закрепить навыки работы в приложенииMS Power Point, на примере создания и демонстрации презентации 

на заданную тему 

Оборудование: персональный компьютер, мультимедиа проектор, звуковые колонки 

Программное обеспечение: Microsoft Office Word 2013, Microsoft Office PowerPoint 2013. 

 

Теоретические сведения к практическому занятию 
Презентация представляет собой сочетание компьютерной анимации, графики, видео, музыки и звукового 

ряда, которые организованы в единую структуру, организованную для удобного восприятия информации. 

Презентация — это рекламный, имиджевый и  информационный инструмент, позволяющий пользователю 

активно воздействовать на аудиторию. 

Отличительной особенностью презентации является ее интерактивность, то есть возможность 

взаимодействия с изображением. Современное презентационное оборудование включает: 

Интерактивная доска - это сенсорный интерактивный экран, который подключается к 

компьютеру. Картинку с компьютера на интерактивнуюдоску передает мультимедийный проектор 

(видеопроектор), подключенный к этому компьютеру 

Плазменные видеостены - крупноформатное высококачественное 

презентационное оборудование. Благодаря модульной конструкции, небольшой 

глубине, с помощью плазменных модулей возможно создавать видео – экраны 

разных размеров с малой толщиной. Эти достоинства обуславливают 

предназначение плазменных видеостен - информационные дисплеи, системы 

наблюдения и контроля 

(ситуационные залы), 

оформление телестудий, выставок, концертов 

и шоу, демонстрации видео в спорт - барах, клубах, 

казино. 

  Проекционный экран – 

этоконструкция со специальной структурой, 

предназначенная для показа проецируемого 

изображения. При использовании специальных проекторов, экраны могут быть 

молированными (гнутыми), но в большинстве случаев они плоские. 

Обычно проекционные экраны - однородно белые, серые или черные (для предотвращения искажения 

цветов изображения). 

Видеопроектор - Видеопроектор, или бимер – это устройство для проецирования увеличенного 

изображения на большой экран или другую плоскую поверхность. Наиболее распространенными типами 

видеопроекторов на настоящий момент являются ЖК-проектор, DLP-проектор и светодиодный проектор 

(LED-проектор). Качество проектора, в первую очередь, определяется 

яркостью лампы и уровнем контрастности. 

Основные характеристики 
 разрешающая способность (разрешение), 

 световой поток (яркость), 

 вес. 

Дополнительными характеристиками мультимедийного проектора 

являются: 

 контрастность, 

 равномерность освещения, 

 наличие ZOOM-объектива, 

 количество и типы входных и выходных разъёмов. 

Разрешающая способность - данный параметр характеризует удобность видео картинки, создаваемой 

проектором, и определяется числом светящихся элементов - пикселей ЖКД или микрозеркал. 

Контрастность - это отношение максимальной освещенности контрольного экрана к минимальной при 

проецировании белого и черного поля соответственно. 

Равномерность освещения - показывает отношение минимальной освещенности (на периферии 

изображения) к максимальной (в его центре); в хороших проекторах этот показатель превышает 70%. 

Функциональные возможности 



Современные мультимедийные проекторы имеют, как правило, стандартный набор функциональных 

возможностей, среди которых: 

 наличие экранного меню и пульта дистанционного ИК управления (иногда такой пульт может превращаться 

в кабельный), 

 инверсия изображения по горизонтали и по вертикали, что позволяет использовать просветные экраны и 

потолочное крепление проектора, 

 возможность регулировки яркости, контрастности, чёткость изображения, 

 возможность настройки цветовой гаммы, 

 возможность подстройки под параметры входных компьютерных и видео сигналов, 

 возможность дистанционного управления курсором компьютера (так наз. инфракрасная экранная мышь) 

 возможность механической корректировки трапециидальных искажений изображения (выдвижные ножки 

или смещаемый объектив), 

 возможность выбора языка меню (к сожалению, русский, как правило, отсутствует). 

Кроме того, некоторые проекторы имеют дополнительные функциональные возможности: 

 стоп-кадр - возможность "заморозить" изображение, 

 "электронная лупа" - возможность сильного (до 30 раз) увеличения выделенного участка изображения, 

поступающего из компьютера, 

 функция "картинка в картинке" - возможность одновременного показа изображений, поступающих от двух 

независимых источников, 

 возможность электронной корректировки трапециидальных искажений изображения в вертикальной, а в 

последнее время - и в горизонтальной плоскости, 

 функция A/V MUTE - затемнение экрана и исключение звука, 

 функция «занавес» - открытие или закрытие части изображения, 

 встроенный слот для PC-карты, что даёт возможность проводить презентации без компьютера, 

 встроенный слот для опционной платы, обеспечивающей беспроводный приём управляющих и 

компьютерных сигналов, 

 лазерная указка, встроенная в пульт дистанционного управления, 

 функция IRIS - автоматическая подстройка яркости изображения в зависимости от освещённости 

помещения, 

 наличие экономичного режима работы (уменьшение светового потока на 15-20%, обеспечивающее 

увеличение срока службы лампы в 1,5-2 раза), 

 автоматическое управление режимом работы вентилятора в зависимости от температуры окружающей 

среды, 

 поддержка цифровых телевизионных стандартов DVT и HDTV (телевидение высокой чёткости), 

 возможность выбора формата изображения (4:3 или 16:9), 

 запоминание установок проектора для большого количества источников сигнала, 

 возможность замены объектива и наличие сменных длиннофокусных и короткофокусных объективов, 

 возможность механического смещения объектива, что особенно важно при сведении изображений от 

нескольких проекторов, 

 наличие сетевого концентратора, обеспечивающего возможность включения проектора в локальную сеть, 

 встроенная программная защита от краж и несанкционированного использования, 

 специальную функцию для работы с интерактивными досками, 

 автоподсветка клавиш на панели управления, 

 возможность установки собственной заставки на экране. 

 

Пульт дистанционного управления 
 

1.Инфракрасный датчик ПДУ. 

2.Кнопка включенья. 

3.Кнопка выключения. 

4.Электронная лупа 

5.Затемнения экрана и исключения звука 

6-7.Отображения меню и выбора его 

8-9.Задает выбранный режим 

10. Выход 

11-13. Переключение на видео 

14.Вход сигнала S-видео от видеоаппаратуры 

15. Смена компьютера-1 на компьютер-2. 

16.Авторежим. 



17. Регулировка звука. 

18. Режим работы лампы. 

19. Выбор формата изображения 

20. Установка изображения. 

21.Помошь 

22.Остановка изображения (заморозка) 

Разъемы и гнезда. 

 

 
1. COMPUTER IN/Component Input Connector (Mini D-Sub 15 pin) 

2. MONITOR OUT Connector (Mini D-Sub 15 Pin) 

3. PC CONTROL Port (DIN 8 Pin) 

4. S-VIDEO IN Connector (Mini DIN 4 Pin) 

5. VIDEO IN Connector (RCA) 

6. AUDIO Input Jacks L/R (RCA) 

Пример подключения проектора. 

 
 

 
 

 

Меры предосторожности перед началом эксплуатации 
Во избежание поражения электрическим током и возникновения пожара запрещается подвергать данное 

изделие воздействию влаги, в корпусе изделия присутствуют компоненты, находящиеся под высоким 

напряжением. Запрещается вскрывать корпус! 



 

Указания по технике безопасности 

1. Прочтите руководство пользователя 
После извлечения изделия из упаковочной тары внимательно прочтите руководство пользователя. 

Соблюдайте инструкции по эксплуатации и другие инструкции. 

2. Источники питания 
Данное устройство разрешается подключать только к такому типу источника питания, напряжение которого 

не превышает допустимого диапазона, указанного на маркировочной табличке и шнуре питания. 

3. Источник света 
Запрещается смотреть в объектив во время работы лампы. Яркий свет, излучаемый лампой может повредить 

органы зрения. 

4. Вентиляция 
Отверстия в корпусе устройства предназначены для вентиляции устройства и обеспечивают надежную его 

работу и защиту от перегрева. 

Запрещается закрывать эти отверстия. Запрещается закрывать эти отверстия, помещая изделие на кровать, 

диван, подстилку или аналогичную поверхность. 

Данное изделие запрещается размещать в закрытом пространстве, например, книжном шкафу или на 

встроенной полке, если не обеспечена достаточная вентиляция. 

5. Источники тепла 
Данное изделие следует располагать вдали от источников тепла, например, радиаторов, отопительных 

батарей, нагревательных плит и других устройств, излучающих тепло (в том числе усилителей). 

6. Влага 
Запрещается эксплуатировать данное изделие вблизи источников воды и влаги. 

7. Очистка 
Прежде чем приступить к очистке изделия, отсоедините его от розетки сети питания. Запрещается 

применять жидкие и аэрозольные моющие средства. Для очистки следует применять мягкую ткань. 

8. Защита кабеля питания 
Кабели питания следует прокладывать в местах, где на них невозможно будет наступить или передавить 

тяжелыми предметами. Особенное внимание нужно уделить вилкам, розеткам и местам соединения кабеля 

питания с устройством. 

9. Перегрузка 
Запрещается подключать чрезмерную нагрузку к розеткам сети питания; в целях снижения риска поражения 

электрическим током запрещается использовать полярную вилку с удлинительными шнурами, 

штепсельными или другими розетками, за исключением тех, которые оснащенны заземлением и в которые 

контакты вилки могут быть вставлены полностью, не допуская их обнажения. В противном случае 

существует опасность поражения электрическим током и возникновения пожара. 

10.Запрещается устанавливать устройство в вертикальное положение 

Запрещается эксплуатировать изделие в вертикальном положении, проецируя изображение на потолок, 

что может привести к падению устройства. 
 

Работа с проектором 

1. Подключение проектора к компьютеру 
1.  

1. Подключите шнур питания. 

Вставьте шнур питания в розетку AC IN на проекторе. 

 
1. Снимите крышку объектива. 

2. Подсоедините VGA signal cable к системному блоку компьютера (видеокарта) и к проектору в 

гнездо COMPUTER IN. Монитор подключаем к проектору в гнездоMONITOR OUT 

3. Включение питания. 



Нажмите кнопку ON/STANDBY. Питание включится, и следующие 3 индикатора загорятся зеленым цветом: 

ON, LAMP и FAN. Через короткий промежуток времени появится начальный экран. 

 

Примечания 
• Начальный экран через некоторое время исчезнет. Вы можете убрать начальный экран раньше, начав 

выполнение какой-либо операции. Вы также можете настроить конфигурацию через меню Установка 

дисплея так, чтобы начальный экран не показывался. 

• При первом после покупки включении проектора, после того, как будет убран начальный экран, 

отобразится меню Язык. 

 

Выключение питания 

1Нажмите кнопку ON/STANDBY 
На экране появится сообщение, подтверждающее ваше намерение выключить питание. Это сообщение через 

некоторое время исчезнет. (После того, как сообщение исчезнет, эта операция больше не действует.) 

2Еще раз нажмите кнопку ON/STANDBY 
Экран выключится, но внутренний охлаждающий вентилятор будет продолжать работать в течение еще 

некоторого времени. После этого проектор перейдет в режим ожидания. 

Во время охлаждения индикатор LAMP мигает. В этом состоянии повторно включить питание нельзя. 

После того, как индикатор LAMP погаснет, охлаждающий вентилятор продолжает работать в течение 

некоторого времени, чтобы удалить излишнее внутреннее тепло. Если вы торопитесь, в этом состоянии 

можно просто отключить шнур питания. 

 

Ход работы 
 

Задание №1 Ознакомится с мультимедийным проектором, изучить его основные характеристики и 

функциональные возможности (см раздел теоретических сведений). 

 

Задание №2 Создание презентации на заданную тему 
Указание к выполнению задания №1 

Используя, приложение MS Power Point создайте не менее 10 слайдов на тему, выбранную заранее, или 

тему: «Презентационное оборудование», презентация должна обязательно содержать, теоретический 

материал, фотографии, заданный набор гиперссылок, к каждому слайду необходимо применить 

анимационные эффекты, презентация должна быть оформлена диаграммой и таблицей. Весь теоретический 

материал и фотографии, необходимо найти в сети Интернет, с помощью любой удобной поисковой системы. 

 

Структура презентации по заданной теме: 
 

1 слайд 
Название презентации, картинки по теме, применение анимации 

2 слайд 
Содержание презентации: перечень оборудования, с созданными ссылками на каждое устройство 

3 слайд 
Рассказ об одном из устройств презентационного оборудования 

4 слайд 
……………………………….. 

5 слайд 

6 слайд 

7 слайд 

8 слайд 

9 слайд 
Создать таблицу отражающую стоимость презентационного оборудования 

За период 2014-2015 года, данные найти в сети Интернет 

10слайд 
Построить диаграмму показывающую зависимость объёма продаж презентационного оборудования от 

квартала 2011 года 

Задание №3 Ответить на контрольные вопросы 
1. Что такое презентационное оборудование? 

2. Перечислите основные устройства входящие в состав презентационного оборудования? 

3. Укажите области их применения 



4. Перечислите в каких форматах существуют проекционные экраны? 

5. Перечислите типы проекторов, а также укажите преимущества и недостатки каждого из типов 

проекторов. 

Задание №5 Проверьте настройки презентационного оборудования и готовность презентации к 

защите. 
Продемонстрируйте приготовленный вами учебно-демонстрационный материал по просьбе преподавателя. 

Задание №4 Сделайте вывод о проделанной работе и сдайте его преподавателю. 
IV. Защита работ учащимися (выступление у доски с демонстрацией презентации по заданной теме с 

использованием проктора). Оценивание результатов работы учащихся. Объявление отметок (40-50 мин.) 

V. Подведение итогов урока (3-5 мин.) 

Рефлексия. Обобщение изученного: 

− С чем мы познакомились на данном уроке? 

− Было ли вам интересно? 

− Как вы думаете, пригодятся ли полученные сегодня навыки в дальнейшем? 

VI. Задание на дом (1-2 мин.): происхождение понятия «телекоммуникация». 

 

Приложение А 

Требования к оформлению презентации: 
13. Первый слайд – название; 

14. Общий стиль (исключение - первый слайд); 

15. Анимированная смена слайдов в общем стиле; 

16. Наличие заголовков у слайдов; 

17. Лаконичность (минимум текста); каждый слайд должен быть заполнен текстом не более чем на треть; 

18. На слайдах должны присутствовать объекты: аудио- (видео-) фрагменты, анимированные изображения (в 

том числе двигающиеся по заданной траектории); 

19. Постоянный шрифт; 

20. Крупный шрифт; 

21. Тёмный текст на светлом фоне или наоборот (не располагать текст поверх изображений); 

22. Не использовать стандартный клипарт; 

23. Наличие четкой структуры и навигации, созданной при помощи кнопок и гиперссылок; 

24. Непрерывный музыкальный фон. 

 

 
 

 

 

 

 

Практическое занятие № 16 Приемы создания изображений в AdobePhotoshop. 
 

Цель: Научиться работать с графическим редактором. 

Задача: Сформировать профессиональные компетенции.  

адачакомпьютерной графики — визуализация, то есть создание изображения. Визуализация выполняется 

исходя из описания (модели) того, что нужно отображать. Существует много методов и алгоритмов 

визуализации, которые различаются между собою в зависимости от того, что и как отображать. Например, 

отображение того, что может быть только в воображении человека — график функций, диаграмма, схема, 

карта. Или наоборот, имитация трехмерной реальности — изображения сцен в компьютерных развлечениях, 

художественных фильмах, тренажерах, в системах архитектурного проектирования. 



Для начала рассмотрим вопрос представления и обработки графической информации в компьютере. Здесь 

важно обратить на то, что видеоинформация воспринимается человеком значительно легче символьной 

информации. Поэтому очень желательно уметь представлять видеоинформацию в компьютере. 

Процесс преобразования видеоинформации представлен на схеме . 

 

 

Основные преимущества векторного принципа формирования изображений перед растровым 

состоят в следующем: 

• файлы векторных изображений имеют гораздо меньший размер, чем растровых; 

• печать векторных изображений осуществляется быстрее; 

• масштабирование и трансформация векторных изображений не сопряжены с ограничениями и 

потерей качества изображения. Наиболее популярными графическими программами, 

предназначенными для обработки векторных изображений, являются 

AdobeIllustratorиCorelDraw, КОМПАС 3D. 

Растровое изображение состоит из точек (пикселей). Параметры каждой точки (координаты, 

интенсивность, цвет) описываются в файле. Отсюда такие огромные размеры файлов, содержащих 

растровые изображения, особенно если последние характеризуются высокой разрешающей 

способностью. Растровые изображения — это блок данных, содержащий информацию о цвете 

каждого пикселя на экране. Т. к. изображение напрямую связано с графическими режимами, в 

которых они отображаются, то они, как и последние, делятся по количеству бит на пиксель. Все 

изображения делятся на черно-белые и цветные. 

Алгоритм создания нового документа 
1. Выполните запуск программы Пуск/Программы/AdobePhotoshop7.0 (рис. 1.3). 

2. Из меню File(Файл) вызовите команду New(Новый) или воспользуйтесь горячими клавишами 

<Ctrl>+<N>. 

3. Появляется диалоговое окно New(Новый документ), в котором устанавливаются параметры документа. 

4. Установки в окне Newпроизводятся в полях Name(Имя), ImageSize(Размер изображения), 

Contents(Содержимое). 

Введите значения в поле ImageSize: 

• Width (Ширина изображения) — 12 см; 

• Height (Высота изображения) — 12 см; 

• Resolution(Разрешение) — 72 пиксела на дюйм. Разрешение монитора компьютера обычно 72 (96) пике/дюйм, 

следовательно, вы устанавливаете разрешение документа равным разрешению монитора. Чем больше размеры 

изображения и разрешение, тем больше размер файла, а большие размеры файла замедляют работу; 

• Mode(Цветовая модель) — RGB. Это стандартный режим видеомониторов для отображения цветов. 

5. Переключателем поля Contents(Содержимое) установите фон 

нового документа — белый. Возможные варианты: 

• White (Белый); 

• BackgroundColor(Фоновый цвет). В этом случае задается тот цвет фона, который был установлен в программе перед 

выполнением этой операции; 

• Transparent (Прозрачный). 

6. Введите в поле Name(Имя) произвольное имя и нажмите 

ОК. На экране появится окно нового документа. 

Сохранение нового изображения 

1. Выберите команду File, вызовите команду Save(Файл/Сохранить) или воспользуйтесь комбинацией клавиш 

Ctrl+S. 
2. В поле Filename(Имя файла) введите имя файла. 

3. Выберите  месторасположение  файла  (например,   рабочий 

стол). Для того чтобы указать другую папку 

 

Изменение изображения с помощью кисти. 

Цель занятия: познакомиться с инструментами рисования. При выполнении вы узнаете, как в программе 

Photoshop воспользоваться инструментами Brush (Кисть), Pencil (Карандаш), Pain 

Для того чтобы были показаны файлы всех форматов, следует из выпадающего меню Filesoftype (Типы 

файлов) выбрать вариант AllFormats(Все форматы). 

1. Выберите в сети МАС5 ФОТОШОП папку Занятия_ Photoshop/Занятие №1/Стадион.jpeg 

2. Выполните команду Изображение/Дублировать. В окне диалога Копировать Изображение введите имя 

Стадион_1. 



3. Щелкните по пиктограмме инструмента Brush 

(Кисть) (клавиша В). 

• Выберите основной цвет кисти используя инструмент Пипетка. Если щелкнуть на 

пиктограмме ,основный цвет отобразится на пиктограмме основного цвета. Получившийся цвет 

можно изменить, щелкнув 2 раза Л К мыши на пиктограмме и выбрав необходимый оттенок. 

• Eraser (Ластик); 

• Smudge (Палец); 

• Gradient (Градиент). 

Рисунки,    необходимые   для    работы:    Стадион-jpeg 

Задание: используя вышеперечисленные инструменты редактора, раскрасить картинку. 
1. Запустить Photoshop(Пуск/Программы/AdobePhotoshop ). 

2. Выберите команду меню File/Open(Файл/Открыть), 

File/Browse(Файл/Просмотр) или воспользуйтесь комбинацией 

клавиш Ctrl+O. 

8. Выберите на панели инструментов Pencil (Карандаш), ширину кончика кисти в пикселах, установите 5 

рх, нарисуйте облака, установив основной цвет синим  

9. С помощью инструмента PaintBucket (Ведро с краской), сделав его активным на панели инструментов 

(рис. 1.16), залейте облака белым цветом. Предварительно установите цвет с помощью кнопки основного 

цвета фона или нажмите на стрелке изменения основного и фонового цвета. 

10 С помощью инструмента Smudge (Палец), сделав его активным на панели инструментов, сделайте 

границы облаков смазанными по траектории. Инструмент Smudge (Палец) служит для смазывания границ 

изображения по траектории . 

11. С помощью инструмента EllipticalMarquee (Овальная область), сделав его активным на панели 

инструментов (или нажав сочетание клавиш Shift+M,  выполним изображение луны .Чтобы получить 

окружность необходимо нажать клавишу Shift. 

6. На панели опций щелкните по стрелке в поле Brush (Кисть), чтобы выбрать тип кисти (рис. 1.13). Число 

под каждой пиктограммой определяет ширину кончика кисти в пикселах, установите 35 рх. Щелкните 

мышью где-либо вне панели выбора кистей, чтобы закрыть ее. 

 
7. Переведите кисть на Изображение и начните при нажатой левой клавиши мыши проводить кистью, как 

показано на (рис. Сделайте небо над стадионом голубым. 

 

После того как вы отпустите левую клавишу, выделенная область будет заполнена градиентной заливкой ( 

13. Из меню File (Файл) вызовите команду SaveAs (Сохранить как), выберите формат файла * .JPG. 

14. Имя файла — Стадион. 

15. Щелкните по кнопке Save (Сохранить). 

1.6. Задание по теме 

Используя предложенные на диске в папке Urok_l_Ph файлы Гopoд.jpeg и Карфаген-jpeg, выполните 

изображение с помощью изученных инструментов, показав закат или рассвет. 

Пример выполнения задания . 

 
12. Выберите на панели инструментов инструмент Gradient (Градиент) и установите радиальное 

направление. При нажатой левой клавише мышки провести через выделенную область (как бы  

перечеркнуть  выделенную  область  в  направлении  заливки). 



Практическое занятие № 19,20 Работа с инструментами рисования, кисти, параметры 

кисти. Сплошная заливка 

1. Откройте приложение Adobe Photoshop 

2. Загрузите файл http://www.modern-computer.ru/media/source_pictures/fruits.zip, распакуйте из 

архива файл fruits.tif и откройте его в Adobe Photoshop 

 

3. Поверх слоя с изображением создайте новый слой 
командой Слой ► Новый ► Слой... (<Ctrl>+<Shift>+<N>) (можно воспользоваться 

кнопкой Создать новый слой , расположенной на палитре Слои). 

 
Палитра Слои 

4. На палитре Слои в выпадающем списке Установить режим смешивания установите 
режим Цвет 

5. Выберите инструмент Кисть  с твёрдыми краями. 

 
Настройки Кисти 

6. Выбирая необходимые цвета инструментом Цвета переднего плана и фона, начните 
раскрашивать изображение. 

 
Инструмент Цвета переднего плана и фона 

7. Объедините слои командой Слой ► Выполнить сведение. 

Готовое изображение сохраните в своей папке. 

 

Практическое занятие № 21 Градиентная заливка. Редактирование и применение градиента. 

 

Градиентная заливка 

1. Откройте приложение Adobe Photoshop 

2. Загрузите файл http://www.modern-computer.ru/media/source_pictures/men.zip, распакуйте из 

архива файл men.jpg и откройте его в Adobe Photoshop 

 

3. Перейдите к рисунку с изображением человека. Постарайтесь улучшить качество изображения, 
воспользовавшись 

http://www.modern-computer.ru/media/source_pictures/fruits.zip
http://www.modern-computer.ru/media/source_pictures/men.zip


командой Изображение ► Регулировки ► Авто Уровни (<Ctrl>+<Shift>+<L>) и 

окном Кривые Изображение ► Регулировки ► Кривые (<Ctrl>+<M>) 

 

4. Выделите с помощью инструмента Волшебная палочка  задний фон изображения. 

 

5. Теперь необходимо несколько расширить выделение, чтобы исключить случайные области. Для 
этого выполните команду Выделение ► Модифицировать ► Расширить. 

В открывшемся окне Выбор расширения установить <Расширить на 2 пикселя> 

 
Окно Выбор расширения 

6. Не отменяя выделения, выберите инструмент Градиент . 

7. Инструментом Цвета переднего плана и фона установите цвета переднего плана и 
фона, выбрав в окне Сборщик цветов следующие составляющие: 

для переднего плана: 
 

для фона: 

  
Окно Сборщик цветов 

R: 14 
 

R: 94 

G: 218 
 

G: 43 

B: 211 
 

B: 162 

8. На панели инструмента Градиент выберите тип градиента Foreground to Background (от цвета 
переднего плана к фону). 

 
Панель инструмента Градиент 

9. Поэкспериментируйте с различными направлениями и типами 
(Линейный, Радиальный, Угловой, Отражённый, Ромбовидный) и видами переходов 
градиента. 

 

10. Готовое изображение сохраните в своей папке. 



Готовые изображения 

  

 

  

 

 

 

 

 



Практическое занятие № 22 Работа со слоями. 

Использование слоев в Adobe PhotoShop 

Цель: 

1. Научиться работать со слоями: создавать; просматривать; выбирать; перемещать слои; 
настраивать слои. 

2. Ознакомиться с инструментарием и научиться осуществлять операции добавления 
текста в композицию, создание градиентного слоя. 

3. Научиться создавать композицию с использованием слоев. 

4. Научиться реализовывать простейшие приемы работы с текстом. 

Работа со слоями осуществляется через Палитру Слои (Layers): 

 

ЗАДАНИЕ 1 

1. Скопируйте в папку Works файлы: ИТОГ.psd, слой. psd, слой1.psd. Запустите программу 
PhotoShop. 

2. Откройте файлы ИТОГ.psd, слой. psd, слой1.psd 

ЗАДАНИЕ 2. 

1. Рабочий файл Слой1.psd 

2. Включите невидимые слои. 

3. Изображение из файла Слой.psd перетащите в файл Слой1.psd 

4. Поверните изображение (Редактирование/трансформация) 

5. Настройте прозрачность данного объекта: 

степень непрозрачности – 45% (2), а способ - Экран (1). 

6. Создайте новый слой, назвав его Градиент. Он будет содержать цветовые эффекты. 
(Слой/Новый/слой) 

7. На Панели инструментов выберите инструмент Линейный градиент. Задайте цвет в 
палитре Каталог (Foreground to Transparent). В палитре Опции сделайте установки: 
непрозрачность - 60%, градиент - Линейное горение. Создайте содержимое слоя, растянув 
градиент справа налево. 

8. Создайте текст, используя одноименный инструмент Т на Панели инструментов. 
Настройте Искажение. Цвет. 

9. Сравните с результатом в файле 
ИТОГ.psd 

 

 

 

 

 



 

 

ЗАДАНИЕ 3 

Самостоятельно создайте открытку «Новогоднее восьмое марта». Для ее создания 
используйте файлы-заготовки (Новый год.jpg, 8 марта.jpg) 

 

 

 

 

 

 

 

 

Практическое занятие № 23 Работа с применением эффектов. 

Эффекты имитации 

Имитация изображения, погружённого в воду 

1. Откройте приложение Adobe Photoshop 

2. Откройте любое исходное изображение, например flower2.tif 

 

 

3. Создайте новый слой, на котором будет создаваться вода. 

4. Определив, какая часть изображения должна быть погружена в воду 
(примерно 1/4 изображения), выделите её при помощи Прямоугольного выделения. 

 

 

5. Установите цвет переднего плана – синий __, а цвет фона – белый __. 

 

 

http://www.modern-computer.ru/media/source_pictures/flower2.zip


6. Примените к выделенной области Облака: Фильтр ► Render ► Clouds. 

 

 

7. Установить прозрачность этого слоя = 60% 

 

 

8. Инструментом Ластик  измените поверхность воды для повышения реалистичности 
изображения. 

 

 

9. Перейдите на слой с основным изображением. 

10. Выделите при помощи Лассо изображение части цветка, погружённой в воду. 

11. Скопируйте выделенную область в буфер обмена. 

12. Вставьте из буфера обмена скопированное изображение. 

13. Обратите внимание, что новый слой должен быть между слоем с водой и основным 
изображением. 

14. Примените к новому слою фильтр ZigZag Фильтр ► Distort ► ZigZag 

Amount: подберите на глаз 

Ridges: 5 

Style:  

15.  

16.  
17. Подкорректируйте, если необходимо, изображение инструментами Ластик и Штамп. 

18. Склейте слои. Готовое изображения сохраните в своей папке. 

 

 

 

 

 



Практическое занятие № 24 Работа с применением фильтров. 

Фильтры, встроенные в программу AdobePhotoshop, позволяют применять к изображению различные 

специальные эффекты. С их помощью можно создавать мозаичные эффекты, случайным образом перераспределять 

цветовые значения пикселов (добавлять или уменьшать шум), имитировать присутствие различных источников 

света, произвольно деформировать изображения, а также получать многие другие интересные визуальные 

эффекты. 

Например, фильтры Blur (Размытие)илиSharpen (Резкость) можно использовать для 

едва заметного ретуширования изображения;  

фильтры ColorHalftone (Цветной растр), FindEdges (Выделение краев), Emboss (Рельеф) или Wind (Ветер) — 

для более ярких эффектов; Artistic (Художественный), BrushStrokes (Мазки кисти), Sketch (Эскиз) или 

Texture(Текстура) — для создания изображения, «нарисованного» вручную; LightingEffects (Эффекты освещения) 

— для того, чтобы осветить изображение. 

Все фильтры сгруппированы по 13 категориям, перечисленные в меню Filter (Фильтр)  

1. Художественные фильтры (Artistic) 

Фильтр ColoredPencil 
Фильтр ColoredPencil (Цветные карандаши) имеет параметры:PencilWidth (Ширина карандаша); 

• Stroke Pressure (Нажим штриха); 

• Paper Brightness (Яркость бумаги). 

фильтр Cutout 
фильтр Cutout (Аппликация) имеет параметры: 

• No. Of Levels (Числоуровней); 

• Edge Simplicity (Упрощение краев); 

• Edge Fidelity (Четкость краев). 

фильтр Dry Brush 
фильтр DryBrush (Сухая кисть) имеет параметры: 

• Brush Size (Размер кисти); 

• Brush Detail (Детализация кисти); 

• Texture (Текстура). 

фильтр Film Grain 
Фильтр FilmGrain (Зернистость фотопленки) имеет параметры: 

• Grain (Размер зерна); 

• Highlight Area (Область светов); 

• Intensity (Интенсивность). 

Фильтр Fresco 
Фильтр Fresco (Фреска) имеет параметры: 

• Brush Size (Размер кисти); 

• Brush Detail (Детализация кисти); 

• Texture (Текстура). 

Фильтр Neon Glow 
Фильтр NeonGlow (Неоновое свечение) имеет параметры: 

• Glow Size (Размер свечения); 

• Glow Brightness (Яркость свечения); 

• Glow Color (Цвет свечения). 

Фильтр Paint Daubs 
Фильтр PaintDaubs (Размазывание кистью) имеет параметры: 

• Brush Size (Размер мазка); 

• Sharpness (Резкость); 

• BrushType (Типы кисти) — на выбор предлагаются кисти Simple (Обычная), LightRough (Светлая 

грубая), DarkRough(Темная грубая), WideSharp (Широкая резкая), WideBlurry (Широкая размытая), 

Sparkle (Искры)- 

Фильтр PaletteKnife 
Фильтр PaletteKnife (Мастихин) имеет параметры: StrokeSize (Размер мазка) 

StrokeDetail (Детализация мазка); Softness (Сглаживание). 

Фильтр PlasticWrap 

Фильтр PlasticWrap (Пластиковый пакет) имеет параметры: 

• Highlight Strength (Подсветка); 

• Detail (Детализация); 

• Smoothness (Смягчение). 

Фильтр Poster Edges 



Фильтр PosterEdges (Очерченные края) имеет параметры: 

• Edge Thickness (Толщина краев); 

• Edge Intensity (Интенсивность краев); 

• Posterization(Постеризация). 

Фильтр Rough Pastels 

Фильтр RoughPastels (Пастель) имеет параметры: 

• Stroke Length (длина штриха); 

• Stroke Detail (детализация); 

• Texture (текстура) Canvas; 

• Scaling (масштаб); 

• Relief (рельеф); 

• Light (направление освещенности); 

• Invert (установки инверсии). 

Фильтр Smudge Stick 

Фильтр SmudgeStick (Растушевка) имеет параметры: 

• Stroke Length (Длина штриха); 

• Highlight Area (Область света); 

• Intensity (Интенсивность). 

Фильтр Sponge 

Фильтр Sponge (Губка) имеет параметры, задающие имитацию обработки изображения губкой 

• Brush size (размер губки); 

• Definition (управление резкостью); 

• Smoothness (гладкость, плавность). 

Фильтр Underpainting 

Фильтр Underpainting (Подмалевок) имитирует подмалевок ДЛЯ! живописи и имеет параметры, сходные с 

параметрами фильтра RoughPastels (Пастель). 

Фильтр Watercolor 

Фильтр Watercolor (Акварель) имеет параметры: 

• Brush Detail (Деталь кисти); 

• ShadowIntensity (Интенсивность тени);Texture (Текстура). 

2. Фильтры размытия (Blur) 

фильтры Blur и BlurMore 
Фильтры Blur (Размытие) и BlurMore (Добавочное размытие) смягчают переходы. 

фильтр GaussianBlur 
Фильтр GaussianBlur (Размытие по Гауссу) имеет только один параметр Radius (Радиус). 

фильтр MotionBlur 
Фильтр MotionBlur (Размытие в движении) выполняет размытие в определенном направлении. 

Фильтр RadialBlur 
Фильтр RadialBlur (Радиальное размытие) размывает изображение и имеет параметры 

• Zoom (увеличение); 

• Spun (вращение). 

Фильтр Smart Blur 
Фильтр SmartBlur (Умное размытие) размывает изображение с конкретными установками. 

3. Фильтры, имитирующие штрихи кисти (Brushstrokes) 

Фильтр AccentedEdges 
Фильтр AccentedEdges (Акцент на краях) имеет параметры: 

• Edge Width (Ширина краев); 

• Ldge Brightness (Яркость краев); 

• Smoothness (Смягчение). 

Фильтр Angled Strokes 
Фильтр AngledStrokes (Угловые штрихи) имеет параметры: 

• Direction Balance (Баланс направлений); 

• Stroke Length (Длина штриха); 

• Sharpness (Резкость). 
фильтр Grosshatch 

Фильтр Grosshatch (Перекрестные штрихи) имеет параметры: 

• Stroke Length (Длина штриха); 

• Sharpness (Резкость); 

• Strength (Интенсивность). 



Фильтр DarkStrokes 

Фильтр DarkStrokes (Темные штрихи) имеет параметры: 

• Balance (Баланс); 

• Black Intensity (Интенсивность черного); 

• White Intensity (Интенсивность белого). 

Фильтр Ink Outlines 

Фильтр InkOutlines (Обводка краской) имеет параметры: 

• Strokes Length (Длина штриха); 

• Dark Intensity (Интенсивность темного); 

• light Intensity (Интенсивность светлого). 

Фильтр Spatter 

Фильтр Spatter (Разбрызгивание) имеет параметры: 

• Spray Radius (Радиус разбрызгивания); 

• Smoothness (Смягчение). 

Фильтр Sprayed Strokes 

Фильтр SprayedStrokes (Аэрограф) имеет параметры: 

• Stroke Length (Длина штриха); 

• Spray Radius (Радиус разбрызгивания); 

• StrokeDirection (Направление штриха) со списком направлений штриха. 

Фильтр Sumi-e 

Фильтр Sumi-e имеет параметры: 

• Stroke Width (Длина штриха); 

• Stroke Pressure (Нажим штриха); 

• О Contrast (Контрастность). 

4. Фильтры деформации (Distort) 

Фильтр Diffuse Glow 

Фильтр DiffuseGlow (Рассеянный свет) имеет параметры: 

• Graininess (Зернистость); 

• Glow Amount (Количество света); 

• Clear Amount (Прозрачность изображения). 

Фильтр Displace 

Фильтр Displace (Смещение) имеет параметры: 

• Horizontal Scale (Горизонтальный размер); 

• Vertical Scale (Вертикальный размер); 

• Displacement Map (Карта искривления). 

 

фильтр Glass 
фильтр Glass (Стекло) имеет параметры: аDistortion (Искажение); 

• Smoothness (Смягчение); 

• Texture (Текстура) со списком текстур; 

• Scaling (Масштаб); 

• Invert (Инверсия). 

фильтр Pinch 
фильтр Pinch (Выжимать) имеет параметр Amount (Количест-в0), с помощью которого изображение 

сжимается к центру/выжимается от центра. 

фильтр PolarCoordinates 
Фильтр PolarCoordinates (Полярные координаты) имеет параметры: 

• RectangulartoPolar (Прямоугольные в полярные); 

• PolartoRectangular (Полярные в прямоугольные). 

Фильтр Ripple 
Фильтр Ripple (Рябь) создает эффект ряби на воде. 

Фильтр OceanRipple 
Фильтр OceanRipple (Океанские волны) создает эффект волн. 

Фильтр Shear 
Фильтр Shear (Искривление) искривляет изображение вдоль кривой. 

Фильтр Spherize 
Фильтр Spherize (Сферизация) переводит изображение на горизонтальную или вертикальную 

цилиндрическую поверхность. 

Фильтр Twirl 



Фильтр Twirl (Скручивание) скручивает изображение. 

Фильтр Wave 
Фильтр Wave (Волна) по имитации эффекта сходен с фильтром RiPple (Рябь). 

Фильтр ZigZag 
Фильтр ZigZag (Зигзаг) деформирует изображение по радиусу с эффектами: «круги на воде» и «от центра». 

°- Шумовые фильтры (Noise) 

фильтр AddNoise 
Фильтр AddNoise (Добавить шум) имеет параметры: 

• Amount (Количество); 

• Distribution (Распределение); 

• Uniform (Равномерное); 

• Gaussian (По Гауссу); 

• Monochromatic (Монохромный). 

Фильтр Despeckle 
Фильтр Despeckle (Удаление точек) удаляет мелкие точки. 

Фильтр Dust&Scratches 
Фильтр Dust&Scratches (Пыль и царапины) размывает изобра. жение. Имеет параметры: 

• Radius (Радиус); 

• Threshold (Порог). 

Фильтр Median 
Фильтр Median (Медиана) размывает изображение с помощью параметра Radius (Радиус). 

6. Фильтры пикселизации(Pixelate) 

Фильтр ColorHalftone 
Фильтр ColorHalftone (Цветной полутоновой) создает эффект растра с помощью параметров: 

• Max. Radius (Максимальный радиус); 

• ScreenAngles (Углы наклона растров). 

Фильтр Crystallize 
Фильтр Crystallize (Кристаллизация) вызывает эффект кристаллизации изображения. Размер ячеек регулируется 

параметром CellSize. 

Фильтр Facet 
Фильтр Facet (Фасет) делит изображение на участки с близкими цветами. 

Фильтр Fragment 
Фильтр Fragment (Фрагмент) размывает и сдвигает изображение' 

Фильтр Mezzotint 
Фильтр Mezzotint (Меццо-тинто) разбивает изображение на точки, пятна, линии и штрихи (выбор 

осуществляется в списКеТуре (Тип)). 

Фильтр Mosaic 
Фильтр Mosaic (Мозаика) разбивает изображение на мозаичные фрагменты. 

Фильтр  Pointillize 
фильтр Pointillize (Пуантилизм) создает эффект пуантилизма техника живописи). 

2. фильтры рендеринга (Render) 

Команда 3D Transform 
Команда 3D Transform (ЗD-трансформация) служит для упрощенного трехмерного моделирования. 

Недостатком фильтра является отсутствие задней стороны созданной трехмерной фигуры,чтоснижает 

возможности трансформации. 

фильтр Clouds 
Фильтр Clouds (Облака) покрывает изображение пятнами основного и фонового цветов. 

фильтр DifferenceClouds 
Фильтр DifferenceClouds (Облака с наложением) покрывает изображение пятнами основного и фонового 

цветов в режиме Difference (Разность). 

Фильтр LensFlare 
Фильтр LensFlare (Блик) создает эффект блика с помощью параметров: 

• Brightness (Яркость); 

• Flare Center (Центр блика); 

• Lens Type (Тип линзы). 

Фильтр Lighting Effects 
Фильтр LightingEffects (Эффекты освещения) создает эффекты освещения на изображении. В 

открывающемся диалоговом окне Lighting Effects представлены следующие параметры: 

• Style (Стиль) — образцы освещения; 



• Light type (Тип света): 

• Рассеянное освещение (Directional); 

• прожектор (Spotlight); 

• лампочка (Omni); 

• On  (Включение) задает включение  или выключение типа света; 

• Intensity (Интенсивность) определяет яркость освещения; 

• Gloss (Отражение) — задаются параметры отражения Matte (Матовая) и Shiny (Глянцевая); 

• Material (Материал) — устанавливаются параметры от пластика (Plastic) до металла (Metallic); 

• Exposure (Экспозиция) — устанавливается экспозиция освещения; 

• Ambience (Среда) — устанавливается значение от позитива I(Positive) до негатива (Negative). 

8. Фильтры резкости (Sharpen) 

Фильтры Sharpen и SharpenMore 
Фильтры Shrapen (Резкость) и SharpenMore (Добавить резкость) повышают резкость изображения, действие 

последнего фильтра несколько сильнее, чем первого. 

Фильтр SharpenEdges 
Фильтр SharpenEdges (Резкость по краям) повышает резкость изображения по краям. 

Фильтр UnsharpMask 
Фильтр UnsharpMask (Контурная резкость) имеет параметры: 

• Amount (Количество); 

• О Radius (Радиус); 

• Threshold (Порог уровней). 

9. Фильтры набросков (Sketch) 

Фильтр Bas Relief 
Фильтр BasRelief (Барельеф) имеет параметры: 

• Detail (Детализация); 

• Smoothness (Смягчение); 

• LightDirection (Направление света) со списком команд. 

Фильтр Chalk&Charcoal 
Фильтр Chalk&Charcoal (Мел и уголь) имеет параметры: 

• Charcoal Area (Область угля); 

• Chalk Area (Область мела); 

• Stroke Pressure (Нажим штриха). 

Фильтр Charcoal 
Фильтр Charcoal (Уголь) имеет параметры: 

• Charcoal Thickness (Плотность угля); 

• Detail (Детализация); 

• Light/DarkBalance (Баланс светлого/темного). 

Фильтр Chrome 
Фильтр Chrome (Хром) создает эффект хромированной поверхности. 

фильтр ConteGrayon 

Фильтр ConteGrayon (Восковой карандаш) создает эффект воскового карандаша с рельефом. 

Фильтр GraphicPen 

Фильтр GraphicPen (Графический карандаш) имеет параметры: 

• Stroke Length (Длина штриха); 

• Light/DarkBalance (Баланс светлого/темного); 

• StrokeDirection (Направление штриха) со списком направлений штриха. 

Фильтр HalftonePattern 

Фильтр HalftonePattern (Полутоновый растр) создает эффект полиграфического растра. 

Фильтр NotePaper 

Фильтр NotePaper (Бумага для заметок) создает рельеф изображения с определенным уровнем зернистости. 

Фильтр Photocopy 

Фильтр Photocopy (Ксерокопия) имеет параметры: 

• Detail (Детализация); 

• Darkness (Затемнение). 

Фильтр Plaster 

Фильтр Plaster (Гипс) имитирует рельефы. 

Фильтр Reticulation 

Фильтр Reticulation (Ретикуляция) имеет параметры: 

• Density (Плотность); 



• ForegroundLevel (Уровень основного цвета); 

• BackgroundLevel (Уровень фонового цвета). 

Фильтр Stamp 

Фильтр Stamp (Штамп) создает грубые контуры одноцветного изображения. 

Фильтр TornEdges 

Фильтр TornEdges (Рваные края) создает одноцветное изображение с рваными краями, которые 

размываются дополнительными командами. 

Фильтр WaterPaper 

Фильтр WaterPaper (Мокрая бумага) размывает изображение, изменяя яркость и контрастность. 

10. Фильтры стилизации (Stylize) 

Фильтр Diffuse 
Фильтр Diffuse (Диффузия) уменьшает резкость изображения в различных режимах. 

Фильтр Emboss 
Фильтр Emboss (Рельеф) создает вогнутые и выпуклые рельефы изображения. 

Фильтр Extrude 
Фильтр Extrude (Экструзия) делит изображения на объемные блоки. 

Фильтр FindEdges 
Фильтр FindEdges (Выделение краев) создает рисунок изображения. 

Фильтр GlowingEdges 
Фильтр GlowingEdges (Свечение краев) создает рисунок на темном фоне, линии рисунка несколько 

утрированы. 

Фильтр Solarize 
Фильтр Solarize (Соляризация) создает изображение, близкое к негативному. 

Фильтр Tiles 
Фильтр Tiles (Ячейки) делит изображение на квадратные ячейки;) 

Фильтр TraceContour 
Фильтр TraceContour (Оконтуривание) оконтуривает отдельные элементы изображения. 

Фильтр Wind 
Фильтр Wind (Ветер), растягивая отдельные фрагменты изображения, имитирует искажение от ветра или размытие 

в движении. 

11. Текстурные фильтры (Texture) 

Фильтр Graquelure 
Фильтр Graquelure  (Кракелюры) имитирует сеть трещин на изображении. 

Фильтр Grain 
Фильтр Grain (Зерно) создает изображение в виде крупных зерен, тип зерна можно выбрать в списке GrainType. 

Фильтр MosaicTiles 
Фильтр MosaicTiles (Мозаичные ячейки) имитирует мозаику из ячеек. 

фильтр Patchwork 
Фильтр Patchwork (Цветная плитка) раскладывает изображение на цветные плитки. 

фильтр StainedGlass 
Фильтр StainedGlass (Витраж) раскладывает изображение на элементы, имитирующие витраж. 

фильтр Texturizer 
Фильтр Texturizer (Текстуризатор) имеет параметры: 

• Texture (Текстура) со списком команд; 

• Scaling (Масштаб); 

• Relief (Рельеф); 

• LightDirection (Направление света) со списком команд; 

• Invert (Инверсия). 

12. Раздел Video 
Фильтры раздела Video (Видео) улучшают качество видеоизображений. 

13. Другие фильтры (раздел Other) 

Фильтр Custom 
Фильтр Custom (Заказной) изменяет яркость изображений. 

Фильтр HighPass 
Фильтр HighPass (Переход цвета) изменяет тональность изображения и выявляет освещенные фрагменты. 

Фильтры Maximum и Minimum 
Фильтр Maximum (Максимум) расширяет области светлых зон. Фильтр Minimum (Минимум) расширяет 

области темных зон. 

Фильтр Offset 



Фильтр Offset (Смещение) сдвигает изображение. 

Фильтры Digimarc 
Фильтры Digimarc создают скрытые водяные знаки на изображении. Технология разработана фирмой 

DigimarcPictureMarc. 

Применение фильтров 
Фильтр можно применить как к слою в целом, так и к его выделенной части. Прежде чем применить 

фильтр к выделенной области, можно растушевать ее, чтобы она не слишком выделялась на изображении 

после фильтрации. 

Одни фильтры преобразуют выделенные фрагменты или слой целиком непосредственно после выбора 

команды. Другие же требуют установки определенных параметров в диалоговом окне. 

Выбрав команду меню Filter/stFilter (Фильтр/Последний фильтр) (комбинация клавиш Ctrl+F), можно 

повторно применить последний использовавшийся фильтр с теми же характеристиками. Для того чтобы 

открыть диалоговое окно последнего использовавшегося фильтра, в котором отображены последние 

установленные характеристики, можно воспользоваться сочетанием клавиш Ctrl+Alt+F. 

В режиме RGBиMultichannelдоступны все фильтры; а в режиме CMYK, Grayscale и LabColor— только 

некоторые из них. Фильтры неприменимы к изображениям в режиме BitmapиIndexedColorи к 

изображениям, в которых приходится 16 бит на каждый канал. 

Ослабление эффекта от фильтра 

С помощью команды Fade (Ослабить) можно ослабить эффект от применения фильтра, команд подменю 

Adjustments (Коррекция), находящихся в меню Image (Изображение), и команд подменю Extract (Извлечь) 

или Liquify (Исказить), находящихся в меню Filter(Фильтры), а также изменить результат рисования, 

стирания или редактирования. После применения фильтра выберите команду меню Edit/Fade 

(Редактирование/Ослабить) (комбинация клавиш Ctrl+Shift+F) и уменьшите значение непрозрачности, 

выберите режим смешивания и нажмите кнопку ОК. 

 

Практическое занятие № 24 Применение фильтров при создании растрового изображения 

Применение фильтров для создания «эффекта льда» 

1. Создайте новое изображение размером 300x300 с белым 

фоном и напишите на нем текст МИФЫ шрифтом ArialBlack 

48 рх (или 72 pt) черным цветом. 

2. Выполните команду Выберите/Загрузите Выбор-загрузить  Select/LoadSelection, затем Слой/ 

сглаживание  Layer/FlattenImage.( сгладить изображение) 

3. Сделайте инверсное выделение Selec/Inverse (Выбрать /Инверсия) и примените фильтр 

Filter/Pixelate/Crystallize-  фильтр-оформление-кристализация  с коэффициентом кристаллизации 8. 

4. Примените фильтр Filter/Noise/AddNoise (Фильтр/Шум/Добавить шум) с коэффициентом шума 70, 

включите параметр DistributionGaussian. 

5. Размойте изображение фильтром Filter/Blur Размытие / Размытие по Гауссу GaussianBlur с 

коэффициентом размывки 2. 

6. Отмените выделение Select/Deselect Выбрать/Отсеять и используйте фильтр Filter/Blur/Blur фильтр –

размытие- размытие. 

7. ВыполнитекомандуImage/Adjustmens/Invert. Изображение – настройки-  инвертировать 

8. Разверните изображение на 90 градусов по часовой стрелке: Изображение/Вращать/Холст 

Image/Rotate/Canvas/90 CW 

10. Примените фильтр Filter/Stylizeстили-ветер /Wind с параметрами Method: Wind, Direction: 

FromtheRight Ветер направление справа 

11. Верните изображение в горизонтальное положение: Image/RotateCanvas/90 CCW 

12. Примените фильтр Filter/Distort/Ripple  фильтр Исказить/Рябь с параметрами Amount 100% и 

SizeMedium-средняя.    

13. Придайте изображению цвет льда с помощью команды Image/Adjust/Hue/Saturation изображение 

корректировать-оттенок - насыщенность, включите кнопку Colorize, установите параметр Hue в положение 

— 175, aSaturation — 80. 

14. Добавьте искрящиеся блики с помощью дополнительных кистей. Нанесите искорки на некоторые 

выступающие льдинки. 

 

Применение фильтров для создания «эффекта льда»  

1. Создайте новое изображение размером 300x300 с белым 

фоном и напишите на нем текст МИФЫ шрифтом ArialBlack 

48 рх (или 72 pt) черным цветом. 



2. Выполните команду Выберите/Загрузите Выбор-загрузить  Select/LoadSelection, затем Слой/ 

сглаживание  Layer/FlattenImage.( сгладить изображение) 

3. Сделайте инверсное выделение Selec/Inverse (Выбрать /Инверсия) и примените фильтр 

Filter/Pixelate/Crystallize-  фильтр-оформление-кристализация  с коэффициентом кристаллизации 8. 

9. Примените фильтр Filter/Noise/AddNoise (Фильтр/Шум/Добавить шум) с коэффициентом шума 70, 

включите параметр DistributionGaussian. 

10. Размойте изображение фильтром Filter/Blur Размытие / Размытие по Гауссу GaussianBlur с 

коэффициентом размывки 2. 

11. Отмените выделение Select/Deselect Выбрать/Отсеять и используйте фильтр Filter/Blur/Blur фильтр –

размытие- размытие. 

12.ВыполнитекомандуImage/Adjustmens/Invert. Изображение – настройки-  инвертировать 

13. Разверните изображение на 90 градусов по часовой стрелке: Изображение/Вращать/Холст 

Image/Rotate/Canvas/90 CW 

15. Примените фильтр Filter/Stylizeстили-ветер /Wind с параметрами Method: Wind, Direction: 

FromtheRight Ветер направление справа 

16. Верните изображение в горизонтальное положение: Image/RotateCanvas/90 CCW 

17. Примените фильтр Filter/Distort/Ripple  фильтр Исказить/Рябь с параметрами Amount 100% и 

SizeMedium-средняя.    

18. Придайте изображению цвет льда с помощью команды Image/Adjust/Hue/Saturation изображение 

корректировать-оттенок - насыщенность, включите кнопку Colorize, установите параметр Hue в положение 

— 175, aSaturation — 80. 

19. Добавьте искрящиеся блики с помощью дополнительных кистей. Нанесите искорки на некоторые 

выступающие льдинки. 

 

Применение фильтров для создания эффекта «Эффект огня» 

1. Создайте новое изображение 800x800 RGBcolor, Transporent (прозрачный фон). Нажмите D, чтобы 

назначить цвет переднего плана и цвет фона по умолчанию. Нажмите Alt+Backspace, чтобы залить текущий 

слой черным цветом. Напишите слова ВЕК МИФОЛОГИИ шрифтом ArialBlack, 48 pt, белым цветом. 

2. Поверните уровень на 90 градусов по часовой стрелке:. Изображение-поворот на 90 по часовой 

3. Примените эффект ветра фильтр-стилизация-ветер с параметрами Wind и fromtheright. Примените этот 

эффект 4 раза подряд. 

4. Поверните уровень на 90 градусов против часовой стрелки:изображение-поворот против часовой. 

5. Примените фильтр фильтр-размытие-размытие по Гауссу с параметром 2. 

6. Затем эффект волны (фильтр-искажение-волна), с параметрами Medium и значением 100. 

7. Конвертируйте в черно-белый режим изображение-режим- оттенки серого. 

Этот шаг обязателен! 

8. Затем конвертируйте в индексированные цвета изображение-режим- индексированный цвет. 9.

 Примените «огненную палитру» изображение-режим /таблица цветов , выберите палитру 

«абсолютно черное тело». 

Применение фильтров для создания «Эффекта линзы»  

1. Откройте файлKapнавал.jpg. 

2. При помощи соответствующего инструмента выделите круглую область и выполните команду 

Edit/Copy (Редактирование/Копировать). 

3. Снимите выделение. 

4. Для всего рисунка примените фильтр (фильтр/ Смазывание/Смазывание Гаусса.) с параметром 2. 

5. Создайте новый слой и выполните команду (Редактирование/Вставить). 

6. Выровняйте положение вставленной области. 

7. Выполните команду (Слой/Эффекты слоя/Рельефность) с параметрами: 

Structure Multiply; Angle 30; Distance 0; Spread 0; Size 60. 

 

Практическое занятие № 25 Создание изображений с элементами текста.    
Надпись огнём. Способ II 

1. Откройте приложение Adobe Photoshop 

2. Создайте новое изображение командой Файл ► Новый (<Ctrl>+<N>). Укажите следующие 

парамерты нового рисунка: 

Ширина: 10 см 
 

 



Высота: 7 см Окно Имя 

Разрешение: 72 пиксели/дюйм 

Режим: Чёрно-белое 

Содержание (фон): Черный 

3. Инструментом Текст  создайте надпись fire: 

Тип шрифта: Time New Roman 

  

Начертание: Bold Italic 

Размер: 150 пкс 

Цвет: Белый 

4.  

5.  

6. Инструментом Перемещение  выровняйте надпись ближе к нижнему краю изображения. 

 

 

7. Склейте слои командой Слой ► Слить с нижним (<Ctrl>+<E>). 

8. Поверните изображение: Изображение ► Повернуть Холст ► 90o по часовой стрелки 

 

 

9. Создайте язычки пламени: Фильтр ► Stylize ► Wind... 

Direction (направление): From the Left (слева) 

 

 

Для усиления язычков примените фильтр несколько раз 

10.  



11.  
12. Примените диффузию: Фильтр ► Стилизация ► Рассеивать... 

Режим:  нормальный 
 

 

13.  

14.  
15. Верните изображение: Изображение ► Повернуть Холст ► 90o против часовой стрелки 

 

 

16. Оживите пламя: Фильтр ► Distort ► Ripple... 

Amount (эффект):  100% 

 
 

Size (размер):  Medium 

17.  

18.  
19. Раскрасте пламя: Изображение ► Режим ► Индексированные Цвета 

Сопоставьте пламени цветовую модель: 

Изображение ► Режим ► Палитра. 

В окне Таблица цветов выберите BlackBody  
 

 
20.  

21.  
22. Готовое изображения сохраните в своей папке. 



Готовое изображения 
 

 

 

 

Практическое занятие № 26,27 Создание коллажа с применением слоя-маски. 
 

Задание.Используя выполненный коллаж из занятия №3 /«древняя Греция»), выполните на нем текстовую 

надпись:Мифы Древней Греции. Вариант выполнения приводится на рис. 

 
При выполнении задания необходимо использовать эффекты слоя и стили деформированной надписи. 

 

Практическое занятие № 28,29 Разработка макияжа средствами AdobePhotoshop  

В этом уроке, рассмотрим базовую технику ретуши, которая поможет вам улучшить портретный 

образ. Вы узнаете, как убирать дефекты на коже, как накладывать косметику и усиливать некоторые черты 

лица, такие как губы и глаза. Мы пойдём дальше, чем стандартный процесс "обычной" ретуши, я покажу 

вам, как добавить больше гламура к вашему портрету, путём добавления драгоценностей на веки глаз, 

используя стоковые изображения. 

Ретушь портрета всецело относится к усовершенствованию черт лица, таких как глаза, губы и кожа, 

при этом не вызывая чувство фальши. Для этого, мы используем инструменты Осветления / Затемнения 

(Dodge/Burn), чтобы изменить освещение на волосах, чтобы придать им больше объёма, а также на глазах и 

губах, чтобы они выглядели более привлекательно. 

Цветовая коррекция будет проводиться с помощью корректирующих слоёв, таких как Цветовой 

Баланс (ColorBalance) для дополнительной коррекции, а также, чтобы не потерять качество картинки во 

время рабочего процесса. Мы используем стандартный инструмент Штамп (CloneStamp)для дублирования 

деталей, а также применим фильтр Эффекты Освещения(LightingEffects) для заключительного улучшения 

всего освещения. 

Исходные материалы: 

Портрет 

Драгоценные камни 

ШАГ 1 - Ретушь Кожи 

Дополнительные комментарии:  Для получения наиболее лучшего результата при ретуши кожи, 

используйте инструмент Точечная Восстанавливающая Кисть ( SpotHealingBrushTool). Данный инструмент 

работает лучше, чем какой-либо фильтр размытия, при этом он сохраняет текстуру кожи.  



Первая задача для улучшения портрета - это исправление любых дефектов на коже. Использовать 

инструмент Точечная Восстанавливающая Кисть (SpotHealingBrushTool) для удаления световых бликов, 

мелких ярких пикселей вокруг глаз и в области лба, а также инструмент Микс Кисть(MixerBrushtool) для 

смягчения кожи. 

ШАГ 2 - Первая Цветовая Коррекция 

Давайте изменим настроение изображения с помощью корректирующих слоёв. Я использовал Карту 

Градиента (GradientMap) для того, чтобы перераспределить цветовые оттенки на тенях и освещении. Я 

использовал градиент по умолчанию от фиолетового до оранжевого, единственное поменял оранжевый 

оттенок на #ecaf68. Поменяйте режим наложения для корректирующего слоя на Мягкий свет (Softlight), 

уменьшите непрозрачность слоя до 30%. 

 ШАГ 3 - Коррекция Контраста 

Проведите коррекцию контраста изображения с помощью Уровней (Levels) или Кривых (Curves). 

Освещение на данном изображении немного размыто, поэтому, я немного усилил освещение, использовав 

значение 235, корректирующегослояУровни (Levels). Также немного осветлил Средние тона (Midtones), 

сместив значение до 1,05, таким образом, всё изображение стало выглядеть немного ярче. 

ШАГ 4 - Узорные Кисти (кисти для нанесения орнамента) 

Я использовал круглую жёсткую кисть для того, чтобы нарисовать несколько точек под глазами. 

Каждый раз постепенно уменьшайте размер кисти при нанесении отдельной точки. Затем, продублируйте 

слой для правого глаза, примените слой- маску при необходимости. Используйте режим наложения Мягкий 

свет (Softlight), непрозрачность слоя 100%. 

 
ШАГ 5 - Грубо наносим Косметику 

  Дополнительные комментарии автора:  Для получения наиболее лучшего результата, начните 

с режим наложения Мягкий свет ( Softlight) и попробуйте применить различные цветовые оттенки и 

интенсивность, пока вы не подберёте правильное сочетание для оттенка кожи модели.  

Для создания теней для век, я использовал большую мягкую кисть. Цвет, который используется для 

этого, не самое главное, главное попробуйте применить интенсивность различных оттенков, пока вы не 

подберёте соответствующий оттенок. На отдельном слое, проделайте то же самое только с нижним веком, 

при этом используя другой цветовой оттенок. Режим наложения, который используется здесь, Перекрытие 

(Overlay). 

 
ШАГ 6 - Улучшаем качество нанесённой Косметики 

Дополнительные комментарии автора:  При нанесении макияжа и при работе с инструментами 

Осветлитель / Затемнитель( Dodge/ Burntools), используйте мягкие кисти с низкой непрозрачностью. 

Пройдитесь кистью несколько раз, постепенно наращивая интенсивность создаваемого эффекта.  

Как только вы грубо нанесли косметику, к обоим слоям с косметикой добавьте слой- маски для 

коррекции и улучшения нанесённой косметики. Для получения натурального эффекта макияжа, используйте 

большую мягкую кисть на слой- масках, уменьшив непрозрачность кисти до примерно 25%. Используйте 

корректирующий слой Цветовой тон / Насыщенность(Hue/Saturation) для выбора цвета косметики. 

Примечания переводчика:  1. корректирующие слои Цветовой тон / Насыщенность для изменения 

цвета косметики, используйте в качестве обтравочной маски. 2. Один корректирующий слой для верхнего 

века, второй для нижнего века. 3. Слой-маски используются для смягчения или коррекции макияжа.   

Дополнительные комментарии автора:  При работе с портретной ретушью,  не переборщите с 

проводимой коррекцией. Проводите едва уловимые изменения, а также используйте настройки 

Непрозрачности ( Opacity) для уменьшения эффекта. Отключайте и включайте видимость слоёв для 

быстрого предварительного просмотра.  

ШАГ 7   Затемнение и Осветление 

Создайте новый слой и далее идём Редактирование - Заливка (Edit>Fill) и заливаем 50 % Серым (50% 

Gray). Поменяйте режим наложения для этого слоя на Перекрытие (Overlay) и на этом же слое, примените 

инструменты Осветлитель / Затемнитель(Dodge/Burntools), значение Экспозиции (Exposure) 3-5%. Создайте 

световые блики с помощью инструмента Осветлитель и тени с помощью инструмента Затемнитель, 

используя мягкую кисть среднего размера. 



Дополнительные комментарии автора:  Улучшение качества изображения  

Инструменты  Осветлитель  / Затемнитель  (Dodge/Burntools) отлично  подходят  для  улучшения  качества  

изображения . Используя очень  низкое  значение  Экспозиции (Exposure) 3-6 %, вы  можете  изменить  

структуру  тела , путём  создания  световых  бликов  и  теней . Например, чтобы глаза стали более 

выразительными, вы можете добиться это, путём интенсивного осветления века и радужной оболочки глаза 

с помощью небольшой мягкой кисти со значением экспозиции 20-30% в зависимости от изображения. 

Данная техника может также применяться к коррекции губ и волос.  

ШАГ 8 - Усиливаем выразительность глаз и улучшаем волосы 

Увеличиваем значение Экспозиции (Exposure) до примерно 25% и уменьшаем размер кисти. 

Находясь на том же самом слое, которые мы залили 50 % серым, примените инструмент осветлитель к векам 

глаз, чтобы веки стали светлее, а также к волосам. Продублируйте данный слой для усиления эффекта. 

Примечания переводчика:  автор усиливает выразительность век, радужной оболочки глаз и губ.  

ШАГ 9 - Цветовой Баланс 

Цель коррекции Цветового Баланса (ColorBalance) - это цветовая коррекция всего изображения. Мы 

сделали изображение более холодным, в частности это касается параметров средних тонов и теней, путём 

добавления больше оттенков голубого и синего цвета. Количество (настройки) добавленного цвета по 

каждому каналу зависит от ваших предпочтений. 

ШАГ 10 - Цвет губ 

Меняем цвет губ с помощью корректирующего слоя Цветовой тон / Насыщенность (Hue/Saturation). 

Создайте корректирующий слой, далее, залейте слой-маску корректирующего слоя чёрным цветом, а затем с 

помощью белой кисти прокрасьте область губ, чтобы эффект проявился только на губах. Используйте три 

параметра корректирующего слоя для коррекции интенсивности и яркости цвета. 

ШАГ 11 - Добавьте деталей, используя драгоценные камни 

С помощью стокового изображения, которое можно скачать по ссылке вначале этого урока, сделайте 

наше изображение более интересным. Поменяйте масштаб изображения драгоценных камней в соответствии 

с вашим изображением, а затем продублируйте столько раз, сколько необходимо. Вы можете изменить цвет 

камней с помощью корректирующегослояЦветовой тон / Насыщенность (Hue/Saturation). Примените 

небольшое значение опции стилей слоя Тени (DropShadow) для создания большего реализма. 

ШАГ 12 - Создайте дубликат Розочки 

С помощью инструмента Штамп (CloneTool), создайте дубликат розочки на волосах модели. 

Избегайте создания точной копии розы, путём изменения настроек параметра Источник клонов 

(clonesourceproperties), который можно активировать через Окно - Клонирование источника 

(Window>CloneSource). Просто, удерживая клавишу Alt + щёлкните по оригинальному изображению розы, 

далее на новом слое нарисуйте дубликат розы. 

ШАГ 13 - Заключительный Световой Эффект 

Создайте новый слой поверх всех слоёв, а затем находясь на новом слое, нажмите клавиши 

Shift+Ctrl+Alt+E, чтобы объединить все слои на новом слое. К этому слою примените фильтр Эффекты 

Освещения (LightingEffectsfilter), идём Фильтр- Рендеринг - Эффекты Освещения 

(Filter>Render>LightingEffects). Целью данного заключительного эффекта является затемнение углов 

изображения, чтобы привлечь внимание наблюдателя к лицу модели. 

 

Итоговый результат 

 
 

 

Практическое занятие № 30,31 Разработка имиджа для модели-шаблона средствами 
AdobePhotoshop 
Преобразуем фото в эскиз 

1. Откроем нужную фотографию 



 
2. Обесцветим ее (Ctrl+Shift+U) 

 
3. Filter > Custom > High Pass, радиус примерно 4  

 
4. Скопируйте слой, примените режим смешивания Color Dodge. Увеличьте контраст: Image > Adjustment > 

Brightness/Contrast  

 
5. Filter > Blur > Smart Blur (примерные параметры: Radius 20, Threshold 30) 

 
 

 



Практическое занятие № 32,33. Ретушь цифрового фото. 
 

Тема: Обработка фотографий. Применение инструментов корректировки и 

ретуширования изображений. 

Цель: - формирование навыков использования инструментов корректировки и 

ретуширования для обработки изображений; 

Вид работы: фронтальный 

Время выполнения: 2 часа 

Теоретические сведения 

Инструменты ретуширования: 

Инструмент Штамп (Stamp) существует в двух вариантах: Clone Stamp (Клон) 

и Pattern Stamp (Штамп-узор). Первый вариант предоставляет возможность создания 

точных копий элементов изображения, а второй — цветовых образцов. 

Инструмент Clone Stamp (Клонирующий штамп) позволяет рисовать 

не  цветом, а кусками из другого места или из другого изображения. Он может 

работать в двух режимах: с выравниванием и без него. Для включения режима 

выравнивания следует установить флажок Aligned (Выровненный). Помимо размеров 

кисти вы можете задать ее непрозрачность. При значениях меньше 100 % старая 

окраска будет просвечивать сквозь нанесенный рисунок. В раскрывающемся 

списке Mode (Режим) можно выбрать все те же режимы смешивания, что и для 

обычной кисти. 

Чтобы начать реставрацию изображения с помощью штампа, надо указать 

программе место, которое вы хотите копировать. Для этого щелкните, держа 

нажатой клавишу Alt, в точке, которая будет «якорем». Эта точка может быть в том 

же самом или в другом изображении. Если теперь, отпустив клавишу Alt, щелкнуть в 

другом месте и провести кистью линию любой формы, будет воспроизведена 

дорожка той же формы, ведущая от якоря. 

При клонировании в обоих режимах вы видите сразу два курсора. Один 

показывает, где вы сейчас проводите линию, а второй курсор показывает, где 

находится то место, которое сейчас копируется. Просто следите за этим вторым 

курсору. Вели место, где он оказался, вам не подходит, переместите «якорь». 

Инструмент Patch (Заплата) делает практически то же самое, что и исцеляющая 

кисть, но для выделенной области. Он копирует одну область на другую или 

закрашивает ее готовым узором, учитывая при этом цветовой и тоновый диапазон 

того места; куда ставится «заплата». 



Для того чтобы поставить «заплату», обведите инструментом область, которую 

вы хотите скопировать. Она выделится. На Панели управления включите 

переключатель Destination (Место назначения). Теперь вы должны указать то место, 

куда надо эту заплату перенести. Установите указатель внутри выделенной области и 

перетащите ее на нужное место, которое тут же перекрасится. Далее можете 

перетащить заплату в другое место и т. д. 

Можно использовать и другой способ. В этом случае вы, наоборот, выделяете 

инструментом Patch (Заплата) то место, которое надо замазать, например дефект или 

надпись. После этого надо выбрать переключатель Source (Источник) и перетащить 

выделенную область в то место, которое подходит по фактуре. Как только вы 

отпустите указатель мыши, выделение прыгнет на прежнее место, и оно 

перекрасится. 

Инструменты группы Blur  

На этой альтернативной панели находятся три инструмента: 

  Blur (Размывание) — инструмент для смазывания границ изображения; 

  Sharpen (Резкость) — инструмент повышения резкости; 

  Smudge (Палец) — смазывание по траектории. 

Инструмент Smudge (Палец) смазывает пикселы в направлении движения,  как 

будто вы проводите пальцем по свежей краске. Чем больше 

величина Strength (Сила), тем сильнее размазывается краска. 

Помимо настройки, характерной для всех инструментов ретуширования, у него 

есть два собственных флажка. При установленном 

флажке Use All Layers (Использовать все слои) палец размазывает краски всех 

видимых слоев. Бели флажок снят, размазывается только активный слой. 

При установленном флажке Finger Painting (Рисование пальцем) мазок 

начинается с текущего основного цвета, как будто вы начали размазывать пальцем, 

испачканным другой краской. 

Инструменты тонирования (Dodge)  

Как и группа Blur, группа инструментов тонирования включает три 

инструмента: 

  Dodge (Осветлитель) — увеличивает яркость; 



  Burn (Затемнитель) — уменьшает яркость; 

  Sponge (Губка) — изменяет насыщенность цветов. 

Действие инструментов Dodge (Осветлитель) и Burn (Затемнитель) основано на 

традиционной технике фотографии, связанной с уменьшением или увеличением 

экспозиции на отдельных участках отпечатка. Чтобы ограничить доступ света к 

определенным участкам изображения, фотограф использует специальные 

непрозрачные маски (экраны) и увеличивает или уменьшает время экспонирования. 

Инструмент Sponge (Губка) выполняет цветовую коррекцию в том месте,  где 

вы им проведете. Интенсивность воздействия определяется параметром now (Поток), 

а размеры обрабатываемой области — размером кисти. У этого инструмента два 

режима работы, которые можно выбрать в раскрывающемся списке Mode (Режим). В 

режиме Saturate (Окрасить) он увеличивает насыщенность цвета, в 

режиме Desaturate (Обесцветить) уменьшает ее. Для полутоновых изображений губка 

увеличивает или уменьшает контрастность изображения. При включении крайней 

справа кнопки с изображением аэрографа изменения нарастают, если держать 

указатель на одном месте. 

Задания к практической работе 

Задание 1. Реставрация старинной фотографии 

1.   Открыть файл Sveta.jpg. Надо заметить, что фотография и изначально была 

неважного качества, а со временем пришла в негодность: где-то отсутствуют 

фрагменты, где-то появились царапины, пятна, посторонние мазки и т. п. 

 



2.   После открытия документа в редакторе переходим на 

палитру Channels (Каналы). Внимательно просматриваем все имеющиеся у нас 

цветные каналы. Выбираем из них тот, в котором, по нашему мнению, 

изображение выглядит наилучшим образом (например, меньше пятен, четче 

рисунок и т. п.). Мы выбрали канал Red (Красный). Все остальные операции будем 

проводить именно в этом канале, поэтому все остальные каналы отключаем. Таким 

образом, мы уже сделали первый шаг в реставрации фотографии — устранили 

некоторые пятна, так как эти пятна могли находиться только в одном пли двух 

каналах. Кроме того, мы устранили и характерную желтизну, присущую 

старинным фотографиям. 

3.   Переключаемся в режим редактирования изображения в оттенках серого 

командой меню Image ► Mode ► Grayscale (Изображение ► Режим 

►Градации серого). Для более детальной реставрации советуем увеличить 

масштаб изображения. Основным инструментом по удалению погрешностей на 

фотографии является Clone Stamp (Штамп). Именно с его помощью можно быстро 

и просто на место трещин и царапин, а также на место утраченных фрагментов 

вставить («клонировать») хорошие участки, заимствованные из других областей 

фотографии. Чтобы исправленное место не выделялось своей 

однообразностью, следует брать образцы из различных областей 

фотографии, наиболее идентичных исправляемым. Некоторые мелкие 

царапины можно просто залить соответствующим цветом. 

4.   На втором этапе реставрации 

инструментом Rectangular Marquee (Прямоугольная область) выделяем фрагмент 

изображения так, чтобы все оборванные и неровные края остались за границей 

выделения. Копируем выделение в новый слой. Теперь мы получили фотографию 

с ровными краями. 

5.   Затем убираем все явные и крупные недостатки на однородных областях 

изображения. В основном это большие трещины и царапины на фоне. Здесь 

используем инструмент Clone Stamp (Штамп). Удерживая нажатой клавишу Alt, 

щелкаем левой кнопкой мыши на хорошем участке. Затем отпускаем клавишу Alt и 

щелчками левой кнопкой мыши заполняем поврежденные участки 

и.поражения. 

6.   Кроме всего прочего, у нас утрачены углы у левой границы фотографии. 

Конечно, их можно восстановить, используя все тот же 

инструмент Clone Stamp (Штамп). Но это достаточно трудоемкий процесс. 

Поэтому, используя инструмент Polygonal Lasso (Прямолинейное лассо), выделяем 

аналогичный неповрежденный участок изображения у левой границы. Копируем 

его командой меню Edit ► Сору (Редактирование ► Скопировать) и вставляем 



командой меню Edit ► Paste (Редактирование ► Вклеить). Затем передвигаем этот 

фрагмент в левый верхний угол. И уже теперь 

инструментом Clone Stamp (Штамп) восстанавливаем те небольшие участки, 

которые не смог закрыть скопированный фрагмент. 

7.   Когда все крупные недостатки устранены, можно приступать к устранению 

мелких. Эта работа будет более скрупулезной и потребует максимума внимания 

и точности движения. 

8.   На этом этапе мы будем убирать трещины и царапины на неоднородных и 

некрупных участках изображения, таких как лица, элементы одежды и т. п. В 

основном такие участки изображения не только мелкие, но и очень 

неоднородные. Чтобы получить более качественный результат, еще более 

увеличиваем масштаб. 

9.   Не будем подробно описывать весь процесс исправления недостатков. Он 

основывается на аккуратном применении инструмента Clone Stamp (Штамп). 

10.   Нередко также используется метод реставрации фотографии с помощью 

фильтра Filter ► Blur ► Gaussian Blur (Фильтр ► Размытие ► Размытие по Гауссу). 

Суть этого способа заключается в том, что мы сначала размываем все исходное 

изображение, а затем, используя инструмент History Brush (Архивная кисть), 

восстанавливаем только сохранившиеся участки изображения. Испорченные 

участки так и остаются размытыми, а потому кажутся неповрежденными. 



 

Задание 2. Художественная обработка фотографии. 

 

Рисунок 1 - Фотография до и после обработки 

1.   Откройте исходное изображение. Продублируйте слой (Layer > Duplicate 

Layer) и удалите предыдущий слой, используя кнопку Delete Layer в окошке со 

слоями. Добавьте немного яркости Image > Adjustments > Levels (быстрый вызов 

Ctrl+L). 



     

2.   Обрежьте часть изображения, используя инструмент Crop . 

3.   Используя инструмент  устраните дефекты кожи. 

 

4.   Примените Filter > Liquefy (Shift+Ctrl+X) и используйте Turbulence Tool. 



 

5.   Поднимите немного бровь и сделайте нос потоньше. 

 

6.   Используя кисть разных размеров, сделайте лицо уже. Затем уменьшите 

картинку по вертикали, используя Edit > Free Transform (Ctrl+T). 



 

7.   Уберите оставшуюся часть при помощи инструмент . С помощью 

Polygonal Lasso Tool выделите лицо с отступом от края. После этого измените, 

настройки инструмента и уберите выделение с глаз, губ, ноздрей. 

 

8.   Скопируйте это выделение Edit > Copy (Ctrl+C) и вставьте копию на новом 

слое Edit > Paste (Ctrl+V). Примените Filter > Blur > Gaussian Blur со следующими 

настройками. 



 

9.   Уменьшите прозрачность до 69%. 

10.   Объедините слой с предыдущим Layer > Merge Down (Ctrl+E) и уберите 

жесткость волос и шеи, которая очень сильно бросается в глаза: Image > Adjustments 

> Selective Color. 

 

11.   Измените цвет картинки, используя Image > Adjustments > Curves (Ctrl+M). 



 

12.   Измените цвет глаз, используя Brush Tool. 

 

К этому слою примените Gaussian Blur. 

Измените, тип слоя на Soft Light и уменьшите прозрачность до 70%. 

 

13.   На новом слое нарисуйте губы и примените к нему Gaussian Blur. 



 

Измените, тип слоя на Soft Light и уменьшите прозрачность до 60%. 

 

14.   Теперь возьмите Eyedropper Tool и щелкните на самом темном месте 

ресниц. При помощи Brush Tool на новом слое выделите глаза. 

 

Тип слоя измените на Soft Light. На новом слое нарисуйте тени. 

 

Примените Gaussian Blur. Тип слоя измените на Color Burn. 



 

Теперь нужно изменить цвет у слоя с нарисованными губами. Для этого 

выберите слой с губами и примените команду Image > Adjustments > Hue/Saturation 

(ctrl+u). Прозрачность поставьте на 73%. 

 

15.   На новом слое нарисуйте подобное следующему. Примените Gaussian Blur. 

 

Используя Eraser Tool, удалите те части, которые выступают за пределы лица. 

Тип слоя установите на Linear Burn, а прозрачность слоя снизьте до 42%. 



Объедините все слои: Layer > Merge Visible (Shift+Ctrl+E) и перейдите в Image 

> Adjustments > Levels (ctrl+L). В открывшемся окне установите следующие 

значения. 

 

Сделайте дубль этого слоя. К полученной копии примените Gaussian Blur и 

установите тип слоя на Soft Light. Уменьшите прозрачность копии до 50%. 

В итоге должна получиться отретушированная фотография. 

 

Задание 3. Корректировке недостатков фотоизображения 

Загрузите файл изображения SLALOM.TIF (или подобную фотографию) в 

Photoshop и попытайтесь проанализировать имеющиеся в нем дефекты с целью 

выработки стратегии их поэтапного исправления. В первую очередь, это неудачное 

кадрирование, пятна, трещины, измятость и другие недостатки. 

1.   Кадрирование и преобразование формата 



а.      Нажмите клавишу С, чтобы сделать активным инструмент Crop 

(Кадрирование). Затем щелкните на кнопке  мыши и очертите область 

изображения, содержащую сюжетно важную часть фотографии, как это 

показано на рис. 2. Одновременно на этом шаге вы удаляете 

второстепенные детали изображения. 

б.     Для уменьшения объема файла преобразуйте изображение из RGB-модели 

в модель Grayscale (Градации серого) с помощью команды 

Image  ModeGrayscale (Изображение Режим  Черно – белый). При 

этом размер файла SLALOM.TIF уменьшился примерно в 3 раза. 

в.      Выберите команду File  Save As (Файл  Сохранить как) и сохраните 

новое изображение в файле с другим именем, например SLALOM1.TIF. 

 

Рисунок 2 - Изображение, полученное путем кадрирования исходного 

Не сохраняйте промежуточные изображения в формате JPG. В том случае, если 

придется возвратиться к промежуточному результату, будет считан с диска файл 

более низкого качества, чем исходный, так как компрессия с потерей качества 

каждый раз будет применяться к текущему изображению, что приведет к его 

постепенной деградации. 

2.   Анализ гистограммы и устранение глобальных технических дефектов 

а.      Выберите команду Window  Histogram (Окно  Гистограмма). На 

экране появляется окно Histogram (Гистограмма) (рис. 3). 



 

Рисунок 3 - Окно Гистограмма 

Из предварительного анализа гистограммы видно, что фотография содержит 

глобальные эффекты, связанные с отсутствием областей светов и теней. Имеет место 

зауженный, требующий коррекции диапазон по яркости. В данном случае ясно видно 

смещение основной массы пикселов в область светлых полутонов. Полностью 

отсутствуют пикселы ниже уровня 40 и выше 240, то есть динамический диапазон 

составляет всего 200 вместо 255. Основная информация сгруппирована в области 

градаций 150-200. Это говорит о том, что изображение явно нуждается в тоновой 

коррекции. 

Для коррекции этого типа дефекта воспользуйтесь инструментом Levels 

(Уровни). 

б.     Выберите команду Image  Adjustments  Levels 

(Изображение  Регулировки  Уровни) или нажмите Ctrl+L для 

отображения диалогового окна Levels (Уровни) (рис. 4). 

 

Рисунок 4 - Диалоговое окно Levels (Уровни) c гистограммой распределения уровней 

яркости черно-белого изображения SLALOM.TIF 

Самым простым из доступных в этом окне способов коррекции является 

автоматический ввод входных параметров. Для его реализации необходимо лишь 



щелкнуть на кнопке Auto (Авто). Это приводит к преобразованию наиболее темных 

пикселов в черные, а самых светлых – в белые. 

в.      Установите флажок Preview (Просмотр) и щелкните на кнопке Auto 

(Авто) для выполнения автоматической коррекции. В полях для входных 

значений установится цифры 52; 1,00; 210 (см. рис. 4). Ползунки 

регуляторов белой и черной точек сместились в соответствующие этим 

цифрам позиции. Обратите внимание на резкое изменение фотографии. 

Вуаль исчезла, появились черные и белые области, повысился контраст, 

все изображение стало более сочным. Если полученные при этом 

изменения на фотографии не удовлетворяют, выполните коррекцию 

фотографии инструментом Levels (Уровни) вручную. 

г.      Сохраните промежуточный результат в виде файла SLALOM2.TIF. 

3.   Ретушь технического брака Штампом (устранение на фотографии царапин и 

трещин) 

Нужно перейти к коррекции локальных дефектов (рис. 5). При увеличении 

масштаба фотографии на очках лыжницы видна трещина. Необходимо устранить 

этот дефект инструментом Clone Stamp (Клонирование штампа). 

а.     Подберите удобный для работы масштаб изображения, комбинируя 

нажатие комбинацией клавиш Ctrl + «+» (увеличение масштаба) и Ctrl + 

«-» (уменьшение масштаба). 

б.     Щелкните на панели инструментов на кнопке  Clone Stamp 

(Клонирование штампа), чтобы сделать активным этот инструмент. 

 

Рисунок 5 - Локальные технические дефекты фотографии в увеличенном масштабе 



в.     Установите на панели свойств этого инструмента значения его 

атрибутов: Opacity (Непрозрачность) – 100%, Mode (Режим наложения) – 

Normal (Норма) и небольшую мягкую кисть, например 21, из 

раскрывающегося списка Brush (Кисть). 

г.      Удерживая клавишу Alt, щелкните мышью (курсор принимает форму 

крестика) на фрагменте «хорошей» области рисунка, расположенного в 

непосредственной близости с дефектной областью, чем устанавливается 

источник изображения. Затем отпустите клавишу Alt и щелкните мышью 

на области царапины. На участок царапины, который указан мышью, 

накладывается выбранный источник изображения, исправляя данный 

дефект. 

д.     Повторяйте шаг 4 до тех пор, пока полностью не удалите царапину на 

очках лыжницы из образца. 

е.     Аналогично (копированием соседних областей) проштампуйте трещину 

на правом плече и правом колене лыжницы и сохраните результат как 

файл SLALOM3.TIF. 

4.   Устраняем крупные пятна инструментом Marquee (Область) 

а.     Выберите один из инструментов (Elliptical Selection (Эллиптическое 

выделение) или Rectangular Selection (Прямоугольное выделение)), 

входящих в группу инструментов Marquee (Область), и выделите с их 

помощью фрагмент хорошо изображенного снега. Затем, используя 

команду Edit  Copy (Редактирование  Копировать), скопируйте его в 

буфер обмена (clipboard). 

б.     Выберите команду Edit  Paste (Редактирование  Вставить) для 

создания дубля области «хорошего» снега и, применяя инструмент Move 

(Перемещение), перетащите его на место пятна. В результате пятно 

маскируется областью хорошего снега (именно маскируется, поскольку 

пока область чистого снега как бы «висит» над дефектом в отдельном 

слое, расположенном поверх фонового слоя). 

в.     Выполните шаги 1 и 2 для удаления всех имеющихся на фотографии 

пятен. 

г.      После завершения операции устранения крупных пятен на фотографии 

выполните команду Layer  Flatten Image (Слой  Выполнить 

сведение). Данная команда совмещает (интегрирует) все созданные в 

процессе работы слои с фоновым слоем. 



д.     Сохраните результаты работы в виде файла SLALOM4.TIF 

5.   Ретушь мелких пятен инструментом Smudge (Палец) 

а.      Выберите на панели инструмент Smudge (Палец)  и выполните 

настройку его атрибутов с помощью панели свойств: задайте режим 

(Mode) – Normal (Норма), снимите флажок Finger Painting (Рисование 

пальцем), установите значение параметра Strength (Сила) равным 50% и 

выберите из списка Brush (Кисть) мягкую кисть среднего размера, 

например 27. 

б.     Выполните инструментом Smudge (Палец) «размазывание» снега вдоль 

лыжни, убирая пятна. Мелкие пятна можно удалять также инструментом 

Blur (Размытие) . 

Следует всегда учитывать, что инструменты Smudge (Палец) и Blur (Размытие) 

нарушают фактуру обрабатываемой поверхности. Поэтому применять их 

необходимо с предельной осторожностью, устанавливая значения Strength (Сила) 

менее 100%, так как при неумелом использовании вместо одного можно внести 

другой локальный дефект. 

в.      Завершив этот шаг, снова сохраните проделанную работу в виде файла 

SLALOM5.TIF. 

6.   Увеличение резкости изображения с помощью фильтров 

Исходная фотография сама по себе была недостаточно резкой. После 

применения различных инструментов в ходе ее коррекции она стала еще более 

размытой. Поэтому следующий шаг работы – повышение резкости фотографии. Для 

этой цели воспользуйтесь группой фильтров Sharpen (Резкость) в меню Filter 

(Фильтр). 

а.    Для обработки изображения фильтром, повышающим контраст, 

выполните команду Filter  Sharpen  Sharpen 

(Фильтр  Резкость  Сделать четче). Этот фильтр не имеет 

диалогового окна с настройками, поэтому результат применения фильтра 

отображается непосредственно на изображении. В результате видно, что 

контуры темных объектов как бы выделились на светлом фоне, мелкие 

белые и светло-серые точки на костюме горнолыжницы стали 

значительно ярче. Общее впечатление – четкость изображения немного 

возросла. 



б.     Если резкость кажется недостаточной, повторите команду для ее 

повышения, сравнивая полученный результат с изображением, 

приведенным на рис. 6. 

в.     Сохраните окончательный результат в виде файла SLALOM6.TIF 

 

Рисунок 6 - Пример черно-белой фотографии после ретуширования средствами 

Adobe Photoshop 

Задания для самостоятельной работы: 

1.   Используя инструмент Clone Stamp, удалите с 

фотографии FISHMAN.JPG изображение зрителя, оставив на ней только рыбака. 

2.   Восстановите испорченную фотографию Old photo. 

3.    Отретушируйте фотографию женщины на фото Old woman 

4.   Используя все инструменты ретуширования, скорректируйте свою 

фотографию. 

5.   Из своей фотографии (или фотографии своего друга) сделайте карикатуру, 

применив инструменты ретуширования и используя инструменты фильтра Luquify. 

 

 

 

 

 



Практическое занятие № 34 Настройка камеры 
 

Тема: «Подготовка фотоаппарата к фотосъемке» 

Цель: Научиться подготавливать фотоаппарат к фотосъемке 

Ход работы: 
 

1. Проверить фотоаппарат на наличие повреждений; 

 

2. Проверить всели устройства фотоаппарата на месте (карта памяти, аккумулятор, 

объектив); 

 

3. Почистить фотоаппарат; 

 

4. Сделать фотосъемку пробного кадра. 

 
 

ПРАКТИЧЕСКОЕ ЗАНЯТИЕ 
Тема: «Выбор режима фотоаппарата» 

Формируемые компетенции: 
ПК 1.1. Выполнять фотосъемку, формирование комплекта фотографий на документы и 

вывод на печать в соответствии с техническими требованиями и рекомендациями. 

 

ПК 1.2. Выполнять фотосъемку индивидуальных и групповых портретов с 

классическими схемами светового и композиционного решения в студии. 

 

ПК 1.3. Выполнять фотосъемку индивидуальных и групповых портретов на выезде, в 

том числе на фоне памятных мест. 

ОК 1. Понимать сущность и социальную значимость будущей профессии, проявлять к 

ней устойчивый интерес. 

 

ОК 2. Организовывать собственную деятельность, исходя из цели и способов ее 

достижения, определенных руководителем. 

 



ОК 3. Анализировать рабочую ситуацию, осуществлять текущий и итоговый контроль, 

оценку и коррекцию собственной деятельности, нести ответственность за результаты 

своей работы. 

 

ОК 4. Осуществлять поиск информации, необходимой для эффективного выполнения 

профессиональных задач. 

 

ОК 5. Использовать информационно-коммуникационные технологии в 

профессиональной деятельности. 

 

ОК 6. Работать в команде, эффективно общаться с коллегами, руководством, клиентами. 

 

ОК 7. Исполнять воинскую обязанность, в том числе с применением полученных 

профессиональных знаний (для юношей). 

Цель: Научиться выбирать правильный режим фотоаппарата в зависимости от съемки. 

Предполагаемый результат: Умеет выбирать правильный режим фотоаппарата в 

зависимости от съемки. 

Иметь практический опыт: в работе с инструктивной документацией, контроле 

качества выполняемых работ. 

Знать: 
 

- виды, устройство и назначение отдельных видов фотографической аппаратуры (в том 

числе цифровой) и фотооборудования; 

 

- основные принципы фотосъемки (аналоговой и цифровой). 

Уметь: 
 

- Пользоваться фотоаппаратурой и фотооборудованием для осуществления фотосъемки 

 

- Определять экспонометрические и иные параметры фотосъемки; 

Уровень работы: 2 - репродуктивный 

Время выполнения: 2 часа 

Оснащение работы: 
 

  

Образец титульного листа 

  

Содержание(алгоритм) лабораторной работы 

  

Критерии оценки качества выполнения работы 

 

 

Ход работы: 
 

1. Зарисовать иконки основных режимов фотоаппарата; 

 

2. Описать основные режимы фотоаппарата; 



 

3. Предоставить изображения. 

Вопросы для подготовки к практическому занятию: 
 

1.  

Виды, устройство и назначение отдельных видов фотографической аппаратуры (в 

том числе цифровой) и фотооборудования; 

2.  

Основные принципы фотосъемки (аналоговой и цифровой). 

 

 

Тема: «Выбор режима фотоаппарата в зависимости от съемки» 

Цель: Научиться выбирать правильный режим фотоаппарата в зависимости от съемки. 

Ход работы: 
 

1. Зарисовать иконки основных режимов фотоаппарата; 

 

2. Описать основные режимы фотоаппарата; 

 

3. Предоставить изображения. 

Иконки основных режимов 
 

   

 

Автоматический 

режим 

 

Автоматический 

режим без вспышки 

 

Портретный режим 

 

   
 

 

Режим макросъемки 

 

Режим ночной 

съемки 

 

Ручной режим 

съемки 

 

 

   
 



 

Программный режим 

 

Режим приоритета 

выдержки 

 

Режим приоритета 

диафрагмы 

 

 

  
 

 

Режим пейзажной съемки 

 

Спортивный режим 

 

Автоматический режим 
 

Данный режим съемки, фотоаппарат самостоятельно устанавливает выдержку, 

диафрагму, ISO, баланс белого, фокус, включает или выключает вспышку, в 

зависимости от условий съемки. 

 

То, каким получится кадр, полностью зависит от производительности камеры, 

фотограф, никак не можете повлиять на результат. 

Автоматический режим без вспышки 
 

Данный режим съемки, фотоаппарат самостоятельно устанавливает выдержку, 

диафрагму, ISO, баланс белого, фокус, в зависимости от условий съемки, но в данном 

режиме не используется вспышка. 

Портретный режим 
 

Портретный режим — это режим фотоаппарата, используемый во время 

фотографирования людей. В данном случае фотоаппарат отдает предпочтение большей 

диафрагме, позволяющей сделать фон более размытым. Портретный режим лучше 

использовать, когда в кадре присутствует один человек, расположенный достаточно 

близко к объекту съемки. Если съемка производится при ярком свете, камера может 

автоматически включить вспышку, что бы компенсировать тени на лице. 

Режим пейзажной съемки 
 

Режим пейзажной съемки — полная противоположность портретному режиму, 

фотоаппарат устанавливает максимально узкое значение диафрагмы, так что бы 

большая часть кадра была четкой. В данном случае, фотоаппарат может установить 

низкую скорость затвора, тем самым создавая риск создания размытого кадра, поэтому 

использование штатива поможет избежать подобных неприятностей. 

Спортивный режим 
 

Спортивный режим съемки в фотоаппарате необходим для фотографирования быстро 

движущихся объектов. Он идеально подходит для фотографирования спортсменов, 

животных, играющих детей и т.д.. Фотоаппарат устанавливает настройки, позволяющие 

зафиксировать движение четким и резким. 

Режим макросъемки 



 

Режим макросъемки в фотоаппарате позволяет фотографировать объекты с близкого 

расстояния. Он подходит для фотографирования мелких объектов — цветов, насекомых, 

ювелирных украшений и т.д. Разные фотоаппараты предоставляют разные возможности 

макросъемки, позволяя снимать с того, или иного расстояния. При использовании 

режима макросъемки вы заметите, что фокусироваться фотоаппарату намного сложнее, 

так как на малых расстояниях глубина резкости маленькая. Необходимо держать камеру 

и объект съемки параллельно. Для лучшего результата может понадобиться штатив, 

который компенсирует дрожание фотоаппарата. 

Режим ночной съемки 
 

Ночной режим — это действительно очень интересно режим, позволяющий создавать 

красочные и интересные кадры. Он предназначен для съемки в условиях недостаточной 

освещенности и устанавливает в фотоаппарате более длинную выдержку, помогающую 

сделать объект в фокусе четким, тут также используется вспышка, освещающая объекты 

переднего плана. 

Ручной режим съемки 
 

В этом режиме у фотографа есть полный контроль над фотоаппаратом, он 

самостоятельно устанавливает все параметры, включая выдержку, диафрагму, ISO, 

баланс белого, вспышку и т.д.. Это дает полную свободу творчества и то, каким будет 

кадр, полностью зависит от вас. 

Программный режим 
 

Некоторые цифровые фотоаппараты поддерживают этот режим в дополнение к 

автоматическому режиму. В данном случае фотограф устанавливает значения 

светочувствительности и баланса белого, а диафрагму и выдержку камера настраивает 

самостоятельно. В отличии от обычного автоматического, данный режим предлагает 

больше свободы для автора снимка. 

Режим приоритета выдержки 
 

Приоритет выдержки очень похож на режим приоритета диафрагмы, но в данном 

случае, фотограф устанавливает значение скорости затвора, а фотоаппарат настраивает 

диафрагму, светочувствительность и баланс белого. Этот режим лучше использовать 

тогда, когда вам необходим контроль над выдержкой, то есть когда вы фотографируете 

или быстро движущиеся объекты, или стремитесь сделать размытое движение воды. 

Когда необходимо сделать четкий кадр во время съемки спортивных мероприятий или 

фотографирования животных, необходимо использовать быструю выдержку. При 

необходимости заморозки движения воды, или заморозки света фар машин ночью, 

требуется использовать длинную выдержку. 

Режим приоритета диафрагмы 
 

Режим приоритета диафрагмы в разных фотоаппаратах обозначается как A или AV, он 

позволяет настроить апертуру самостоятельно, а остальные параметры фотоаппарат 

установит автоматически. Режим приоритета диафрагмы полезен, когда вам необходимо 

контролировать глубину резкости. Выбор большого числа диафрагмы, означает, что 

само отверстие будет узким, и большая часть кадра получится резкой с большой 

глубиной резкости. Маленькое числовое значение диафрагмы говорят о большом 



открытии отверстия, это приводит к меньшей глубине резкости и более размытому 

фону. 

 

 
Практическое занятие № 35 Техника съемки. Композиция кадра. 

 

 

Цель: Научиться выбирать точку съемки и ракурс. 

Предполагаемый результат: Умеет выбирать точку съемки и ракурс. 

Иметь практический опыт: в работе с инструктивной документацией, контроле 

качества выполняемых работ. 

Знать: 
 

- основы фотокомпозиции; 

 

- рекомендации и технические требования к фотографиям на документы; 

Уметь: 
 

- Пользоваться фотоаппаратурой и фотооборудованием для осуществления фотосъемки; 

 

- строить кадр в соответствии с законами фотокомпозиции; 

 

- выполнять фотосъемку на документы в соответствии с рекомендациями и 

техническими требованиями. 

Уровень работы: 2 - репродуктивный 

Время выполнения: 2 часа 

Оснащение работы: 
 

  

Образец титульного листа 

  

Содержание(алгоритм) лабораторной работы 

  

Критерии оценки качества выполнения работы 

 

 

Ход работы: 
 

1. Провести фотосъемку с разных точек съемки и ракурсов; 

 

2. Сравнить полученные фотоснимки; 

 

3. Предоставить изображения. 

Вопросы для подготовки к практическому занятию: 
 



1.  

Основы фотокомпозиции; 

2.  

Рекомендации и технические требования к фотографиям на документы. 

 
Практическое занятие № 36 Правила и средства композиции. 

Цель: Научиться определять композицию при фотосъемке 

Практическое задание.  

1. Практически во всех фотокамерах в видоискателе (на экране)  есть сетка, 

показывающая линии правила третей, и позволяет предварительно оценить 

правильность композиции, но чаще всего ошибочно отключается новичками. Включите 

отображение сетки. Используйте инструкцию к вашей камере. 

2. Просмотрите ваши фото, снятые, например, в вашем крайнем отпуске. Оцените 

правильность их композиции, найдите ошибки. Перекадрируйте эти снимки в 

редакторе, если пространство на них позволяет, так, чтобы улучшить композиционное 

построение. 

3. Какие ошибки при съемке размещенных ниже фотографий допустили авторы? 

  Фото №1 

 Фото №2 

https://dphotoworld.net/_ld/0/70003541.jpeg
https://dphotoworld.net/_ld/0/10767433.jpeg


 Фото №3 

И помните: надо знать законы композиции и соблюдать их, но без фанатизма: иногда их 

можно и нужно нарушать, иначе все снимки были бы похожи один на другой.  
 

 

Использованные материалы и Интернет-ресурсы 

1. http://www.ug.ru 

2. http://informatio.ru/ 

 

 

https://dphotoworld.net/_ld/0/91091411.jpeg

	Контроль и оценка результатов освоения дисциплины осуществляется преподавателем в процессе проведения практических занятий и лабораторных работ, тестирования, а также выполнения обучающимися индивидуальных заданий, проектов, исследований.
	Практическое занятие № 1 Инсталляция программного обеспечения
	Практическое занятие № 2 Операционная система. Структурные элементы окна в Windows.
	Задание:PKZIP
	RAR
	QUARK
	GZIP

	Задание №5. Сделать вывод о проделанной работе:
	Задание 1 1 Войдите в редактор MS Word. Ознакомьтесь со стандартным окном ре- дактора (строка главного меню и ее команды, панель инструментов и ее кноп- ки, служебные кнопки, функциональные клавиши). 2 Установите поля документа: верхнее – 2 см, нижнее...
	Задание 2 1 Найдите в приведенном ниже тексте все случаи, когда пробелы были ис- пользованы не по назначению, и определите, какие настройки формата следо- вало бы здесь применить. 2 Наберите текст, исправляя неточности. 3 Сохраните текст под своим ори...
	Задание 3 1 Наберите текст и отформатируйте, как показано в образце, исправляя ошибки. 15 2 Сохраните текст под своим оригинальным именем. 3 Закройте документ.
	Задание 4 1 Получите у преподавателя задание_1 и сохраните его под новым именем. 2 В созданном документе установите все поля по 2 см. 3 Разбейте текст на абзацы. 4 Удалите второй абзац. 5 В оставшемся тексте переставьте абзацы в обратном порядке. 6 Ра...
	Задание 5 1 Получите у преподавателя задания по редактированию текста (задание_2, 3). 2 Выполните редактирование. 3 Сохраните полученные документы в созданную папку.
	Задание 6 1 Откройте созданный в задании_1 документ и получите его копию под но- вым именем. 16 2 Выделите первый абзац и установите начертание букв полужирным, раз- мер букв – 16 пт, тип шрифта – CourierNew. 3 Сделайте выравнивание текста по ширине....
	Задание 7 1 Получите у преподавателя задания по редактированию текста (зада- ние_4). 2 Выполните проверку правописания. 3 Сохраните полученные документы в созданную папку.
	Задание 8 1 Откройте задание_1 и сохраните его под новым именем. 2 В созданном документе установите все поля по 2 см и выделите границы текста. 3 Используя меню Фон страницы, создайте подложку с надписью «Моя подложка». 4 Измените цвет листа. 5 Сохра...
	1.4 Вопросы для самоконтроля 1 Как войти в редактор Word? 2 Найдите в окне редактора Word строку главного меню, стандартную панель инструментов, панель форматирования, строку состояния. 3 Укажите на панели инструментов кнопки: Масштаб (страницы), От- ...
	Практическое занятие № 2 . Поиск информации, структурирование информации с помощью MS Word
	Образец задания
	Информационное письмо
	Рис. 4.1. Структурная схема MRP



	Практическое занятие № 3 Форматирование документа согласно ГОСТ
	. Задание №1«Сканирование и распознавание двух страниц любой книги средствами программы ABBYY Finereader»

	Оформляя документ с материалами ПЗ №1, предусмотреть вставку титульной страницы (Вкл.Вставка → гр. Страницы → Титульная страница).
	Практическое занятие № 5
	Создание и редактирование таблиц. Вставка и редактирование рисунка.Цель занятия: Изучение основных приемов создания, редактирования и форматирования таблиц
	ТЕОРЕТИЧЕСКИЙ МАТЕРИАЛ
	Для работы с таблицами в Microsoft Word применяют контекстные вкладки Конструктор и Макет группы вкладок Работа с таблицами (рис. 1). Эти вкладки автоматически отображаются, когда курсор находится в какой-либо ячейке существующей таблицы.
	Рис. 1.  Вкладки для работы с таблицами
	Кроме обычных таблиц Word документы могут содержать таблицы, импортированные из Microsoft Excel, и таблицы Microsoft Excel, созданные непосредственно в документе.
	Вставка таблицы Microsoft Word
	Таблица всегда вставляется в то место документа, где в данный момент находится курсор. Лучше всего поставить курсор в начало абзаца текста, перед которым должна располагаться создаваемая таблица.
	Для быстрой вставки простой таблицы во вкладке Вставка нажмите кнопку Таблица и в появившемся табло при нажатой левой кнопке выделите необходимое число столбцов и строк (рис. 2). При наведении указателя мыши срабатывает функция динамического просмотра...
	Рис. 2.  Вставка простой таблицы
	Можно настроить некоторые параметры создаваемой таблицы.
	Установите курсор туда, где будет находиться создаваемая таблица.
	Щелкните кнопку Таблица во вкладке Вставка и выберите команду Вставить таблицу (см. рис. .2).
	В окне Вставка таблицы (рис. 3) выберите требуемое количество строк и столбцов, а также способ автоподбора. При выборе режима постоянный можно установить ширину столбцов таблицы.
	Рис. 3.  Выбор параметров вставляемой таблицы
	При создании таблицы можно воспользоваться имеющимися заготовками Microsoft Word или собственными, ранее созданными таблицами.
	Установите курсор туда, где будет находиться создаваемая таблица. (1)
	Нажмите кнопку Таблица во вкладке Вставка и выберите команду Экспресс-таблицы (см. рис. 2).
	Прокрутите список таблиц и выберите нужную (рис. 4). Пользовательские таблицы, занесенные в список экспресс-таблиц, обычно располагаются в разделе Общие в конце списка.
	Рис. 4.  Выбор экспресс-таблицы
	В результате в документ будет вставлена готовая, содержащая текст и оформление таблица (рис. 5). Оформление встроенных экспресс-таблиц Microsoft Word зависит от выбранной темы документа. Вставленная таблица может иметь заголовок. Ненужный текст можно ...
	Рис. 5.  Вставленная в документ экспресс-таблица
	Ход работы:
	1. Запустите программу Microsoft Word
	2. Создайте текстовый документ  Таблица_1.doc, который сохраните в своей папке на диске D: Выполните в этом файле следующие задания:
	2.1. Командой Вставить таблицу постройте таблицу состоящую из 10 строк и 5 столбцов.
	o Выделите ячейки первой строки и из контекстного меню объедините их
	o Аналогично объедините все ячейки нижней строки, затем восемь средних ячеек первого и последнего столбцов
	o Запишите в объединенных ячейках слова ТАБЛИЦА, выровняйте текст по центру и измените направление записи текста (ориентацию)
	2.2. Построение таблицы командой Нарисовать таблицу по образцу, приведенному ниже:
	o Залить каждую строку таблицу разными цветами
	2.3 Командой Нарисовать таблицу построить таблицу состоящую из 3 строк и 4 столбцов. Границы таблицы должны быть построены красной тройной линией толщиной 3 пт., а внутренние границы – пунктирной линией в 1,5 пт. синего цвета.
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